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Agilent Technologies, Inc., Automation Solutions, 5301 Stevens Creek Blvd., Santa Clara, CA 95051 USA

Letter to our Customers

Dear Customer,

The Agilent Technologies acquisition of Velocity11 resulted in the following 
changes:

• Creation of Agilent Technologies Automation Solutions, formerly Velocity11

• Renaming of some Velocity11 products

• New Customer Service and Technical Support contact information

• New website address for product information

Please make a note of the following changes as they impact this user guide.

Velocity11 product name changes

New contact information
Documentation feedback: documentation.automation@agilent.com

Technical Support: 1.800.979.4811 or +1.408.345.8011 
service.automation@agilent.com

Customer Service: 1.866.428.9811 or +1.408.345.8356 
orders.automation@agilent.com

European Service: +44 (0)1763853638  
euroservice.automation@agilent.com

Web: www.agilent.com/lifesciences/automation

Velocity11 product name Changes to …

Access2 Automated Microplate 
Loader

Automated Centrifuge Loader

Element Automation System BioCel 900 System

IWorks Device Driver Programming 
Interface

VWorks Device Driver Interface

PlatePierce Seal Piercing Station Microplate Seal Piercer

VCode Barcode Print and Apply 
Station

Microplate Barcode Labeler

Velocity11 Robot 3- Axis Robot

VHooks Integration Interface VWorks Hooks Interface

VPrep Pipetting System Vertical Pipetting Station

VSpin Microplate Centrifuge Microplate Centrifuge

VStack Labware Stacker Labware Stacker

Agilent Technologies
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Preface
This chapter introduces the BenchWorks Automation Control User Guide.

To operate the BenchCel Workstation, become familiar with the 
procedures in this guide as well as the guides for the devices installed on 
your BenchCel Workstation. This chapter contains the following topics:

❑ “Who should read this guide” on page vi

❑ “About Velocity11 user guides” on page vii

❑ “What this guide covers” on page ix

❑ “What is new in this version” on page x

❑ “Finding your software versions” on page xi

❑ “Reporting problems” on page xiii

❑ “Sending a bug report” on page xiv
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Who should read this guide

Job roles This user guide is for people with the following job roles:

Related topics

Job role Responsibilities

Integrator Someone who configures software and 
hardware to allow integration of the 
BenchCel Workstation into a larger lab 
automation system.

Installer Someone who unpacks, puts together, 
and tests the BenchCel Workstation 
before it is used.

Lab manager, administrator, or 
technician

Someone who is responsible for:

❑ Managing the BenchCel 
Workstation

❑ Developing the applications that 
are run on it

❑ Solving the more challenging 
problems that might arise

❑ Developing training materials and 
standard operating procedures for 
operators

Operator Someone who performs the daily 
production work on the BenchCel 
Workstation and solves routine 
problems.

Your organization may choose to create 
its own procedures for operators 
including the procedures in this guide.

For information about... See...

Using Velocity11 user guides “About Velocity11 user guides” on 
page vii

Finding firmware version “Finding your software versions” on 
page xi

What this guide covers “What this guide covers” on page ix

Starting BenchWorks software “Starting BenchWorks software” on 
page 19
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About Velocity11 user guides

About this topic This topic describes the different formats of Velocity11 user information 
and explains how to access the user information.

Formats available Velocity11 user information is provided to you as:

❑ Online help

❑ A PDF file

❑ A printed book

The information in each format is the same but each format has different 
benefits.

Where to find user 
information

Online help

The online help is added to your computer with the Velocity11 lab 
automation system software installation.

PDF file

The PDF file of the user guide is on the software CD that is supplied with 
the product.

Velocity11 website

You can search the online help or download the latest version of any 
PDF file from the Velocity11 website at www.velocity11.com.

Note: All Velocity11 user information can be searched from the website 
at www.velocity11.com.

Online help The online help is the best format to use when you are working at the 
computer and when you want to perform fast or advanced searches for 
information. 

To open the online help:

1. In the Velocity11 lab automation software, press F1. The online help 
window opens.

Main features
The online help window contains the following:

❑ Navigation pane. Consists of four tabs. The Contents, Index, and 
Search tabs provide different ways to locate information. The Using 
tab contains information about using the help system.

❑ Content pane. Displays the online help topics.

❑ Navigation buttons. Enables you to navigate through the pages.The 
online help includes a navigation pane, content pane, and 
navigation buttons.

http://www.velocity11.com/site/?q=node/111
http://www.velocity11.com/site/?q=node/113
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PDF user guides Computer requirements
To open a user guide in PDF format, you need a PDF viewer. You can 
download a free PDF viewer from the internet.

Printing and searching
The user guides in PDF format are mainly for printing additional copies. 
You can perform simple searches in the PDF file, although these 
searches are much slower than online help searches.

More information

For more information about using PDF documents, see the user 
documentation for the PDF viewer.

Related topics

Navigation pane Content pane Navigation buttons

For information about... See...

Who this guide is for “Who should read this guide” on 
page vi

What this guide covers “What this guide covers” on page ix

Finding firmware version “Finding your software versions” on 
page xi

Starting BenchWorks software 
software

“Starting BenchWorks software” on 
page 19
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What this guide covers

BenchWorks 
software version

This guide covers the operation of BenchWorks software. This version of 
the guide is only for use with BenchWorks software file version 37.

Supported firmware 
version

This guide covers firmware version 3.0. The firmware version can be 
determined from the General Settings page of the BenchWorks software 
Diagnostics dialog box.

What this guide does 
not cover

This guide does not cover the operation of the following:

❑ Velocity11 instruments, such as the PlateLoc Sealer, VCode 
Microplate Labeler, and VPrep Pipettor when used in stand-alone 
mode

❑ Other companies’ devices, with the exception of the use of 
diagnostics software that is developed by Velocity11 for other 
companies’ devices

For more information about these topics, see the user guides for the 
relevant instruments.

Related topics
For information about... See...

Starting BenchWorks software  “Starting BenchWorks software” on 
page 19

Finding software and firmware 
versions

“Finding your software versions” on 
page xi
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What is new in this version

About this topic The following table describes the main new features of BenchWorks 
software (version 37) that have been added since version 24.

New features

Related topics

Feature Description See...

Runset manager Enables you to schedule a series of 
runs, using a different protocol for 
each run, if desired.

❑ “About starting runs 
automatically” on page 55

❑ “Working with the run-set 
manager” on page 56

Spawn task Enables you to conditionally start a 
new protocol process.

“Setting Spawn Process task 
parameters” on page 117

Inventory editor Enables you to coordinate a plate 
storage system with a database.

“Using the BenchWorks 
software inventory” on 
page 167

Start and finish scripts Enables you to create JavaScripts that 
are executed before and after a 
protocol is run.

❑ “Adding a start and finish 
script to the protocol” on 
page 37

❑ “Where scripts are written” 
on page 210

New Run Progress toolbar Enables you to view the current 
progress of a run.

“Monitoring a run” on page 61

Well volume visualization Enables you to see volume of a plate 
in the inventory

“Auditing plate volumes in the 
inventory editor” on page 193

 X-Series and R-Series 
BenchCel Workstations

Enables you to run protocols on both 
series of BenchCel Workstations.

“Defining labware properties 
for a BenchCel Workstation” on 
page 261

For information about... See...

Overview of the BenchCel 
Workstation

BenchCel Microplate Handling 
Workstation User Guide
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Finding your software versions

About this topic This topic shows you some ways to find out your version of:

❑ BenchWorks software

❑ Device driver plug-in

❑ Firmware

About software 
versions

There are several different software versions that describe the 
BenchWorks software. The most important are the following.

Finding versions 
from the software

If you are asked to identify the software version, provide the installer 
version. If the software does not have an installer version, provide the 
file version.

To find the BenchWorks software installer version, file version, 
and device driver version number:

1. Start BenchWorks software.

2. Select Help > About BenchWorks software.

Version This identifies the...

File version Specific product version (follows the 
notation xx.x.x)

Installer version Specific installer (follows the notation 
xx.x.x.xxx)

Driver version Software version for the device driver 
plug-in or ActiveX

Firmware version Version of firmware the device is using
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To find the firmware version number:

1. Start BenchWorks software.

2. Open a device file. Wait for the BenchCel Workstation to initialize.

3. Open BenchCel Diagnostics.

Click the General Settings tab and observe the Firmware version in 
the BenchCel area at the top of the dialog box.

Finding versions 
from the files

You can find the BenchWorks software file version and device driver 
version information by looking at the executable files.

To find the BenchWorks software file version number:

1. Navigate to C:\Program Files\Velocity11\BenchWorks.

2. Right-click BenchWorks software.exe.

3. Select Properties.

4. Click the Version tab.

To find the device driver version number:

1. Navigate to C:\Program Files\Velocity11\BenchWorks\plugins.

2. Right-click .dll file for the device.

3. Select Properties.

4. Click the Version tab.

Device driver version

Installer and file version
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Related topics

Reporting problems

About this topic If you find a bug in the software or have a technical or hardware 
problem that you can’t resolve, read the information in this topic for how 
to report problems.

Reporting software 
problems

If you find a problem in the Velocity11 software, let us know by:

❑ Sending a bug report from within BenchCel Workstation

❑ Sending an email to service@velocity11.com or 
euroservice@velocity11.com

❑ Calling Velocity11 Technical Support at 1-800-979-4811 or +1 650-846-
6611 outside the US

Sending files and 
information 

When resolving software bugs or other problems, please send the 
following files and information:

❑ Detailed, precise description of the problem you are experiencing

❑ Device file (if the issue occurs when a device file is open)

❑ Protocol file (if the issue occurs during a protocol run or simulation)

❑ Protocol log file (if the issue occurs during a protocol run or 
simulation)

❑ Velocity11 registry files from the Windows registry

❑ Error message text (or screen capture of the error message window)

❑ Screen capture of the About BenchWorks window

For information about... See...

Opening a device file “Working with device files” on page 12

Getting help “About Velocity11 user guides” on 
page vii

Opening Diagnostics BenchCel Microplate Handling 
Workstation User Guide

Finding firmware version BenchCel Microplate Handling 
Workstation User Guide

Starting BenchWorks software “Starting BenchWorks software” on 
page 19

mailto:service@velocity11.com
mailto:euroservice@velocity11.com
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Reporting user guide 
problems

If you find a problem with this user guide or have suggestions for 
improvement, please take a minute or two to give us your feedback 
using the feedback button in the online help. Your comments will be 
reviewed promptly and used to write the next version of the guide.

You can also send an email directly to documentation@velocity11.com 

Related topics

Sending a bug report

About this topic This topic describes how to send a bug report to Velocity11 Technical 
Support from BenchWorks software.

Before you start Before you can send a bug report:

❑ The system’s computer must be connected to a network with 
internet access.

❑ The outgoing email server must be set up on the system’s computer 
by a BenchCel Workstation or network administrator.

Sending a bug report A bug report is an email that you create and send from within 
BenchWorks software.

To send a bug report:

1. Select Help > Report a Bug.

The Report a Bug dialog box opens.

For information about... See...

Sending a bug report “Sending a bug report” on page xiv

Sending a registry file “Moving or sending a registry file” on 
page 240

mailto:documentation@velocity11.com
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2. Type a description of the error in the text box.

In your description, provide a summary of the error and, in the case 
of a software bug, a description of how we can reproduce it.

3. Click Email Velocity11 and wait until a Message Sent message box 
opens.

Related topics
For information about... See...

Reporting software problems “Reporting problems” on page xiii

Sending a registry file “Moving or sending a registry file” on 
page 240
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BenchWorks software 
overview
 1
This chapter introduces BenchWorks software and its user interface.

This chapter contains the following topics:

❑ “Description of BenchWorks software” on page 2

❑ “Overview of the BenchWorks software user interface” on page 3

❑ “Relationships of BenchWorks software components” on page 9

❑ “Working with device files” on page 12

❑ “Installing BenchWorks software” on page 14

❑ “Uninstalling BenchWorks software” on page 16
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Description of BenchWorks software 

About this topic This topic gives an overview of BenchWorks software, the software that 
runs the BenchCel Workstation.

What BenchWorks 
software does

BenchWorks software controls the BenchCel Workstation and any 
associated devices. The BenchCel Workstation is a microplate-
processing automation platform used to store microplates and move 
them to and from separate devices.

The control of the BenchCel Workstation occurs through the execution 
of protocols in BenchWorks software.

Example

A typical automation platform might consist of a BenchCel Workstation 
with two stacks, a VCode Plate Labeler, and a PlateLoc Plate Sealer. The 
BenchCel Workstation has access to the VCode Plate Labeler on one 
end and the PlateLoc Sealer on the other.

In one scenario, a BenchWorks software protocol might instruct the 
BenchCel Workstation to download the microplate from one of its 
stacks, place it on the VCode Plate Labeler, instruct the VCode Plate 
Labeler to label the plate, then move the plate to the PlateLoc Plate 
Sealer, instruct the PlateLoc Plate Sealer to seal the plate, and then 
upload it to the other stack.

About protocols Protocols are sequences of tasks created by the user and run in 
BenchWorks software. Each task performs an activity, such as putting tips 
on a pipette head or sealing a plate.

BenchWorks software is a multiprocess application, enabling a single 
protocol to simultaneously run two or more sequence of tasks.

Before a protocol is run, a compiler checks it for logical errors that 
would otherwise prevent the protocol from completing. Users also have 
the option of running simulations of the protocol before committing 
expensive samples.

BenchWorks 
software is event-
driven 

BenchWorks software uses an event-driven controller to schedule the 
execution of the protocol. This means that protocols are run with no pre-
set schedule and tasks are performed in a manner that uses devices 
simultaneously and most efficiently. This efficiency reduces the overall 
time of the run.

Real-time 
manipulation and 
troubleshooting

BenchWorks software can also manipulate each device in the system in 
real-time by sending individual commands using diagnostics software. 
This is useful for setting up and troubleshooting.

Comprehensive event logging allows the operator to analyze each run 
and troubleshoot problems.
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Related topics

Overview of the BenchWorks software user 
interface

About this topic This topic introduces the pages, toolbars, and menus that make up the 
BenchWorks software user interface (UI).

About the 
BenchWorks 
software UI

The BenchWorks software UI is made up of a tabbed workspace, tabbed 
toolbars, a menu bar, and a status bar. The content of these items can 
change depending on whether you are viewing a device file, protocol 
file, or the progress of a protocol run.

UI terminology The following diagram identifies the elements of the BenchWorks 
software UI.

For more information about... See...

Software installations “Installing BenchWorks software” on 
page 14

BenchWorks software user 
interface

“Overview of the BenchWorks software 
user interface” on page 3

Device files “Working with device files” on page 12

BenchWorks software components “Relationships of BenchWorks software 
components” on page 9
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Workspace tabs Run progress, protocol editors, and device manager are accessible by 
tabs.

Tasks toolbar Workspace tabs
Title bar

Menu bar Standard toolbar Control toolbar Task Parameters toolbar

Workspace

Task toolbar 
filter buttons

Log toolbar 
filter buttons

Status bar

Log entry

Tab Use to... See...

Progress Display the status of the current 
protocol and manage run sets.

❑ “Monitoring overall progress” on 
page 61

❑ “Working with the run-set 
manager” on page 56

Pre-Protocol Editor Create a process to be executed 
before the protocol runs.

“Setting up a pre-protocol or post-
protocol process” on page 74

Protocol Editor Create and edit protocols and 
processes. 

❑ “Creating a protocol basics” on 
page 67

❑ “Creating a protocol: advanced 
topics” on page 201

Post-Protocol Editor Create a process to be executed after 
the protocol run is completed. 

“Setting up a pre-protocol or post-
protocol process” on page 74
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Progress tab

Pipette Process 
Editor

Create and edit pipette protocols and 
processes.

Note: This is only used if a VPrep 
System or Bravo Platform is one of the 
configured peripheral devices.

“Adding and configuring a Pipette 
Process task” on page 130

Device Manager Manage and configure devices.

Every device that is added to the 
system must be added to the device 
file. 

Device Driver User Guide

Tab Use to... See...

Runset Manager 
toolbar

Run Progress toolbar
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Device Manager tab

Toolbars Control toolbar

There are six buttons on the Control toolbar.

Device list toolbar

Device Properties
workspace

Button Use to... See...

Log In Log a user into BenchWorks software. 
This provides a level of security by 
controlling access to software security 
levels.

“Logging in to BenchWorks software” on 
page 20

Log Out Log a user out of BenchWorks software. “Logging out of BenchWorks software” on 
page 65

Compile Check the protocol for errors. “Compiling and saving protocols” on 
page 83

Start Begin a protocol or run. “Starting a run from BenchWorks 
software” on page 51

Pause Interrupt a protocol or run after it has 
been started.

“Pausing or stopping a run” on page 59
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Log toolbar
The Log toolbar can display different subsets of log data or display all 
log data. You can also add a note to a log.

There are six tabs in the Log toolbar for displaying different data. 

Tasks toolbar

The Tasks toolbar provides access to all the available tasks that may be 
used in a protocol.

The display of available tasks can be filtered by clicking one of the 
category buttons on the bottom of the toolbar.

Simulate ❑ Find errors that you would encounter 
during an actual run

❑ Prevent BenchCel Workstation from 
trying to initialize devices while you 
are loading a device file.

❑ “Simulating a run” on page 84

❑ “Working with device files” on 
page 12

Diagnostics Displays the BenchCel System Device list 
providing access to diagnostics for all of 
the installed devices.

BenchCel Microplate Handling 
Workstation User Guide

Enable run-set 
manager

Enable/disable the run-set manager. “Working with the run-set manager” on 
page 56

Button Use to... See...

Page Description

All Displays all log entries

Process Displays BenchCel Workstation process logs

Fluid Transfers Displays VPrep System or Bravo Platform fluid 
transfer logs

Measurements Displays 

Errors Displays run errors

Notes Lets you enter a time stamped note into the log

Note: Entries made directly into the log text fields 
do not get written to the log file.
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Task Parameters toolbar
The Task Parameters and Pipette Task Parameters toolbars enables you 
to set the parameters for each task in the protocol. There are two tabs:

❑ Task Settings for setting the task parameters

❑ Advanced Settings for adding a JavaScript to the task

Status bar The Status bar is located on the bottom of the BenchWorks software UI. 
It displays short text messages describing the current state of the 
software, the current user, and tooltips.

Categories for filtering
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Relationships of BenchWorks software 
components

About this topic BenchWorks software uses different components (file types and 
databases) to run the application. What they are and how they work 
together to operate the BenchCel Workstation is described below.

What you should 
know

It is important to understand the way each of the components in 
BenchWorks software relate. Changing settings or options in one 
component will affect one or more of the other components. 

Definitions The table below provides some information about these BenchWorks 
software components:

Component Definition See...

Protocol file A file that contains instructions 
for performing a run and a 
reference to the device file.

“About tasks, processes, 
and protocols” on 
page 68

Device file The data entered into the device 
manager and saved as a device 
file that contains the 
configuration information for 
your devices and references to 
the profiles for each device.

Device Driver User 
Guide

Profile A collection of settings, stored 
in the Windows registry, that 
manages how you connect to 
devices. It also stores device-
specific information such as 
teachpoints

❑ BenchCel 
Microplate Handling 
Workstation User 
Guide

❑ Device Driver User 
Guide

Teachpoint File A file that contains your 
teachpoint settings (referenced 
by the profile).

BenchCel Microplate 
Handling Workstation 
User Guide

Labware 
database

Labware definitions and classes 
stored in the Windows registry.

“Defining labware” on 
page 245

Liquid library 
database

Pipetting settings, setup for 
different liquid types, stored in 
the Windows registry.

“Setting liquid-handling 
definitions” on 
page 279

Pipette 
techniques

An xml file that contains pipette 
methods that can be applied to 
certain pipetting tasks. 

VWorks Software User 
Guide Addendum

User database List of user accounts, privileges, 
and passwords stored in the 
Windows registry.

“Administrator 
procedures” on 
page 235
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Component file 
location

You choose the location for saving protocol, device, and teachpoint 
files. We recommend you create folders within the BenchWorks software 
folder for storing these files. 

Component 
relationships

The table below lists the component, their file extension and what it 
loads when opened:

Component 
relationship diagram

The following diagram illustrates the most basic relationship between 
the BenchWorks software components. 

The following table describes the consequences of making changes to 
one or more components.

Component Extension Opening this file loads...

Protocol .bwl ❑ BenchWorks software (if it is not already 
running)

❑ Labware database information

❑ Liquid library database information

❑ Device file (which loads the...)

Profiles

Teachpoint files

Device file .dev ❑ Profile

❑ Teachpoint file

Profile None Teachpoint file 

Teachpoint file .xml Teachpoint definitions

Teachpoint
 file

ProfileLabware
database

Liquid library
database

Protocol

Device filePipetting
techniques
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Related topics

If you... Then...

Make a change to the teachpoint 
file

❑ All profiles that use that teachpoint 
file are affected

❑ All device files that use those 
profiles are affected

❑ All protocols that use those device 
files are affected

Create a new profile You must specify the new profile in your 
device file

Want to use two different 
teachpoint files

You must:

❑ Create two teachpoint files

❑ Create two profiles

❑ Create two device files

❑ Create two protocol files

Want to copy a protocol to another 
system or computer

You must copy all components. This 
includes:

❑ Labware database

❑ Liquid library database

❑ Pipette techniques (if using)

❑ MySQL database (if using Plate or 
Location Groups)

❑ Device file

❑ Profile

❑ Teachpoint file

Note: Labware, Liquid library, and 
profiles must be transferred by 
exporting and importing as a registry 
keys. See related topics for more 
information.

For more information about... See...

Registry keys “Moving or sending a registry file” on 
page 240

Loading a device file “Working with device files” on page 12
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Working with device files

About this topic This topic describes how to create, save, and load device files in 
BenchWorks software.

Device file defined A device file is a .dev file containing the configuration information for 
your devices. The device configuration data is entered into the Device 
Manager and saved to a device file. In addition, the data in the device-
specific profiles is stored as a reference to the profiles.

Device file location Device files have the file name format file name.dev and are stored in 
the folder location that you specify when saving the file.

Creating device files An empty device file is automatically created when you open 
BenchWorks software. If you add devices or make changes in the device 
manager, you need to save those changes, or they will be lost when you 
exit BenchWorks software (you will be prompted to do so). 

For most users, one device file is sufficient. However, there may be 
circumstances when another device file is needed. There are multiple 
ways to create a new device file. Here are two methods.

Method 1: Create a new device file

To create a device file:

1. Make sure you are logged in as an administrator.

2. Select File > Device File > New. 

3. Click Yes to the alert that existing devices will be erased. A new file 
opens.

4. Save the device file.

Method 2: Create a new device file from an existing one

To create a device file:

1. Select File > Device File > Open. 

2. Select an existing device file and click OK.

3. Click File > Device File > Save as.

4. Enter a new name for the device file in the Save as dialog box.

5. Click Save.

Saving a device file After you make changes in the device manager, you must save the 
device file for the changes to be available the next time the protocol 
using that device file is opened.

To save a device file:

1. Make sure you are logged in as an administrator.
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2. Select File > Device File > Save As.

3. Navigate to the folder in which you want to save the file.

If you want to save the file in the current folder, skip this step.

4. Click Save.

The path of the device file specified in the protocol file and Protocol 
Options dialog box is changed to reflect the different location.

The next time you compile or run a protocol that references the device 
file, the new devices are registered with the Windows operating system.

Loading a device file When you open a protocol file, the device file associated with it is 
automatically loaded for you.

If you need to load another device file, use one of the following method.

Note: Enabling simulation mode will prevent BenchWorks software from 
trying to initialize all devices when you load a device file. However, 
remember to disable simulation mode before starting a run.

To load a device file from within BenchWorks software:

1. Select File > Device File > Open.

If you want to open a recently opened device file, select it from the 
list of device files at bottom of the menu, and the device file is 
loaded.

2. Navigate to the folder that contains the file to load.

3. Click Open.

or,

4. Select File > Protocol File > Open.

If you want to open a recently opened protocol file, select it from the 
list of protocol files at bottom of the menu, and the protocol file 
loads.

5. Navigate to the folder that contains the file to load.

6. Click Open. Opening the protocol, opens the associated device file.

To load a device file from protocol options:

If you load a device file using the following method, the device file will 
be saved with the protocol when you save the protocol.

1. Open a protocol.

2. Click Tools and select Protocol Options.

3. In the Protocol Options tab of the dialog box, click the device file 
ellipsis button.

4. Navigate to the folder that contains the file to load.
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5. Click Open.

Related topics

Installing BenchWorks software

About this topic This topic describes how to start the BenchWorks software installer. 

Two procedures are given. If you are installing BenchWorks software:

❑ For the first time on the system, use Procedure 1

❑ On a system where a version of BenchWorks software is already 
installed, use Procedure 2

Procedure 1 To install BenchWorks software for the first time:

1. Insert the BenchWorks software CD-ROM into your CD-ROM drive.

2. Double-click the setup.exe file.

3. Follow the instructions in the wizard to complete your installation.

Procedure 2 If you are reinstalling BenchWorks software or installing a newer version 
of BenchWorks software use this procedure.

To install BenchWorks software if a version of BenchWorks 
software is already installed:

1. Exit the BenchWorks software application.

2. Insert the BenchWorks software CD-ROM into your CD-ROM drive.

3. Double-click the setup.exe file.

You should be prompted to remove your old BenchWorks software 
application. If this does not happen, you need to uninstall 
BenchWorks software before continuing the new installation. See 
“Uninstalling BenchWorks software” on page 16. You do not need to 
delete the Velocity11 registry files.

4. Follow the instructions in the wizard to complete your installation.

For more information about... See...

BenchWorks software components “Relationships of BenchWorks software 
components” on page 9

BenchWorks software interface “Overview of the BenchWorks software 
user interface” on page 3
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Installing and 
overwriting labware 
definitions

The BenchWorks software installer checks for labware entries in the 
Windows registry, compares them to an approved list generated by 
Velocity11, and performs one or more actions according to the 
following:

❑ If the labware entry does not exist, the installer installs the 
definitions for that labware

❑ If a labware definition is missing one or more property values, the 
installer installs those values (without asking)

❑ If there is a labware definition within the approved list, if and only if 
the labware’s parameter values are different from those in the 
installer, then a user prompt is displayed, asking whether to 
overwrite the labware’s parameter value with the value considered 
to be correct by Velocity11

Note: The installer does not remove any labware not on the approved list

Related information
For information about... See...

Starting BenchWorks software “Logging in to BenchWorks software” 
on page 20

Uninstalling BenchWorks software “Uninstalling BenchWorks software” on 
page 16
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Uninstalling BenchWorks software

About this topic This topic describes two ways to uninstall BenchWorks software.

When to remove 
Velocity11 registry 
files

In general, it is sufficient to uninstall the BenchWorks software program 
without removing the registry files. However, you can remove the 
Velocity11files from the registry if: 

❑ You want to make a completely fresh start with BenchWorks 
software, removing all user accounts, teachpoints, device profiles, 
and liquid and labware definitions, or

❑ You do not intend to run BenchWorks software on your system again

Procedures To remove BenchWorks software:

1. Use the Add / Remove Programs control panel. 

For more information, see the online help for your Windows 
operating system.

!! IMPORTANT !! The following procedure deletes the user 
accounts, labware definitions, liquid library data, device profiles, 
and teachpoints. 

To remove the Velocity11 files from the registry:

1. From the Windows Start menu, select Run.

2. In the Open text box, type regedit.

3. Click OK.

The Windows registry editor opens.

4. Expand folders to select the following folder:

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11

5. Make sure you have selected the Velocity11 folder. 

!! IMPORTANT !! Making a mistake and deleting the wrong 
registry folder may cause critical failures with your operating 
system.

6. Select Edit > Delete.

Related information
For information about... See...

Exporting Velocity11 data from the 
registry files (for example, before 
clearing the registry)

“Moving or sending a registry file” on 
page 240
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Preparing for a run
 2

This chapter describes how to setup BenchWorks software to run an 
existing protocol. All of the procedures in this chapter can be performed 
by someone with operator privileges. This chapter contains the following 
topics:

❑ “Workflow for preparing for a run” on page 18

❑ “Starting BenchWorks software” on page 19

❑ “Logging in to BenchWorks software” on page 20

❑ “Opening a protocol in BenchWorks software” on page 21

❑ “Setting BenchWorks software options” on page 22

❑ “About setting error-handling options” on page 24

❑ “Setting error-handling options in the Options dialog box” on 
page 25

❑ “Setting up email error notification” on page 28

❑ “Setting protocol error-handling options” on page 31

❑ “About setting Protocol Options” on page 30

❑ “Setting pre-protocol rules” on page 32

❑ “Setting protocol rules” on page 33

❑ “Adding an alarm” on page 35

❑ “Adding a start and finish script to the protocol” on page 37

❑ “About log and data files” on page 38

❑ “Setting log options” on page 42

❑ “What you should know before you start the protocol” on page 47

❑ “Printing a protocol” on page 48
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Workflow for preparing for a run

About this topic This topic gives the order of recommended tasks before performing a 
run and tells you where to look for information and procedures for each 
task.

Workflow The general workflow for preparing for a run is listed in the following 
table: 

Related topics

Step Topic

1 “Starting BenchWorks software” on page 19

2 “Logging in to BenchWorks software” on page 20

3 “Opening a protocol in BenchWorks software” on page 21

4 “Setting BenchWorks software options” on page 22

5 “Setting error-handling options in the Options dialog box” on 
page 25

6 “Setting up email error notification” on page 28

7 “Setting protocol error-handling options” on page 31

8 “Setting pre-protocol rules” on page 32

9 “Setting protocol rules” on page 33

10 “Adding an alarm” on page 35

11 “Adding a start and finish script to the protocol” on page 37

12 “Setting log options” on page 42

13 “What you should know before you start the protocol” on page 47

For information about... See...

Protocols “About tasks, processes, and protocols” 
on page 68

BenchWorks software user 
interface

“Overview of the BenchWorks software 
user interface” on page 3

BenchWorks software components “Relationships of BenchWorks software 
components” on page 9
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Starting BenchWorks software

About this topic This topic describes how to start BenchWorks software.

Before you start 
BenchWorks 
software

Start BenchWorks software after you have turned on the BenchCel 
Workstation and the controlling computer and logged in to the 
computer operating system.

Starting 
BenchWorks 
software

To start BenchWorks software:

1. Make sure that everyone is clear of the lab automation system and 
that there are no objects that could obstruct any moving parts.

2. Double-click the shortcut to BenchWorks software on the Windows 
desktop.

Note: If the shortcut has been deleted, open the folderC:\Program 
Files\Velocity11\BenchWorks and create a new shortcut from the 
executable file BenchWorks.exe.

The BenchWorks software splash screen opens.
 

Related topics
For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Logging in to BenchWorks software” 
on page 20
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Logging in to BenchWorks software

About this topic To log in to BenchWorks software you need a user account, created by 
an administrator. This topic describes how to log in and change your 
password once you have a user account. 

Logging in To log in to BenchWorks software:

1. Click Log in.

2. Select your User Name from the list.

3. Enter your password and click OK.

Note: If this is the first time anyone has logged in to this 
installation of BenchCel Workstation, there is one administrator 
account named Admin and it has no password.

4. To change your password, click Change password. The Change 
password dialog box opens.

5. Type your current password in the Old text box.

6. Type your new password in the New text box.

7. Retype your new password in the Confirm New text box.

8. Click OK.

Note: You can also change your password by selecting Tools  > 
Manage Users, after you have logged in.

Related topics
For information about... See...

Workflow this procedure belongs 
to

“Workflow for preparing for a run” on 
page 18
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Opening a protocol in BenchWorks software 

About this topic All runs on the BenchCel Workstation require a protocol. This topic 
describes how to open a protocol that has already been created.

Procedure To open a protocol:

!! INJURY HAZARD !! When BenchWorks software starts, device 
parts might unexpectedly move to their home positions.

Select File > Open.

Make sure you set the file type to Protocol ( .bwl) when browsing for the 
file.

You can also open a protocol by navigating to the .bwl file in Windows 
and double-clicking it. This launches BenchWorks software and opens 
the protocol.

Related topics

The next step “Opening a protocol in BenchWorks 
software” on page 21

Creating user accounts “Adding and deleting a user account” 
on page 237

User permissions “About user accounts and privileges” on 
page 236

Job roles and responsibilities “Who should read this guide” on 
page vi

For information about... See...

For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting BenchWorks software options” 
on page 22
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Setting BenchWorks software options

About this topic This topic describes how to configure the settings on the Options tab in 
the BenchWorks software Options dialog box.

These include settings for the following:

❑ Bar-Code 

❑ Robot

❑ Protocol Editor

❑ BenchCel

❑ Simulator

When to use Review these options after you open a protocol but before starting a run. 

!! IMPORTANT !! Protocols do not store Options dialog box 
settings as part of the protocol. This means that all protocols use the 
settings that are currently selected in the Options dialog box. 

Note: You may decide to keep all or many of the options the same for 
every run. 

Procedure !! IMPORTANT !! If you use barcode data files, remember to 
select the correct file for every run.

To choose the settings in the Options tab of the Options dialog 
box:

1. Select Tools > Options.

2. Make sure that the Options page of the BenchWorks software 
Options dialog box is selected.

3. If you are using a barcode file, select its location:

a. In the BarCode Settings area, click the ellipsis button (...) next to 
the appropriate type of barcode file.

b. In the Open dialog box, navigate to the folder that contains the 
barcode file.

c. Select the file (with a .bar filename extension for an input file 
and a .dat filename extension for a database file) and click 
Open.

4. In the Robot Settings area, select the desired maximum speed of the 
robot movement. 

If the plate-specific robot speed (set in the Maximum Robot Handling 
Speed area of the Labware Editor) is different from the general robot 
speed, the slower of the two speeds is used.

!! DAMAGE HAZARD !! If you are testing a new protocol or 
learning to use the workstation, run the robot at a slow or 
medium speed to reduce the risk of damage in the event of a 
crash.
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5. Select an option in the Protocol Editor Settings area, if desired. 

We strongly recommend that you select the Hide icons for non-
configured device types check box. This option displays the 
available tasks based on the devices specified in the loaded device 
file instead of the tasks for all devices ever made compatible for the 
BenchCel Workstation. This is especially important where similar 
icons are used for different tasks. 

6. In the BenchCel Settings area, select Release BenchCel stackers 
when filled during run to be able to remove the stackers after they 
have been filled.

7. In the Simulator Settings area, select Remember simulator state 
between sessions if you want BenchWorks software to remember the 
simulator state when the software was last opened and maintain that 
state when re-opened. This is useful when you are performing tasks 
when devices are not on and initiated.

8. Click OK to close the BenchWorks software Options dialog box. 

Related topics
For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “About setting error-handling options” 
on page 24
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About setting error-handling options

About this topic This topic provides an overview the types of error handling options 
available when running a protocol with BenchWorks software.

These options are located in the Options dialog box.

Review error options after you open a protocol, and before starting a 
run. 

Note: You may not need to do this for every run.

What error handling 
options include

❑ Error options located on the Error Handling tab of the Options 
dialog box

Error reporting. Choose from a list of error types that you want 
reported.

Error handling. Direct the BenchWorks software on how to 
handle errors encountered during the run.

Scheduler error behavior. Direct the BenchWorks software 
scheduler on how to handle errors encountered during the run.

❑ Error notification options. Located on the Email Setup tab of the 
Options dialog box. Set up email notification in BenchWorks 
software to email or page you when a run error occurs.

❑ Protocol error handling options. Located on the Protocol Options tab 
of the Protocol Options dialog box. Specify how the BenchWorks 
software should behave if it encounters an error while executing 
your protocol.

Related topics
For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting error-handling options in the 
Options dialog box” on page 25

Protocol error-handling options “Setting protocol error-handling 
options” on page 31

Error notification “Setting up email error notification” on 
page 28
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Setting error-handling options in the Options 
dialog box

About this topic This topic describes the handling of error options found in the Error 
Handling tab of the Options dialog box (under Tools > Options). 

See “Related topics” on page 27 for information about protocol error 
options and email error notification.

Procedure To set error handling options found in the Options dialog box:

1. Select Tools > Options.

2. Click the Error Handling tab of the BenchWorks software Options 
dialog box.

3. In the Error Reporting area, select the devices for which you want 
errors reported.

Typically, all of the devices are selected for a run. If you want to 
perform a test run without plates, clear the options for devices used 
in the protocol that would otherwise report errors.

!! INJURY HAZARD !! Clearing error reporting results in all 
errors being ignored. This could result in damage to the 
equipment, microplates, or injury to the operator.

4. Select from the following options in the Error Handling area:

Option When selected...

Sound alarm on output... Not used with the BenchCel 
Workstation.

Send Email when errors occur The people listed in the Email Setup 
tab of the BenchWorks software 
Options dialog box will receive an 
email for every error notification. 

Halt on barcode misreads The robot will halt the run if it 
encounters a barcode misread.
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5. In the Scheduler Error Behavior area, select one of the following 
options:

Halt on barcode database 
lookup errors

The robot will halt the run if the 
barcode found in the database does 
not match the plate barcode.

Launch program if error 
occurs...

A program that you specify is 
launched. 

You must specify the program by 
clicking the ellipsis button (...) and 
browsing to the program’s executable. 
With the appropriate script, this 
function can be used to send a page or 
an email.

If you want to pass the text of the error 
message to the program, select the 
Add error text as command line 
argument check box.

Halt if available disk space falls 
below...

The robot completes the currently 
scheduled step and then stops if the 
percentage of available hard disk 
space is less than the percentage 
specified in the text box.

Halt on critical measurement 
events

Halts the processing of plates if a 
critical measurement is detected. The 
critical measurement is defined in 
Alarm tab of the Protocol Options 
dialog box.

Display warning if VCode label 
count falls below

Displays a warning message when the 
VCode Microplate Labeler has fewer 
than the number of labels entered in 
the text box.

Option When selected...

Option When selected, in the event of an error...

Process as many plates as 
possible

As many tasks as possible, given the error, 
are completed.

Continue processing 
without starting any new 
plates

Tasks involving plates that are currently in 
the system continue. Other tasks are not 
scheduled.
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6. Click OK to close the BenchWorks software Options dialog box.

Related topics

Stop scheduler The scheduler stops scheduling new tasks, 
even if plates are currently available to the 
robot. Current tasks continue to completion.

Option When selected, in the event of an error...

For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting up email error notification” on 
page 28

Protocol error-handling options “Setting protocol error-handling 
options” on page 31

Error options “About setting error-handling options” 
on page 24
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Setting up email error notification

About this topic This topic describes how to add an email address to BenchWorks 
software so you can be notified by email or pager when there is a run 
error.

Email setup in BenchWorks software enables you to do the following 
tasks:

❑ Automatically be notified by email or pager when errors occur 
during a protocol run

❑ Send a bug report to Velocity11

Requirements for 
email setup

Before you can send an email from BenchWorks software, the 
controlling computer must:

❑ Be connected to a network with internet access

❑ Have network access to an outgoing mail server that supports one of 
the authentication methods available through BenchWorks software.

Setting up email To set up the outgoing email server:

1. Select Tools  > Options.

2. In the Mail Server Setup area, enter the name of your SMTP server 
name (outgoing email server).

3. If the server requires a user name and password:

a. Select the Authentication type from the list.

!! IMPORTANT !! The authentication type is critical. Check with 
your network administrator to determine the best authentication 
network for your email server.

b. Enter your User name and Password for the selected 
authentication type.

c. Click Add. A new email address entry appears in the Recipient 
list for error notification.

d. Click on the New email address entry and type in your email.

e. Click OK in the Options dialog box, to save the email setup 
information and close the dialog box.
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This information only needs to be set up once, provided the email 
account remains active. All email sent from BenchWorks software is 
authenticated using this account.

Related topics
For information about... See...

The workflow that this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting protocol error-handling 
options” on page 31

How to setup the outgoing mail 
server

“Setting up email” on page 239

How to send a bug report using 
email

“Sending a bug report” on page xiv
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About setting Protocol Options

Groups of protocol 
options

There are five groups of protocol options. See the table below for where 
to find out information for the different option groups.

Related topics

Protocol Option See...

Device File “Working with device files” on page 12

Description/Notes “Compiling and saving protocols” on 
page 83

Pre-Protocol Rules “Setting pre-protocol rules” on page 32

Protocol Rules “Setting protocol rules” on page 33

Error Handling “Setting protocol error-handling 
options” on page 31

For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting pre-protocol rules” on page 32
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Setting protocol error-handling options

About this topic This topic describes the error-handling options available in the Protocol 
Options dialog box.

Setting protocol 
error handling 
options

To set protocol error handling options:

1. Select Tools > Protocol Options.

2. In the Error Handling area, select one or both of the following 
options:

Related topics

Option If selected and...

Attempt to put plates away if 
deadlock occurs

A deadlock occurs, any lids are 
replaced and the plates are moved to 
the positions they would be in at the 
end of a successful protocol run.

Abort run if stacker runs out of 
plates

The stacker runs out of plates before 
the run is finished, the run is aborted.

Note: Aborting a run permanently 
terminates the run.

For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting pre-protocol rules” on page 32
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Setting pre-protocol rules

About this topic This topic describes the pre-protocol rules available in the Protocol 
Options dialog box. 

Pre-protocol rules 
include

There are two rules in the Pre-Protocol Rules area: 

❑ Reset script context (erase all variables) before protocol executes

❑ Automatically load stacker racks

Reset script context Select this option if you want all script variables to be cleared before the 
protocol is executed.

Automatically load 
stacker racks

Select this option if you want all racks on stacks to automatically load 
before the protocol is started.

Related topics
For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting protocol rules” on page 33

Using and resetting scripts “Using JavaScript in BenchWorks 
software” on page 209

General options “Setting BenchWorks software options” 
on page 22

Stackers BenchCel Microplate Handling 
Workstation User Guide
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Setting protocol rules

About this topic This topic describes the protocol rules in the Protocol Options dialog 
box.

Protocol rules 
include

There are six rules in the Protocol Rules area:

❑ Invoke VCode user plugin in simulation mode

❑ Pipette plates in instance order

❑ Handle plates in instance order

❑ Automatically release stacker racks after protocol finishes

❑ Do not display place labware confirmation during Runset

❑ Dynamically assign empty slot to load in storage device

Invoke VCode user 
plugin in simulation 
mode

Select this option if you are using a Velocity11 lookup plug-in such as file 
reader and you want to check the communication from the VCode 
Microplate Labeler and the plug-in during simulation.

Pipette plates in 
instance order

Default setting

By default, the setting for the Pipette plates in instance order rule is 
checked, and it should be left checked for most protocols.

When to clear the rule

If your protocol has all of the following attributes, consider clearing this 
check box:

❑ The protocol has more than one pipette process that uses the same 
VPrep Pipettor or Bravo Platform

❑ The duration of one of the pipetting operations is much longer than 
another

Explanation

Consider an example in which a protocol has two processes and both 
have a pipetting operation that uses the same VPrep Pipettor. When 
selected, the pipetting operations for one process are completed before 
the pipetting operations begin for the other process.

Now consider what happens when the first pipetting operation takes 
significantly longer to complete than the second operation, and the 
protocol is run several times in succession. The overall time taken for 
the protocol to complete is much greater than it needs to be because 
during each cycle the system had to wait for the slower pipetting 
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operations to complete for all the plates in the process before it could 
continue.

If the rule is turned off, a plate from the fast pipetting process can be 
delivered to the VPrep Pipettor after a plate from the slow pipetting 
process, followed by another plate from the slow pipette process, and so 
on. This reduces the bottleneck at the VPrep Pipettor because it allows 
the faster process to continue, and its second cycle in the series to start 
before the first cycle is complete.

Handle plates in 
instance order

Default setting

By default, the setting for the Handle plates in instance order rule is 
selected.

When to select the rule

Use this rule if you need the plates to be handled in the order in which 
they enter the system. 

Explanation
Consider a situation in which you are using a BenchCel Workstation to 
seal plates using two PlateLoc Sealers and the first one runs out of seal, 
stopping on plate 5.

If this option is not selected, the second sealer continues sealing and 
upstacking plates but plate 5 would be omitted and thus out of order. 

If this option is selected, the second sealer stops until you reload a new 
roll of seal and start the first sealer again and plate 5 is upstacked to its 
position in order.

Automatically 
release stacker 
racks after protocol 
finishes

Default setting

By default, the setting for the “Automatically release stacker racks after 
protocol finishes” setting is checked.

When to select the rule

Use this rule if you have two or more stackers and you want them all to 
release their racks at the end of the protocol. 

Do not display place 
labware 
confirmation...

If you are using the Place Labware task in a pre-protocol process, the 
labware confirmation dialog box opens when you start the protocol and 
awaits your confirmation before allowing the protocol to continue.

Select this option if you are running a runset and do not want to pause 
the run between protocols.

Dynamically assign 
empty slot

Select this option if you want the software scheduler to assign slots in the 
storage device according to what is available at that moment.
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Related topics

Adding an alarm

About this topic You can set an alarm, if your lab automation system is equipped with:

❑ A Weigh Pad

❑ A StoreX incubator with environmental control

For the Weigh Pad, you can set an alarm to inform you when the bottle 
on the Weigh Pad becomes too heavy or too light. 

For the StoreX incubator, you can set an alarm to inform you when a 
particular temperature, humidity, or gas concentration level is reached. 

The alarm creates an error message when a measurement falls outside 
the range that you specify.

This topic describes how to set up such an alarm.

Procedure To add an alarm:

1. Select Tools > Options > Log Options, and, in the Screen settings 
group box, select the Log measurement readings check box.

2. Select Tools > Protocol Options > Alarms.

For information about... See...

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “Setting log options” on page 42
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3. In the Log measurements every text box, type in the time interval 
between measurements taken by the device.

If you change this value, the existing time interval instance expires 
before the change is implemented. If the existing time interval is 
long and you want to implement the change as soon as possible, you 
may need to restart BenchWorks software.

4. Click the Create a new alarm button.

A row with default values is added to the Measurement Alarms table. 
Click to select the row and then click a value to edit it, using the 
following table as a guide.

An example of a field ready to be edited is shown below.

Related information

Field Comments

Alarm name A name of your choice.

Enabled? Yes turns the alarm on.

Device The name of the device on which the 
alarm is set.

Alarm type The parameter that is being measured.

It could be temperature, relative 
humidity, mass, volume, and so on.

Process value The current measurement, with units 
being dependent on the alarm type.

Low Alarm The low value at which you want the 
alarm to be turned on.

High alarm The high value at which you want the 
alarm to be turned on.

Alarm Timer [minutes] Determines when a “critical” alarm is 
triggered. An initial alarm error 
message is triggered as soon as the 
alarm condition is met. A second 
“critical” alarm is triggered after this 
time interval.

For example, if the temperature High 
Alarm is 40 ºC and the Alarm Timer is 
5 min, and a measurement is recorded 
at 40 ºC, the critical alarm is triggered 
five minutes after remaining above 
40 ºC.

For information about... See...

Workflow for preparing a run “Workflow for preparing for a run” on 
page 18
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Adding a start and finish script to the protocol

About this topic Start and Finish scripts are typically used to initialize variables and 
define functions for all the scripts used throughout the protocol. Note 
that they are associated with the protocol rather than the task and 
therefore less susceptible to accidental deletion.

This topic describes how to add JavaScripts that will be executed before 
the pre-protocol or after the post-protocol is finished. 

For more information on using scripts in protocols, see the Related 
topics section at the end of this topic.

Procedure To add a start or finish JavaScript to a protocol:

1. Select Tools > Protocol Options.

2. Click Start/Finish Scripts.

3. To enter a script to run before the protocol, type the script into the 
Start Script text box or click Browse to open a file that contains a 
script.

4. To enter a script to run after the protocol, type the script into the 
Finish Script text box or click Browse to open a file that contains a 
script.

5. Click OK.

Note: Entries entered on this page will be saved along with the 
protocol.

Related topics

Sending email when errors occur “Setting up email error notification” on 
page 28 

Monitoring environmental 
conditions during a run

“Monitoring a run” on page 61

The log file to which 
measurements are recorded

“Importing a log file to Excel” on 
page 45

StoreX environmental control The operating manual for your StoreX 
incubator

For information about... See...

For more information about... See...

Using JavaScript in BenchWorks 
software

“Using JavaScript in BenchWorks 
software” on page 209



Chapter 2: 
BenchWorks Automation Control User Guide

38
About log and data files

About this topic This topic describes the different types of logs that BenchWorks software 
creates.

Types of log and 
data files

Log files record event and error information in text files that can be 
useful for troubleshooting. Data files record data collected by devices 
such as plate readers.

Velocity11 strongly recommends that you select Create new logs every 
run, Append timestamps to filenames, and set the Max number of each 
log file to maintain to 100.

The location of the three log files, a data file, environment text file, and 
two root folders are set in the Log Options page of the BenchWorks 
software Options dialog box.

Store the log files in a place that is easy for you to find them again. These 
files can be essential for verifying that plates were processed properly 
and can help troubleshoot any type of errors that you might encounter 
during the use of your system.

The various files are listed in the following table and described in more 
detail later in this topic:

File Default file or folder name

Protocol log file log.txt 

Pipettor transfer log file piplog.txt

Barcode log file barcodelog.txt

Reader output file Reader.dat

Measurement output file Environment.txt
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Note: You can change the default filenames to suit your own needs, but 
they are referred to using their default names throughout this guide.

About opening log 
files

You can open a log file in any text editor, but we recommend that you 
use the Windows application Notepad because with Notepad you can 
open the file during a run as the file is being written.

Protocol log file The protocol log file records all available event and error information. 
The information recorded in the protocol log file cannot be modified.

This is a tab-delimited text file that can be opened and manipulated in 
excel. Many customers use this feature to parse barcode information 
from the log and into their database.

Part of a protocol log file, opened in Notepad, is shown in the following 
diagram.

During a run, you can type notes directly into the log and it will be saved 
to the log file. See related topics for more information.

Pipettor transfer log 
file

The pipettor transfer log file is a tab-delimited text file that records VPrep 
Pipettor or Bravo Platform pipetting information on a BenchCel 
Workstation that has a VPrep Pipettor or Bravo Platform.

Note: This log is not the same as the log generated by the VPrep Pipettor.

Image file root folder A folder that you select

Pipette technique editor root 
folder

A folder that you select

File Default file or folder name
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Part of a pipettor transfer log file, opened in Notepad is shown in the 
following diagram.

The pipettor transfer log contains the following information, separated 
by tabs:

❑ Aspiration timestamp

❑ Pipettor name

❑ Name of the plate aspirated from

❑ North barcode (of plate aspirated from)

❑ East barcode (of plate aspirated from)

❑ South barcode (of plate aspirated from)

❑ West barcode (of plate aspirated from)

❑ Quadrant of the plate aspirated from (number 1–16)

❑ Dispense timestamp

❑ Name of the plate dispensed to

❑ North barcode (of plate dispensed to)

❑ East barcode (of plate dispensed to)

❑ South barcode (of plate dispensed to)

❑ West barcode (of plate dispensed to)

❑ Quadrant of the plate dispensed to (number 1–16)

❑ Volume of liquid dispensed in microliters

❑ Status of the dispense

Values are ERROR or OK. These refer to the status of the barcode 
verification and not the dispense itself.

Note: One log entry is created for every aspirate/dispense task pair. For 
example, if 20 µL are aspirated and half is dispensed to one plate and 
half to another plate, two piplog entries are created. This example is 
treated as two dispense task pairs.

Barcode log file The barcode log file contains the date and time at which each barcode 
is applied and the text of each field. Barcode fields are displayed in 
human readable form.

Reader output file The reader output file defines the location of the data file (<file 
name>.dat) for a plate reader. 
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Measurements 
output log file

What is recorded
The measurements output log file records measurements made by 
StoreX and Weigh Pad devices.

Weigh Pad measuring units

The Weigh Pad records liquid volumes as percentage of the maximum.

StoreX measuring units

The measuring units recorded by a StoreX device are temperature, in 
degrees Celsius, humidity in relative humidity percentage, and gas 
concentrations in percent (by volume).

VersaScan image file 
root folder

The image root folder sets the folder in which images from a VersaScan 
are automatically stored.

Pipette technique 
editor root folder

The pipette technique editor root folder sets the folder in which pipette 
technique files are automatically stored.

Note: Currently, pipette techniques are available only for the Bravo 
Platform.

Related topics
For information about... See... 

The next step “Setting log options” on page 42

Adding a note “Working with the Log toolbar” on 
page 63

Barcode labeling “Setting Apply Label task parameters” on 
page 91

Pipette techniques VWorks User Guide (addendum)
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Setting log options

About this topic This topic explains how to configure the log options page of the 
BenchWorks software Options dialog box. You may not need to 
configure these options for every run.

Available options The following log options are available in BenchWorks software:

❑ The type of log information to show in the Log toolbar of 
BenchWorks software

❑ General settings that pertain to log and data file maintenance

❑ The folders in which to store log and data files

❑ Checking the database connection and enabling plate tracking

How messages 
displayed in the Log 
toolbar are 
controlled

Event and error messages are displayed in the log toolbar. With all 
message options turned on, a large number of messages are displayed. 
For simplicity, you can hide types of messages that are not important to 
you. 

The messages that are displayed during a run are controlled by:

❑ Selecting screen settings options (in the Tools > Options dialog box) 
before a run 

❑ Clicking tabs in the Log toolbar during a run 

Note: Screen display settings do not affect the information saved in log 
files. All error and event information is always saved.

Procedure To set log file options:

1. Select Tools > Options.

2. Click the Log Options tab.

3. In the Screen settings area, select one or more of the following 
options, as needed:
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4. In the File Settings area:

a. In the Max number of each log file to maintain text box, type the 
maximum number of log files that you want to store. We 
recommend you maintain at least 100 log files.

!! IMPORTANT !! After this number has been reached, 
each new log file replaces the oldest existing log file.

b. Select one or more of the following options, as needed:

Log Option Writes to screen and file...

Log “task begin” events on screen Messages at the time that process 
tasks are scheduled (not at the time 
that they are performed).

This applies only to the protocol log 
file.

Log “task complete” events on 
screen

Messages that confirm when process 
tasks are completed.

This applies only to the protocol log 
file.

Log robot motions on screen Robot motion events as they 
happen.

This applies only to the protocol log 
file.

Log pipettor debug messages Event messages that are generated 
by VPrep Pipettors and Bravo 
Platforms.

This applies only to the protocol log 
file.

Log measurement readings Environmental values as they are 
recorded in real time.

This applies only to the protocol log 
file.

Log options Description

Create new logs for every run A separate log file is created for 
every run.

If the check box is cleared, each 
run appends data to the same log 
file and a new log file is created 
when BenchWorks software is 
started.

This affects all log files.
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5. Click the ellipsis button  for a log file or folder.

a. Navigate to the folder to which you want to save the log file.

b. Click Save.

6. In the BenchWorks software Options dialog box, click OK.

Related topics

Append timestamps to log file 
names

The date and time of the run is 
appended to the name of the log 
file.

This affects all log files.

Log options Description

For information about... See 

The workflow this procedure 
belongs to

“Workflow for preparing for a run” on 
page 18

The next step “What you should know before you start 
the protocol” on page 47

Log and data files ❑ “Setting pre-protocol rules” on 
page 32

❑ “Working with the Log toolbar” on 
page 63
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Importing a log file to Excel

About this topic This topic describes how to import a log file into Microsoft Excel.

Because comma-delimited and tab-delimited text files contain 
structured data, you can quickly import them into Microsoft Excel, 
automatically organizing their data into columns. 

This feature is helpful for making it easier to analyze the data in log files.

Procedure To import a log file to Excel:

1. Open Microsoft Excel.

2. Drag the file onto the Excel window.

The data is imported.

Protocol log file 
information

The information given in a protocol log file is explained in the following 
table. Refer to the screenshot of the Excel file for the column letters.
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Related topics

Spreadsheet column Information

A Date and time that the entry was added

B Type of information:

❑ Error

❑ Event

❑ Info

❑ Script

❑ User

C Origin of the information

D Either the:

❑ Name of the plate

❑ Name of the device, if it refers to a reagent

E Description of the log entry

For information about... See 

The workflow for preparing to do 
a run

“Workflow for preparing for a run” on 
page 18

The next step “What you should know before you start 
the protocol” on page 47

Adding notes to the log file “Working with the Log toolbar” on 
page 63

Log and data files ❑ “Setting pre-protocol rules” on 
page 32

❑ “Working with the Log toolbar” on 
page 63

Setting log options “Setting log options” on page 42
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What you should know before you start the 
protocol

About this topic This topic gives an overview of the information you should become 
familiar with when running a protocol.

What you should 
know

At a minimum, become familiar with the following:

❑ Which devices you need to prepare

❑ Where you need to position the plates before the run and where 
they are moved to during the run

❑ Whether User Message tasks prompt you to perform certain actions 
after you start the run or whether you need to perform the actions on 
your own initiative before you start the run

❑ Whether you need to replace fluids and empty waste during the run

❑ Whether you need to remove and add plates during the run

❑ Which liquids you need to prepare, where they should be placed, 
and in what kinds of reservoir

Related topics
For information about... See 

Where this topic fit into the 
workflow

“Workflow for preparing for a run” on 
page 18

Running a protocol “Starting a run from BenchWorks 
software” on page 51

Printing a protocol “Printing a protocol” on page 48
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Printing a protocol

About this topic You can print a description of a protocol, which will help you to analyze 
the sequence of tasks. This topic describes how to print a copy of the 
protocol.

Printing a protocol It might help you to refer to a printout of the protocol steps as you 
analyze the protocol.

To set up the printer:

1. Select File > Print Setup.

2. Select the printer you want to print to and configure the print dialog 
box as required.

To print a protocol:

1. Navigate to File > Print Preview.

2. View the preview and, if it is satisfactory, click Print.

Note: If you try to print a protocol before a network printer driver is 
installed on the BenchCel Workstation computer, you will receive an 
error. If this happens, contact your network administrator for help.

An example of a printed process that includes a pipette process is 
shown here.

Related topics
For information about... See...

Information you should know 
about protocols

“What you should know before you 
start the protocol” on page 47
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Performing a run
 3

A run is a single protocol that is performed one or more times in a series. 
This chapter describes how to run an existing protocol using 
BenchWorks software. All of the procedures in this chapter can be 
performed by someone with operator privileges. This chapter contains 
the following topics:

❑ “About performing a run” on page 50

❑ “Starting a run from BenchWorks software” on page 51

❑ “Starting a run from a command line” on page 54

❑ “About starting runs automatically” on page 55

❑ “Working with the run-set manager” on page 56

❑ “Pausing or stopping a run” on page 59

❑ “Monitoring a run” on page 61

❑ “Working with the Log toolbar” on page 63

❑ “Logging out of BenchWorks software” on page 65
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About performing a run

About this topic This topic tells you where to find the information about starting a run 
and performing tasks associated with running a protocol.

Ways to set up a run There are three ways to start a run.

What you do next depends on whether you are going to run a single 
protocol or a run set.

If you are going to run a single protocol, at this point the protocol you 
plan to run has been created and opened in BenchWorks software. The 
next step is to start the run.

If you are going to run a run set, you first have to create it. 

Tasks associated 
with a run

Whichever way you choose to start a run, you would typically perform a 
number of pre-run checks.

Method See...

Set up a single protocol run and 
manually start it by clicking the Start 
button in the BenchWorks software

“Starting a run from BenchWorks 
software” on page 51

Set up a single protocol in advance 
and manually start it from a command 
line

“Starting a run from a command 
line” on page 54

Set up a run set, which consists of one 
or more protocol runs that are started 
automatically, based on times that you 
set in advance

❑ “About starting runs 
automatically” on page 55

❑ “Working with the run-set 
manager” on page 56

Task See...

Perform pre-run checks BenchCel Microplate Handling 
Workstation User Guide

Start a run ❑ “Starting a run from 
BenchWorks software” on 
page 51

❑ “Starting a run from a 
command line” on page 54

❑ “About starting runs 
automatically” on page 55

❑ “Working with the run-set 
manager” on page 56
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Starting a run from BenchWorks software

About this topic This topic describes how to start a run using the Start button in 
BenchWorks software. Start a run after performing pre-run checks and 
opening a protocol.

Procedure To start a run:

1. Make sure all devices used in the protocol are in their home 
positions. 

Refer to the device user guides for more information about homing.

2. Make sure the areas around the devices are clear of labware (except 
for the labware used in the protocol).

3. In BenchWorks software, click Start.

If this is the first run with this device file, BenchWorks software 
confirms communication with all devices and instructs the devices 
to home.

4. If you selected from plug-in as the plate type, the Labware dialog box 
opens asking you to select the labware type: select the appropriate 
labware type from the list.

Monitor a run ❑ “Monitoring a run” on page 61

❑ “Working with the Log toolbar” 
on page 63

Pause a run “Pausing or stopping a run” on 
page 59

Clean up BenchCel Microplate Handling 
Workstation User Guide

Exiting BenchWorks software “Logging out of BenchWorks 
software” on page 65

Task See...
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5. If you are running a VCode Labeler and are using the FileReader 
plug-in, the Open dialog box opens asking you to select the text file 
that contains the barcode label data.

a. Select the plug-in text file that contains the data from the Open 
dialog box. and click Open.

b. In the new dialog box that opens, inspect the list of names of the 
columns of the text file and the total number of rows in the file. 

In the following screenshot, the first six columns of the plug-in 
file are repeated for each side of the plate.

c. Click OK.

If the file is not the one you intend to use, you can cancel the run 
at the next step if needed.

6. Type the number of times that you want to execute the protocol 
during the run, or to run an indefinite number of plates, select Run 
protocol until manually aborted. 

When the downstack becomes empty, or the upstack becomes full, 
you will be prompted with the option of adding or removing plates. 
This feature saves you the time of having to restart the protocol when 
you are processing a large number of plates or when you are 
running plates intermittently.
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7. Click OK.

What happens after 
a run starts

After you start the run:

❑ The Start button becomes unavailable and the Pause button 
becomes available.

❑ Log messages on the Log toolbar indicate the start of the run. Also, 
log files record events as they are performed on all plates in the run. 

❑ The first instructions of the protocol are executed.

❑ If User Message tasks are included in the protocol, you are prompted 
to respond to them. 

Related topics
For information about... See... 

Pausing a run “Pausing or stopping a run” on 
page 59

Monitoring the log “Working with the Log toolbar” on 
page 63
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Starting a run from a command line

About this topic This topic describes how to start BenchWorks software and initiate a run 
directly from a command line. 

Procedure To start BenchWorks software from a command line:

1. In Windows, select Start > Run.

2. In the Run text box, type cmd and click OK.

The command prompt opens.

3. At the command prompt, change the current directory to 
BenchWorks software workspace that contains the protocol file by 
typing:

cd \Program Files\Velocity11\BenchWorks

4. Press ENTER.

5. Type the name of the BenchWorks software protocol file followed by 
values for the switches that specify: 

The protocol to run

Your user name

Your password

The number of cycles for which to run the protocol

An example is:

myprotocol.bwl /user:your user name /password:your password /
runs:number of run cycles

6. Press ENTER to start the run.

The following screenshot shows a generic example of the 
completed command prompt.

Related topics
For information about... See...

Starting a run using the start 
button

“Starting a run from BenchWorks 
software” on page 51

Pausing a run “Pausing or stopping a run” on page 59

Monitoring a run “Monitoring a run” on page 61
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About starting runs automatically

About this topic If you want to schedule a series of runs, perhaps using a different 
protocol for each run, you need to create a run set. This topic provides 
some basic information about run sets.

Run set defined A run set is a collection of runs that are scheduled in advance to run 
without operator intervention.

The run set is defined in the Run-Set Manager toolbar, which is displayed 
on the Progress page of BenchWorks software.

Typical use Run sets are typically used with systems that are meant to be run for 
long stretches of time unattended.

Run-set file The data displayed in the run-set manager is stored as an XML file with 
the file name extension .rst, in a location selected by your BenchCel 
Workstation administrator.

Run-set privileges You can only save run-set files if you are logged on with an Administrator 
or Technician user account.

Run options When setting up a run set, for each run you define:

❑ How many times the run should cycle

❑ The time that each run should start

Run scheduling logic You can create a run set while another protocol is running.

If the time to start a run scheduled by the run-set manager arrives while 
another run is being performed, the start is delayed. Then, when the 
running protocol finishes, the earliest-scheduled run in the run set starts. 

Related topics
For information about... See...

Setting up runs (overview) “About performing a run” on page 50

Using the run-set manager “Working with the run-set manager” on 
page 56
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Working with the run-set manager

About this topic This topic describes how to create, edit, save, and open run sets.

Adding a run To add a run to the run set:

1. In the Run-Set Manager toolbar, click Add run.

2. In the Select a protocol file to use for this scheduled run browser 
box, navigate to, and select, the protocol file that you want to add.

3. Click Open.

A new row is added to the Run-Set Manager toolbar table, with a 
default time scheduled 5 minutes into the future.

4. If you want to schedule the run for a different day:

a. Click in the Date column.

b. Click a second time in the Date column to make the date 
editable.

c. Click the drop-down arrow to open a calendar and select the 
date.

d. If you want all other runs in a run set to be modified in relation 
to the changed day, click Yes in the BenchWorks software dialog 
box.

5. If you want to schedule the run for a different time:

a. Click in the Time column.

b. Click again in the Time column to make the time editable.

c. Click the group of hours, minutes, or seconds to edit.

d. In the following example, the minutes group is selected.
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e. Click the up or down arrows to change the value or type the new 
value in the field.

6. In the Runs column, enter a number of cycles that you want the 
protocol to run.

7. If you are using a plug-in (that Velocity11 has written or that you 
have created using the VHooks interface), double-click in the 
Plugin column and navigate to plug-in file.

Filtering runs If you have a long list of runs in a run set, you can apply a filter to display 
a subset of the runs.

To filter displayed runs:

1. Right-click a cell in the Run-Set Manager toolbar that you would like 
to keep in the displayed selection.

2. Select Filter by row from the menu that appears.

3. Select the value that you would like to filter on.

Runs that do not include this value are hidden.

After filtering a run set, you can display all runs again.

To display all runs:

1. Right-click a data-containing row in the Run-Set Manager toolbar.

2. Select Show all from the menu that appears.

All runs are now displayed.

Deleting a run To delete a run:

1. Select a row in the Run-Set Manager toolbar.

2. Click Delete run.



Chapter 3: 
BenchWorks Automation Control User Guide

58
Saving run sets To save a run set you must be logged on with an Administrator or 
Technician user account.

To save a run set:

1. Select File > Runset File > Save.

To save the file in a different location, select Save As.

Opening a run set If you open a previously created run set, it is likely that some or all of the 
runs are scheduled to start in the past. In this case, make sure that you 
set new start dates and times so that they are in the future. 

The run-set manager allows you to set a new start time for one run and 
automatically reset the start times of the other runs by the same time 
increment.

!! IMPORTANT !! The runs that are scheduled in the past will not 
start automatically.

To open a run set:

1. Select File > Runset File > Open.

2. In the Open browser box, navigate to and select the run-set file that 
you want to open.

3. Click Open.

4. Change the scheduled date and time following the procedure in 
“Adding a run” on page 56.

Stopping a run set The procedure for stopping a run set is the same as the procedure for 
stopping any run. 

For more information about... See...

Stopping a run set “Pausing or stopping a run” on page 59

Setting up runs “About performing a run” on page 50

Run sets “About starting runs automatically” on 
page 55
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Pausing or stopping a run

About this topic This topic describes when and how to stop or pause a protocol that is 
running.

Use this procedure to:

❑ Pause and continue a run, for example, when you want to:

Add or remove labware

Clean up a spill

Add buffer to a reservoir

Diagnose a problem that you notice

Perform an operation that is not part of the protocol

❑ Abort a run in a non-emergency situation

Procedure To pause or stop a run using BenchWorks software:

1. In BenchWorks software, click Pause.

The Stop dialog box opens and the currently scheduled task 
continues to completion. This may take a minute or more. After that, 
no more tasks are performed.

2. You now have three choices:

If you want to... Then...

Continue with the run Click Continue.
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!! IMPORTANT !! Before continuing with a run, make sure that 
the system is in a valid state for the protocol.

Make sure that you have not made changes that will cause an error, such 
as moving a plate to a position that should not have a plate or causing 
samples to be switched around. 

Related topics

Troubleshoot a problem or 
perform a manual operation

Click Diagnostics, and select the 
module that caused the error.

This opens the diagnostics 
software for that module, allowing 
you to troubleshoot the problem. 
For more information, see 
BenchCel Microplate Handling 
Workstation User Guide.

Abort the protocol Click Abort Process.

If you want to... Then...

For information about... See...

Starting a run ❑ “Starting a run from BenchWorks 
software” on page 51

❑ “Starting a run from a command 
line” on page 54

Monitoring a run “Monitoring a run” on page 61

Using the Log toolbar “Working with the Log toolbar” on 
page 63
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Monitoring a run

About this topic This topic describes what operations you need to monitor and how to 
view the progress of a run.

What to monitor After starting a run, monitor the operation of the BenchWorks software. 
Exactly what you do to monitor a run depends on the protocol that you 
are using. For example, you might need to:

❑ Compare the motions of the robot to the protocol tasks being 
completed.

You can identify the task that is currently being performed from the 
position of the green ball in the process panes. Because 
BenchWorks software can schedule more than one task at a time, 
there may be more than one green ball displayed.

❑ Add and remove labware.

❑ Empty liquid waste containers.

❑ Fill liquid reservoirs.

❑ Replace an empty roll of seal or barcode labels.

!! IMPORTANT !! No errors are reported when a liquid waste 
container becomes full or a liquid reservoir becomes empty. 
(Exceptions to this are reservoirs on a VPrep Pipettor Weigh Shelf.)

To guard against the problem of a full waste container or empty reservoir 
container, the protocol writer can incorporate User Message tasks into 
the protocol to remind the operator at the appropriate steps in the 
protocol. Alternatively, operators can set timer alarms to remind them to 
fill reservoirs and empty the waste container at the appropriate time.

Monitoring overall 
progress

You can monitor the overall progress of the run on the Progress page of 
BenchWorks software.

The Progress page has a:

❑ Protocol Progress area

❑ Run-Set Manager

❑ Run Progress area 

Collectively, these display:

❑ The protocol that is running

❑ The number of tasks remaining

❑ The number of plates remaining to be run
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❑ The status of each plate in the protocol

Closing unneeded 
toolbars

You can close unneeded toolbars to create more room on the screen for 
you to monitor a run by clicking the close box.

Related topics
For information about... See...

Pausing a run “Pausing or stopping a run” on page 59

Starting a run ❑ “Starting a run from BenchWorks 
software” on page 51

❑ “Starting a run from a command 
line” on page 54

What to do when you get an error BenchCel Microplate Handling 
Workstation User Guide
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Working with the Log toolbar

About this topic This topic gives an overview of what the Log toolbar does and how to 
use its features.

Event and error messages are displayed in the Log toolbar of the 
BenchWorks software window.

With all message options turned on, a large number of messages are 
displayed during a run. For ease of use, you can hide types of messages 
that are not important to you. The messages displayed during a run are 
controlled by:

❑ Selecting Screen Setting options in the Log Options dialog box 
before a run

❑ Clicking tabs at the bottom of the Log toolbar display during a run

Viewing the Log 
toolbar

To view the Log toolbar:

1. If the toolbar is not showing, from the View menu, select Toolbars > 
Log.

The toolbar opens at the bottom of the screen.

2. Refer to the table below to view different kinds of log data.

Log toolbar options The following options are available for displaying screen messages.

Searching the Log 
toolbar

You can search for specific text in the Log toolbar.

BenchWorks 
software log tab

Displays...

All All event and error messages.

This is the data that is recorded in the log.txt file.

Process Event messages, including fluid transfer messages.

Pipettor Fluid Transfers Event messages reported by a Velocity11 pipettor.

This is the same data that is recorded in the 
pipettor transfer log file, but is presented in 
sentence rather than tab-delimited format.

Note: Event messages can be disabled by clearing 
the Record in transfer log option in the aspirate 
and dispense pipette task parameters.

Errors Error messages that appear as alert boxes on the 
screen.

This data is not saved in a separate log, but is 
included in the log.txt file.

Notes Notes that you add.
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To perform a search in the Log toolbar:

1. Select the appropriate tab in the Log toolbar.

2. Click in the toolbar pane.

3. Click CTRL + F3 or CTRL + F.

The Find dialog box opens.

Adding a note You can type notes into the message display pane during a run. Any 
notes that you type are also incorporated into the log.txt file.

To add a note to the Log toolbar and log.txt file:

1. At the bottom of the message display pane, click the Notes tab.

2. Click in the display pane wherever you want to add the note.

3. Type the note.

4. Press ENTER on the keyboard

A timestamp is appended to the note.

Message color 
coding

The BenchWorks software log color-coding scheme is listed here.

Color Meaning

Black Standard events with a date stamp or 
user-added notes

Blue Liquid transfer events

Red Warnings

Lime green General information
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Related topics

Logging out of BenchWorks software

About this topic This topic describes how to log out of BenchWorks software.

Logging out of BenchWorks software ensures that unauthorized users do 
not use your account to control the BenchCel Workstation or its devices. 
For example, an administrator should log out after making changes in 
the plate editor.

Procedure To log out:

1. Click Log Out.

Related topics

For information about... See...

Setting screen message options 
before a run

 “About log and data files” on page 38

Importing a log file “Importing a log file to Excel” on 
page 45

For information about... See...

Managing users “Adding and deleting a user account” 
on page 237

User privileges “About user accounts and privileges” on 
page 236
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Creating a protocol 
basics
 4
This chapter is for people with technician and administrator privileges. It 
describes the process of creating a protocol and explains the parameters 
used to define each protocol task. Before reading this chapter you 
should be familiar with the concepts presented in “Performing a run” on 
page 49.

This chapter is not a tutorial on writing protocols — it provides the basic 
reference information you need to create protocols.

This chapter contains the following topics:

❑ “About tasks, processes, and protocols” on page 68

❑ “About the protocol file format” on page 71

❑ “Workflow for creating a protocol” on page 73

❑ “Setting up a pre-protocol or post-protocol process” on page 74

❑ “Setting up a protocol process” on page 76

❑ “Adding and deleting tasks” on page 78

❑ “About setting task parameters” on page 80

❑ “About setting pipette task parameters” on page 81

❑ “Compiling and saving protocols” on page 83

❑ “Simulating a run” on page 84

❑ “Setting the number of simultaneous plates” on page 85
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About tasks, processes, and protocols

About this topic This topic defines some terms that you need to know before you can 
understand or create protocols.

Task defined A task is an operation usually performed by a device, on one or more 
plates, and is represented by an icon in the protocol editor. It has 
associated parameters that are defined in the Task Parameters toolbar.

Some tasks can only be used in certain conditions, for example, only in 
a pre- or post-protocol process or only as part of a pipette sub-process.

Process defined A process is a series of tasks to be performed on one or more pieces of 
labware, usually from a single source, such as plate stacker. Plate 
processes are created in the Protocol Editor. Each process starts with a 
plate process icon. 

The following diagram shows a process in which a defined plate type is 
having four tasks performed on it.

Plate process icon 
defined

A plate process icon represents the basic information about a plate or 
collection of plates. It has associated parameters that are defined in the 
Task Parameters toolbar.

The information it represents includes the type of labware used in the 
process, how many plates are available for processing at one time, 
whether the plates have lids, and plate name. 

The following example icon represents a plate icon for a 384-well plate.

Protocol defined A protocol is one or more processes that are run together. 

The following example shows one protocol with two processes. The top 
process contains one pipette process. The pipette process is executed as 
a sub-routine of the main protocol process.
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Pre-protocol defined A pre-protocol is one or more processes that are executed once, before 
the protocol. The processes are created in the Pre-Protocol Editor which 
is accessed by clicking the Pre-Protocol Editor tab in BenchCel 
Workstation. 

Priming reservoir pumps is an example of a startup-protocol task. 

When you click Start, if there is a pre-protocol, it is executed first, 
followed by the protocol.

Note: If the Pre-Protocol tab is not visible, go to Tools > Options and 
select Show Pre/Post Protocol Editor.

Post-protocol 
defined

A post-protocol is one or more processes, which are executed once after 
the protocol. The processes are created in the Post-Protocol Editor 
which is accessed by clicking the Post-Protocol Editor tab in BenchCel 
Workstation. 

A post-protocol is typically used to clean the system after a protocol run.

When you click Start, a pre-protocol might run first, followed by the 
protocol, and then any post-protocol processes.

Note: If the Pre-Protocol tab is not visible, go to Tools > Options and 
select Show Pre/Post Protocol Editor.

Pipette process 
defined

A pipette process is a sequence of pipette tasks that is performed on a 
specific plate, as defined in the process editor. It is a subroutine of a 
pipette process task.

The following diagram describes the relationship between a task, 
pipette process task, and a pipette process.
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Pipette task defined A pipette task is an operation that is performed on one or more plates by 
a pipettor. It is represented by an icon in the pipette process editor.

The following diagram shows a pipette task.

Pipette process task 
defined

A pipette process task represents a sequence of pipette tasks known as a 
pipette process. Pipette processes are represented by an icon in the 
protocol.

Run defined A run is a single protocol, which includes any pre-protocol and post-
protocol processes, that is performed one or more times in a series.

When you start a run, you are prompted to enter the number of cycles 
that you want to run. The value that you enter represents the number of 
times the protocol executes before the run ends. For example, a value of 
four means that the protocol runs four times in the series. Note that 
when you run a protocol multiple times, the pre and post, if they exist, 
are only run once.

Pipette process task

Pipette process

Pipette tasks

Protocol process
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Related topics

About the protocol file format

About protocol files Protocols are sequences of tasks created by the user and run in 
BenchWorks software. Each task performs an activity, such as putting tips 
on a pipette head or sealing a plate. 

Protocol files contain the information about which tasks to execute and 
what parameters each task uses. It does not contain information about 
device communications, teachpoint locations, and scheduling.

This topic provides an overview of the protocol file format.

File format Protocols are created in the drag-and-drop protocol editor. When they 
are saved, the information is written to a file in XML format. In XML, the 
elements indicate the protocol’s properties, and text within the markup 
tags gives the properties’ values.

You can create and edit protocols in the protocol editor or directly in 
XML. The XML files can also be useful for troubleshooting because you 
can, for example, see which device file is associated with the protocol.

XML example A protocol file viewed as XML is shown below. You can open a protocol 
file in any browser that contains an XML parser, for example, Mozilla 
Firefox.

For information about... See...

Workflow for creating a protocol “Workflow for creating a protocol” on 
page 73

The next step “Setting up a pre-protocol or post-
protocol process” on page 74
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XML schema To create and edit protocols directly in XML, you need to have the XML 
schema that defines the logical rules of a BenchWorks software 
protocol. If you want the schema, please contact Velocity11 Technical 
Support. 

Related topics
For information about... See...

Workflow for creating a protocol “Workflow for creating a protocol” on 
page 73

Using JavaScript in protocols “Using JavaScript in BenchWorks 
software” on page 209
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Workflow for creating a protocol

About this topic This topic gives the steps used to make a protocol and a cross-reference 
to the topic that describes each step.

Who creates 
protocols?

People who have technician and administrator level user accounts have 
the necessary privileges to create protocols. 

Workflow

Step Topic See...

1 Optional. Preparing back-end barcode label data 
to use with a plug-in.

❑ “About the FileReader plug-in” on 
page 203

❑ “Using the FileReader plug-in in a 
protocol” on page 206

❑ “About barcode reading and tracking” 
on page 229

❑ “Using barcode input files” on page 230

❑ “Using barcode data files” on page 233

2 Optional. Creating a pre-protocol process. “Setting up a pre-protocol or post-protocol 
process” on page 74

3 Creating a protocol process which includes:

Setting up a process. “Setting up a protocol process” on page 76

Adding tasks. “Adding and deleting tasks” on page 78

Setting task parameters. ❑ “Simulating a run” on page 84

❑ “Simulating a run” on page 84

4 Optional. Enter JavaScript scripts to dynamically 
set task parameters. and control devices.

❑ “Using JavaScript in BenchWorks 
software” on page 209

❑ “The JavaScript task object and 
properties” on page 216

5 Optional. Creating a pipette process, which includes:

Adding pipette tasks. “Configuring a pipette process: example” 
on page 126

Setting pipette process task parameters. “Setting pipette task parameters” on 
page 125

6 Creating additional processes and pipette 
processes.

This table, step 3 and step 5

7 Optional. Creating a post-protocol process. “Setting up a pre-protocol or post-protocol 
process” on page 74
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Related topics

Setting up a pre-protocol or post-protocol 
process

About this topic This topic describes how to set up a pre-protocol and post-protocol 
process.

Pre-protocols and post-protocols are processes that are carried out 
before and after the protocol is executed.

Use the pre-protocol editor when you want a task performed, before the 
protocol runs. For example, if you are dispensing reagents, you may 
want to prime a pump with fluid.

Use the post-protocol editor when you want to perform a task, after the 
protocol runs. For example, you may want to flush lines with a buffer or 
cleaning agent.

Procedure To set up a pre-protocol or post-protocol process:

1. Click the Pre-Protocol or Post-Protocol Editor tab.

If the tab is not available:

a. Select Tools > Options.

b. Select Show Pre/Post Protocol Editor.

c. Click OK.

8 Adding user message tasks where needed. “Setting User Message task parameters” on 
page 118

9 Compiling and saving the protocol. “Compiling and saving protocols” on 
page 83

10 Testing the protocol with the simulator. “Simulating a run” on page 84

11 Deciding the number of simultaneous plates to 
set.

“Compiling and saving protocols” on 
page 83

12 Running the protocol. “Performing a run” on page 49

Step Topic See...

For information about... See...

Protocols, including definitions of 
terms

“Opening a protocol in BenchWorks 
software” on page 21

Privileges “About user accounts and privileges” on 
page 236
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2. Click Add.

A pre-protocol process icon appears in the Pre-Protocol or Post-
Protocol Editor window.

3. If the Task Parameters toolbar is not showing, select View > Toolbars > 
Protocol Parameters.

4. Type in a name for the process in the Process name field.

5. Create the pre-protocol process as you would a protocol process, by 
adding tasks and then setting the task parameters.

6. When you are finished, compile and check your pre-protocol.

Related topics
For information about... See...

Creating a protocol process ❑ “Setting up a protocol process” on 
page 76

❑ “Compiling and saving protocols” 
on page 83

❑ “Adding and deleting tasks” on 
page 78

Compiling a protocol “Compiling and saving protocols” on 
page 83

Running a protocol in simulation 
mode

“Simulating a run” on page 84

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73
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Setting up a protocol process

About this topic This topic describes how to set up a protocol process when creating a 
protocol. See Related topics at the end of this topic for where to find a 
definition of plate instance.

Procedure To set the plate properties for a protocol process:

1. In the protocol editor, click Add.

A plate process icon appears in the protocol editor window.

2. In the Task Parameters toolbar:

a. Type a name for the plate in the Plate name text box.

b. In the Plate type list box, select the type of plate you want to use.

c. If you want to add or modify a plate definition, click Edit labware 
settings to open the labware editor.

d. If you are using a plug-in, select it from the Plug-in list box.

If the plug-in is not available for selection, it may be because the 
file_name.dll file is not in the plug-ins folder in the same folder 
as the BenchWorks software executable. 

e. In the Simultaneous plates text box, type the maximum number 
of plates of this type that the system is allowed to operate on at 
any given time. 

f. If the plates entering the system have lids, select the Plates have 
lids check box. 

Note: This option is only available if the plate you selected is 
capable of using a lid, as defined in the labware editor. 

g. If the sample plates in the protocol have seals when they are 
loaded onto the BenchCel Workstation, select the Plates enter 
the system sealed check box. 

h. If you have only one instance of a plate type and want it to be 
used repeatedly, select the Use single instance of plate check 
box. For example, you may have one source plate from which 
you want to repeatedly aspirate a given volume and dispense it 
into a different receiving plates. 
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3. In the Barcode control sub-page:

a. If the incoming plates have barcodes, select the appropriate 
Incoming plates have barcodes... check box.

b. If you want to check the barcodes on the incoming plates 
against a series of barcodes in a barcode input file, select the 
name of the barcode series you want to use.

For more information about barcodes input from file, see 
Related topics at the end of this topic.

4. In the Special error handling sub-page:

a. Select one or more devices that you want to use as quarantine 
stations and click Add.

The device names are moved to the bottom quarantine list.

A quarantine station is a place that plates will be placed if the 
plate has a barcode mismatch error.

b. Check or leave clear Quarantine plate after process completed, 
based on the following descriptions.

If left clear, a plate that gives a barcode misread error is 
immediately moved to a quarantine station and a new plate 
takes the place of the quarantined plate in the processing 
sequence.

If selected, plates that give a barcode misread are processed as 
normal, but are then moved to quarantine instead of moving to 
the final destination specified in the protocol.

Related topics
For information about... See...

Using plug-ins “About the FileReader plug-in” on 
page 203
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Adding and deleting tasks 

About this topic This topic describes how to add and delete tasks.

After you have set up a protocol process, you can start adding tasks and 
pipette tasks.

Adding a task To add a task to a process:

1. If the Protocol Tasks are not visible, make sure that:

a. View > Toolbars > Protocol Tasks is selected.

b. The All tab is selected.

Definition of a protocol process “About tasks, processes, and protocols” 
on page 68

Setting the number of 
simultaneous plates

“Compiling and saving protocols” on 
page 83

Using barcodes “About barcode reading and tracking” 
on page 229

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73

For information about... See...
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2. To add tasks to the protocol, do one of the following:

Click a task icon and drag it from the task list to the protocol 
editor window until a vertical, dashed line appears.

Double-click the icon.

Copy (or cut) and paste task icons in the protocol.

Deleting a task To delete a task from a process:

1. In a protocol editor, select a task that is in a protocol process.

2. Press the DELETE key on the keyboard.

3. Click Yes in the Delete Task dialog box to delete the task.

Moving tasks To move tasks in a protocol:

1. In a protocol editor, select a task or a group of tasks in a protocol 
process.

2. Do one of the following:

Drag and drop the tasks to a new location in the protocol.

Use the Cut, or Copy and Paste commands on the Edit menu to 
move the tasks. To paste between two tasks, click the first task 
before pasting the copied task.

 

Related topics

Click All

For information about... See...

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73

Setting up a plate instance “Setting up a protocol process” on 
page 76
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About setting task parameters

About this topic This topic describes what task parameters are and what they do.

Task parameters 
defined

After you have added a task, you can set parameters for it. Most tasks 
require you to set parameters. The parameters specify the details of the 
task. As you set the parameters, the text underneath the task icons 
change to reflect the new parameters.

Related topics For information about the specific types of tasks, see the following 
topics:

Setting the number of 
simultaneous plates

“Compiling and saving protocols” on 
page 83

For information about... See...

For information about... See 

Pipette task parameters “Simulating a run” on page 84

Apply Label task parameters “About setting Apply Label task 
parameters” on page 90

Delid/Relid task parameters “Setting Delid/Relid task parameters” on 
page 97

Downstack and Upstack task 
parameters

“Setting Downstack and Upstack task 
parameters” on page 98

Evaluate Script task parameters “Using the Evaluate Script task” on 
page 102

Incubate task parameters “Setting Incubation task parameters” on 
page 103

Inoculate task parameters “Setting Inoculate task parameters” on 
page 105

Loop task parameters “Setting Loop task parameters” on 
page 107

Mount/dismount task 
parameters

“Setting Mount/Dismount task parameters” 
on page 108

Multidrop task parameters Device Driver User Guide

Nanodrop task parameters Device Driver User Guide

Pierce task parameters “Setting Pierce task parameters” on 
page 110
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About setting pipette task parameters

About this topic This topic describes the differences between tasks and pipette tasks and 
provides cross references to topics about specific pipette tasks.

Pipette tasks versus 
tasks

Pipette tasks differ from tasks in the following ways:

❑ Pipette tasks are added in the pipette process editor and not the 
protocol editor

❑ Pipette tasks refer to settings in the liquid library editor

❑ Pipette tasks may require you to configure a VPrep Pipettor shelf in 
the device manager

Specific pipette 
tasks 

For information about the specific types of pipette tasks, see the 
following topics:

Place Plate task parameters “Setting Place Plate task parameters” on 
page 113

QFill2 task parameters Device Driver User Guide

Restack task parameters “Setting Restack task parameters” on 
page 114

Seal task parameters “Setting Seal task parameters” on page 116

User Message task parameters “Setting User Message task parameters” on 
page 118

Waitfor and Signal task 
parameters

“Setting Waitfor task and Signal task 
parameters” on page 120

WellMate task parameters “Setting VSpin Access2 Centrifuge task 
parameters” on page 121

VSpin with Access2 task 
parameters

“Setting VSpin Access2 Centrifuge task 
parameters” on page 121

Setting the order of tasks “Specifying task order across processes” on 
page 122

Checking for protocol errors “Simulating a run” on page 84

Individual modules that 
perform tasks

“Overview of the BenchWorks software 
user interface” on page 3

For information about... See 
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For information 
about...

See...

Aspirate task parameters ❑ “Setting Aspirate task parameters for a VPrep 
Pipettor” on page 135

❑ “Setting Aspirate task parameters for a Bravo 
Platform” on page 137

Change instance task 
parameters

“Setting Change Instance task parameters” on 
page 140

Change tips task 
parameters

❑ “Setting Change Tips task parameters for a 
VPrep Pipettor” on page 142

❑ “Setting Tips On task parameters for the 
Bravo Platform” on page 158

❑ “Setting Tips Off task parameters for the 
Bravo Platform” on page 159

Dispense task 
parameters

❑ “Setting Dispense task parameters for a 
VPrep Pipettor” on page 144

❑ “Setting Dispense task parameters for a Bravo 
Platform” on page 147

Dry tips task parameters “Setting Dry Tips task parameters” on page 150

Loop task parameters “Setting Loop task parameters” on page 107

Mix task parameters ❑ “Setting Mix task parameters for a VPrep 
Pipettor” on page 150

❑ “Setting Mix task parameters for a Bravo 
Platform” on page 152

Pump reagent task 
parameters

❑ “Setting Pump Reagent task parameters for a 
VPrep Pipettor” on page 155

❑ “Setting Pump Reagent task parameters for a 
Bravo Platform” on page 156

Wash tips task 
parameters

“Setting Wash Tips task parameters for a VPrep 
Pipettor” on page 160
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Compiling and saving protocols

About this topic This topic describes how to compile and save a protocol.

When you compile a protocol, BenchWorks software checks to make 
sure that your protocol makes logical sense.

Compiling a protocol To compile a protocol:

1. Click Compile.

Errors are reported in the Log toolbar.

Note: Whenever you start a protocol, BenchWorks software 
automatically compiles it and checks for errors.

Saving a protocol To save a protocol you must be logged in with an administrator or 
technician user account. 

!! IMPORTANT !! When you edit a protocol, the changes take 
effect immediately. However, unless you explicitly save the 
protocol, the changes are lost when you exit BenchWorks software.

To save a protocol:

1. Select File > Save As.

2. In the Save As dialog box, navigate to the folder in which you want 
to save the protocol.

3. In the File name text box, replace the selected file name with a 
name of your choice.

You can save your protocol files anywhere, but it is good practice to 
create a directory in your BenchWorks software directory to contain 
your protocol files.

Related topics
For information about... See...

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73

Setting up a plate instance “Setting up a protocol process” on 
page 76

Resolving protocol compilation 
errors

BenchCel Microplate Handling 
Workstation User Guide

Setting the number of 
simultaneous plates

“Compiling and saving protocols” on 
page 83
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Simulating a run

About this topic This topic provides suggestions on how to check for errors in a protocol 
after it is compiled.

Simulating the run After making sure there are no compiler errors in the protocol, you can 
check for other types of problems by running the protocol through the 
simulator. The simulator allows you to confirm that steps are completed 
and sequenced correctly. and to find problems such as:

❑ Deadlocks 

❑ Periods of inefficiency, such as when the robot is not being used

❑ Plates spending different times at critical steps when they should be 
run under identical conditions

❑ A number of simultaneous plates that is too high or too low

The simulator does not move plates. It performs a virtual run based on 
the estimated execution times displayed for each task. You can change 
the execution times for tasks to make the simulation more accurate for 
your protocol.

One approach you can use for testing is the following:

1. Run the simulator with the default task execution times and the 
same number of plates expected for a run to identify deadlocks and 
rate-limiting tasks.

2. Resolve any major problems with the protocol.

3. Perform a real dry run with a plate.

4. Use the times recorded in the log to edit the task execution times for 
each task.

5. Run the simulator with the more accurate task execution times.

6. Make adjustments to the protocol based on the results of the 
simulation.

Running the 
simulator

To run the simulator:

1. Click Simulation is off on the toolbar.

The button changes to Simulation is on.

2. Click Start to run the protocol in simulation mode.
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Related topics

Setting the number of simultaneous plates

About this topic This topic describes the concept of simultaneous plates and how to set 
the simultaneous plate number.

The number of simultaneous plates is the maximum number of plates 
belonging to a single process that are in the system at one time.

Plates that are in the system could be in the robot gripper, on platepads, 
pipettor location, plate hotels, and so on. Simultaneous plates do not 
include counterweight plates.

Setting the number of simultaneous plates is part of the process of 
setting up a process in the Protocol Editor.

Selecting the 
number

The default number of simultaneous plates is set to one for each 
protocol process. If your protocol process uses multiple devices, you 
can increase the throughput of the system by increasing the number of 
plates to be processed simultaneously. The challenge is to determine the 
balance between highest throughput and avoiding deadlock.

The number of simultaneous plates to select for a plate instance 
depends on how many:

❑ Positions available during a protocol process

In general, one simultaneous plate can be used for every task in the 
protocol. This is because, in general, each task uses one plate 
position. For example, if your protocol downstackes a plate, seals the 
plate, labels the plate, and then upstacks the plate, you have three 
positions available; one in the robot grippers, one on the plate 
sealer, and one on the microplate labeler. There are exceptions to 
this, though, such as cases where the same plate position is used for 
more than one of the tasks and when a VPrep Pipettor is used. 
Several plates can be positioned on a VPrep Pipettor at the same 
time.

For information about... See 

Compiling and saving a 
protocol

“Compiling and saving protocols” on 
page 83

Resolving errors BenchCel Microplate Handling Workstation 
User Guide

The workflow that this 
procedure belongs to

“Workflow for creating a protocol” on 
page 73
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❑ Positions there are in the system that will incubate plates.

For example, if your protocol downstacks a plate, dispenses liquid, 
incubates the plate at a 10-position plate hotel, and then dispenses 
more of the same liquid, you have 12 positions available; one in the 
robot grippers, one on the dispenser, and 10 in the plate hotel.

❑ Plates there are in a restack task.

If the protocol includes a restack task, the number of simultaneous 
plates must be equal to, or greater than, the number of plates in the 
restack task.

If the number of simultaneous plates is set too high, the protocol might 
be slowed down because the robot will move around to avoid a 
deadlock. A deadlock occurs when too many plates are in the system 
and there is no way to move the plates around further, at which point the 
protocol stops.

If the number of simultaneous plates is set too low, the time for the 
protocol run could be extended. Optimizing the number of 
simultaneous plates is therefore critical for maximizing efficiency. 

Run the protocol in simulation, noting the protocol process time in the 
log, then increase the number of simultaneous plates and simulate 
again. When the simulated time no longer decrease, you have found the 
optimal number of simultaneous plates. If you see messages in the log 
that say “Attempting to avoid deadlock by...”, then your protocol might 
have too many simultaneous plates. Decreasing the number of 
simultaneous plates will decrease the likelihood of a deadlock during 
the protocol run.

Determining the 
correct release rate

Another aspect to optimizing your protocol is the rate at which plates 
enter the system, particularly if you have a precisely timed incubation 
for one of the tasks.

Consider the following:

A plate will be downstacked when the first required device is available 
to process plates, and the number of plates currently being processed is 
less than the number of simultaneous plates. If a task in the protocol 
process takes longer to perform than it takes for the BenchCel 
Workstation to introduce new plates, this task will become a bottleneck. 
Plates will be introduced into the system faster than they can be 
removed from the system and if your protocol requires precise 
incubation times, this can cause a problem. 

For example, if you have a protocol that downstacks, dispenses liquid, 
incubates for one hour, reads the plate, and then upstacks and the read 
takes 1 minute, but the dispense task only takes 10 seconds, the software 
will introduce new plates at a rate of 1 plate every 10 seconds until the 
number of simultaneous plates is reached. These plates will then sit in 
the incubation step for 1 hour, at which point the first plate will move to 
the reader. The second plate should leave the incubation step 10 
seconds behind the first plate, but it cannot because the first plate is still 
occupying the reader. The result is the second plate incubating for 50 
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seconds longer than the first plate. The third plate will incubate 50 
seconds longer than the second, and 100 seconds longer than the first.

To prevent this from happening, limit the input rate of your plates to 
match the output rate. Run the protocol dry once to determine where 
your bottleneck is and how quickly plates can be moved through the 
bottleneck. Set your input rate about 10% slower than the output rate to 
account for variance in the speed of the bottle-neck task.

Related topics
For information about... See...

Recovering from deadlock BenchCel Microplate Handling 
Workstation User Guide

Definition of a plate instance “Opening a protocol in BenchWorks 
software” on page 21

Setting up a plate instance “Setting up a protocol process” on 
page 76

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73
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Setting task 
parameters
 5
This chapter gives the procedures for configuring the parameters for 
individual tasks in a protocol. This chapter contains the following topics:

❑ “About setting Apply Label task parameters” on page 90

❑ “Setting Apply Label task parameters” on page 91

❑ “About combining barcode modifiers” on page 95

❑ “Setting Delid/Relid task parameters” on page 97

❑ “Setting Downstack and Upstack task parameters” on page 98

❑ “Using the Evaluate Script task” on page 102

❑ “Setting Incubation task parameters” on page 103

❑ “Setting Inoculate task parameters” on page 105

❑ “Setting Loop task parameters” on page 107

❑ “Setting Mount/Dismount task parameters” on page 108

❑ “Setting Pierce task parameters” on page 110

❑ “Setting Place Labware task parameters” on page 111

❑ “Setting Place Plate task parameters” on page 113

❑ “Setting Restack task parameters” on page 114

❑ “Setting Seal task parameters” on page 116

❑ “Setting Spawn Process task parameters” on page 117

❑ “Setting User Message task parameters” on page 118

❑ “Setting Waitfor task and Signal task parameters” on page 120

❑ “Setting VSpin Access2 Centrifuge task parameters” on page 121

❑ “Specifying task order across processes” on page 122
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About setting Apply Label task parameters

About this topic This topic provides some information about the Apply Label task to help 
you make choices about barcode labeling.

Apply Label task 
defined

The Apply Label task uses a VCode Microplate Labeler to print a 
barcode label and apply it to a plate.

Barcode labelling 
decisions

Before you add an Apply Label task to a protocol, consider your record-
keeping and automation needs. For example:

❑ Do you need each barcode label to be unique within a run, but not 
from run to run?

❑ Do you need each barcode label to be unique across all runs?

❑ Will you be using a Laboratory Information Management System 
(LIMS) for barcoding information and record-keeping?

❑ What human-readable fields do you want to include on the label?

❑ Do you want to use a barcode input file?

❑ Do you want to use a barcode data file?

Barcode format When setting Apply Label task parameters, you need to select a barcode 
format, which specifies the type, number, properties, and location of 
fields that are printed on barcode labels.

Some formats are provided with the VCode Microplate Labeler, but you 
can define others according to your needs. Each format is identified by 
a number, which you enter when setting up an Apply Label task.

Related topics
For information about... See...

Using barcode modifiers “About combining barcode 
modifiers” on page 95

Creating a barcode input file “Using barcode input files” on 
page 230

Using barcode data files “Using barcode data files” on 
page 233

General options “Setting BenchWorks software 
options” on page 22

Creating a plate instance “Setting up a protocol process” on 
page 76

Using plug-ins “About the FileReader plug-in” on 
page 203
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Setting Apply Label task parameters

About this topic This topic describes how to set the parameters for the Apply Label task.

Read this topic if you are:

❑ An administrator or technician who writes protocols that uses a 
VCode Microplate Labeler 

❑ An operator who needs to specify parameters for one or more of the 
apply label tasks

Before you start Before working with Apply Label tasks, read the VCode Barcode Print 
and Apply Station User Guide to learn about barcodes and label formats.

Procedure To set Apply Label task parameters:

1. Add the Apply Label task to a protocol process.

2. In the Protocol Task Parameters toolbar, click a tab corresponding to 
a side of the plate.

The options are South, West, North, and East.

3. Select one of the options in the Printing Option list.

Log files “About log and data files” on 
page 38

For information about... See...
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4. In the Format to use text box, type a number that corresponds to the 
barcode format that you want.

5. In the Number of Fields text box, type the number of fields that you 
want to print on the barcode.

The maximum number of fields you can print is limited by the 
number of fields in the format you selected. For example, if the 
format specifies three fields, you cannot print a barcode with four 
fields. In this example, if you do enter the number four into the text 
box, the last field is ignored.

6. Click in the Field text box for the first field that you want to use and 
enter one or more of the following types of information that you 
want to print in that position on the label:

If... Then...

You do not want to place a label 
on this side of the plate

Select No Label and return to step 2.

You want to define a barcode 
label and place it on this side of 
the plate

Select Use this label and continue 
with step 4.

You want to print a label that is 
the same as a label already set 
up for another side of the plate

Select Use side label and continue 
with step 4.

All other parameters on the page are 
ignored.

If you want to print... Then...

Text field that does not 
increment

Type the text in the text box.

A field that is identical to 
a barcode field on 
another side of the plate

To use this option, your VCode Microplate 
Labeler must have an attached barcode 
reader.

a. Select the side of the plate from the from 
side side list, below the Use existing 
barcode button.

b. Click Use existing barcode.
This places the code [BC] in the text 
box.

Note: This option copies a single field from 
another side of the plate. The similar option 
selected in the Printing Options list copies 
an entire barcode from another side of the 
plate.
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A series of barcodes 
from a barcode input file

a. Make sure that you have set up a 
barcode input file and selected it in 
BenchWorks software general options.

b. Make sure that the number of barcodes 
specified in the series of the barcode 
input file that you want to use is equal to 
or greater than the number of labels that 
you want to print.

c. Select the series in the Barcode file 
entry list at the bottom of the toolbar.

Note: If there are no entries in the 
Barcode file entry list other than the 
default text, you need to set the location 
of the barcode input file. 

d. Click From File.
This places the code [FILE] in the text 
box.

!! IMPORTANT !! If you use this 
option in two fields, the same data will 
be printed in both fields. You cannot 
enter different data into fields using 
this method.

A series of barcodes by 
referencing barcodes on 
another side of the plate, 
using a barcode data file

a. Make sure that you have created a 
barcode database file and selected it in 
BenchWorks software general options.

b. Make sure that the incoming plates have 
barcode labels on the south or west side, 
or a previous Apply Label task is set up 
to print labels on the south or west side.

c. If the incoming plates are labelled, make 
sure that the system verifies the labels by 
setting up barcode control on the plate 
icon.

d. Click From text database.
This places the code [DB] in the text 
box.

e. In the use side side list under the From 
text database button, select the side of 
the plate that has the barcodes you want 
to use as a reference.

!! IMPORTANT !! Although you can 
select any side, only the south and 
west sides can currently be used.

If you want to print... Then...
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7. Return to step 6 and fill out another field until all required fields are 
completed.

Note: If you enter information in a field that does not exist in the 
format you have chosen, the information is ignored.

8. Return to step 3 and define labels to put on other sides of the plate.

Related topics

A series of barcodes that 
increment, but which are 
not specified by a 
barcode input file

a. Type the root data that you want in the 
Field 1 text box.

b. Click Increment.
This adds the code [INC] to the root 
data.

c. In the Increment chars text box, type 
the number of alphanumeric characters 
that you want to be appended to the root 
data.
For example, if you want the series to 
increment from 01 enter 2. If you want it 
to increment from 001, enter 3.

d. In the Starting increment # text box, 
type the number that you want to be 
printed on the first label, for example, 
100.

e. Select either Numeric or Alphanumeric 
depending on the increment style you 
prefer. 
Alphanumeric increments use 0–9, A–Z, 
whereas numeric increments use 0–9.

From a plug-in that you 
have developed

Select From user plug-in.

If you want to print... Then...

For information about... See...

Using barcode modifiers “About combining barcode modifiers” 
on page 95

Creating a barcode input file “Using barcode input files” on page 230

Using barcode data files “Using barcode data files” on page 233

General options “Setting BenchWorks software options” 
on page 22

Creating a plate instance “Setting up a protocol process” on 
page 76

Using plug-ins “About the FileReader plug-in” on 
page 203

Log files “About log and data files” on page 38
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About combining barcode modifiers

About this topic This topic describes how to combine barcode modifiers for the Apply 
Label task.

Barcode modifiers are text/numerical strings that are appended to the 
barcode. Typically they are used to add a readable text/numerical string 
to a barcode, which increments for each plate, giving each plate a 
unique label.

Read this topic if you are: 

❑ An administrator or technician who writes protocols that uses a 
VCode Microplate Labeler 

❑ An operator who needs to specify parameters for one or more of the 
Apply Label tasks

Before you start Before you modify the barcodes, read the VCode Barcode Print and 
Apply Station User Guide to become familiar with barcodes and label 
formats.

Combining barcode 
modifiers

You can combine barcode modifiers with text in a single field. This 
section shows how to do this by using an example. The example has five 
fields and for each field the symbology or font used has been defined as 
follows in the VCode Microplate Labeler.

In the screenshot below, you can see that three of the BenchWorks 
software fields are used: Field 2, Field 3, and Field 4. 

Format field (valid 
for pre-2003 VCode 
Microplate Labeler)

BenchCel 
Workstation/VCode 
Microplate Labeler 
field

Symbology/Font

Field 0 Field 1 Swiss Mono 721 Bold

Field 1 Field 2 Code 39

Field 2 Field 3 Dutch Roman 801 prop

Field 3 Field 4 Dutch Roman 801 prop

Field 4 Field 5 Dutch Roman 801 prop
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Field 2 prints a Code 39 symbology barcode that is incremented for 
each printing. Field 3 prints the same barcode in the human readable 
Dutch Roman font. The text entered into Field 3 is the same as that 
entered into Field 2. 

The information entered in Field 3, combined with the information 
entered into the Increment chars and Starting increment # fields, creates 
the following human readable barcode sequence:

Date001

Date002

Date003

Date004

Date005

Date006

Date007...

The barcode log file Information about the barcodes that are applied during a run is saved in 
a barcode log file. Because this is a tab-delimited text file, the data can 
easily be imported into a spreadsheet program.

Related topics
For information about... See...

Creating a barcode input file “Using barcode input files” on page 230

Using barcode data files “Using barcode data files” on page 233
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Setting Delid/Relid task parameters

About this topic This topic describes how to set the Delid/Relid task parameters. These 
tasks are used by the BenchWorks software to remove and replace 
labware lids.

Read this topic if you are:

❑ An administrator or technician who writes protocols that uses this 
task

❑ An operator who needs to specify parameters for the Delid/Relid 
tasks

Delid/Relid task 
defined

The Delid task removes a plate’s lid using a device such as a plate hotel 
or vacuum delidding station. The Relid task replaces the lid. 

Neither the Delid nor Relid tasks have configurable parameters.

Example The Delid/Relid tasks are used to remove and replace a plate lid. A 
typical use for this task is shown below:

In the example, a plate is downstacked and the lid is removed. The plate 
is pipetted at the VPrep Pipettor and the lid is replaced. If your system 
has a trash chute and you want to remove a plate’s lid and put the lid in 
the trash, use the Delid task and do not add a subsequent Relid task.

Procedure Setting Delid/Relid task parameters
There are no task parameters for these processes.
 

General options “Setting BenchWorks software options” on 
page 22

Creating a plate instance “Setting up a protocol process” on 
page 76

Using plug-ins “About the FileReader plug-in” on 
page 203

Log files “About log and data files” on page 38

For information about... See...
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Related topics

Setting Downstack and Upstack task parameters

About this topic This topic describes how to set the Downstack and Upstack task 
parameters.

Read this topic if you are:

❑ An administrator or technician who writes protocols using the 
Downstack and Upstack tasks

❑ An operator who needs to specify parameters for these tasks

Stacker task defined The Downstack and Upstack tasks move plates into or out ofBenchCel 
Workstation stacks.

The process of moving a plate out of a stacker is called downstacking. 
The process of moving a plate into a stacker is called upstacking.

Plates may be returned to the same or different stackers.

You can make a single task upstack to, or downstack from, more than 
one stacker. For example, in a downstacking task, when all of the plates 
are removed from one stacker, the robot will begin to pick plates from a 
second stacker. The two stackers are referred to as pooled downstackers.

You can also perform mixed upstacking where plates downstacked from 
two different stackers can be upstacked to one stack.

Procedure To set Downstack and Upstack task parameters:

1. Add the Downstack or Upstack task to a protocol process. 

For information about... See...

Defining lidded plates “Defining labware” on page 245

Adding and deleting tasks “Adding and deleting tasks” on page 78

Creating a protocol process “Setting up a protocol process” on 
page 76

Specifying task order “Specifying task order across 
processes” on page 122
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2. In the list of available stackers in the Protocol Task Parameters 
toolbar, select a stacker to downstack from or upstack to and click 
Add. 

To select more than one stacker, SHIFT-click or CTRL-click before 
clicking Add.

An asterisk next to a stacker in the list means that the stacker is 
currently assigned to a task that uses the same labware.

3. To remove a stacker from your list of available stacker devices, select 
it and click Remove.

4. If you have added more than one stacker, you can change the order 
in which particular stackers are used:

a. Select a stacker.

b. Click Use earlier to increase the priority of the stacker or Use 
later to decrease the priority of it.

5. To specify a time interval for when plates are made available to the 
system, select the Release a new plate check box and type in an 
interval time.

You can use this feature to avoid a plate processing bottleneck that 
results in plates having different incubation times.

Consider a simplified example process in which plates are 
downstacked, labels applied, liquid dispensed into, and then 
incubated for 10 minutes.

Applying the label only takes a few seconds while subsequent tasks 
take longer. This creates a processing bottleneck.

If the dispense task takes 2 minutes, plates that are ready for the 
pipetting step would have to wait. In this example, the first plate 
would incubate for approximately 5 minutes, the second plate for 
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approximately 7 minutes, the third plate for approximately 
9 minutes, and so on. To avoid these different incubation times, you 
could downstack one plate every 2 minutes. The plates are then 
incubated sequentially and not simultaneously.

6. If you want to dynamically assign an upstacking stackers, click Add 
dynamically-assigned stacker.

Note: This option is only available for upstacking tasks.

With dynamic assignment you do not have to specifically assign 
every stacker that will receive plates because assignments are made 
automatically. 

When stackers are dynamically assigned, the text “TBD,” meaning 
“To Be Determined”, is added to the stacker task icon.

Note: When using dynamically assigned stackers, you need to 
have a dynamic stacker in the Device Manager for each stack you 
expect to require.

You can determine which stackers contain which plates at the end 
of the run by consulting the run log.

Using mixed 
upstacking

This procedure describes how to downstack from two different stacks 
and upstack both to a single stack.

To use the mixed upstacking option:

1. Add the Upstack task to the first protocol process (downstacking 
from the first stack).

2. In the Task Parameters toolbar, select Allow different process 
plates....

3. Add the stack.

4. Add the Upstack task to the second protocol process (downstacking 
from the second stack).

5. In the Task Parameters toolbar, select Allow different process 
plates....

6. Add the stack.
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Related topics
For information about... See...

Adding and deleting tasks “Adding and deleting tasks” on page 78

Creating a protocol process “Setting up a protocol process” on 
page 76

Specifying task order “Specifying task order across 
processes” on page 122

Restacking “Setting Restack task parameters” on 
page 114
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Using the Evaluate Script task 

About this topic This topic describes how to use the Evaluate Script task in BenchWorks 
software.

About the Evaluate 
Script task 

The Evaluate Script task can be added to any protocol process to 
execute a JavaScript. Used in this way, the JavaScript does not have to be 
linked with a particular task.

The Evaluate Script task is represented by this icon in the Protocol Task 
toolbar:

This task is available in the pre-, post-, pipette-, and protocol editors

Procedure To use the Evaluate Script task:

1. Add the Evaluate Script task to a protocol process.

2. Click Advanced Settings in the Protocol Task Parameters toolbar (there 
are no task settings for this task).

3. Do one of the following to attach a script:

Enter a script in the text field

Click Browse and navigate to an external .txt file that contains the 
script

Related topics
For information about... See...

Using JavaScript “Using JavaScript in BenchWorks 
software” on page 209

Creating a protocol process “Setting up a protocol process” on 
page 76

Specifying task order “Specifying task order across 
processes” on page 122
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Setting Incubation task parameters

About this topic This topic describes how to set the Incubation task parameters.

Read this topic if you are:

❑ An administrator or technician who writes protocols using the 
Incubation task

❑ An operator who needs to specify parameters for this task

Incubate task 
defined

The Incubate task performs a timed incubation of a plate. It is typically 
used for short incubations.

The number of plates that can be incubated simultaneously is limited by 
the number of platepads that are available for holding plates.

Process overview

The overall process for a typical incubation is as follows:

1. Incubation of the plate starts with the addition of an initiating 
reagent.

This would be performed by a liquid-handling task, such as a Pipette 
Process task.

2. The plate is moved to a platepad.

When the plate arrives at the platepad, the incubation time 
parameter that you specify starts timing.

3. The plate is moved from the platepad to a reader.

The plate is moved when the incubation time parameter that you 
specify ends.

Incubation time 
error

The time parameter that you set for the incubation period is not the 
actual time of incubation. It represents the minimum time that the plate 
sits on the platepad where the incubation task is carried out.

The actual incubation period starts when the initiating reagent is added 
and continues until the plate is transferred to the next step in the 
process. This means that the actual incubation is longer than the time 
parameter that you set, by an amount that depends on the scheduling 
and operating speed of the robot.

If your assays require greater precision in plate incubation times than 
this method supports, you can adjust the rate at which plates enter the 
system.

Procedure To set incubation parameters:

1. Add the Incubate task to a protocol process window.

2. In the Task Settings page of the Protocol Task Parameter toolbar, 
type the length of time for which you want the plate to incubate on 
the platepad.
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3. If you need to control the rate at which plates are delivered to a 
particular device, incubate the plates on a plate hotel or similar 
short-term storage device and select Start timer when previous plate 
finishes incubating.

A situation can arise in which plates move through a protocol too 
fast for one of the steps. An example is a pipetting step in which a 
reagent that starts a timed reaction is added to the plate. The result is 
that plates queue up at the pipettor. 

Without selecting the Start timer when previous plate finishes 
incubating check box, plates are delivered to the plate hotel as fast 
as the robot can deliver them, are incubated for the time specified in 
the Length of incubation text box, and then leave as fast as the robot 
can remove them. The robot might remove the plates as frequently 
as every 10 seconds.

With the Start timer when previous plate finishes incubating check 
box selected, the time separation between each plate being picked 
up is specified by the value in the Length of incubation text box. 
Using this function, plates can leave the plate hotel and delivered to 
the pipettor every minute instead of every 10 seconds.

An alternative way to control the time at which plates are delivered 
to a device is to use the Release a new plate every x seconds 
parameter for the Downstack task.

4. If you want to restrict a device so it is not used as the place where 
the incubation takes place, in the Available devices box, select the 
device and click Exclude.

This might be useful if a particular platepad is used during multiple 
steps of the protocol.

The name of the platepad moves to the lower box.
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Example In the following example, a plate is downstacked, moved to an 
incubator, and then upstacked. 

Related topics

Setting Inoculate task parameters

About this topic This topic describes how to set the Inoculate task parameters.

Inoculate task 
defined

The Inoculate task performs a transfer of material from a source plate to 
a destination plate using a pin tool.

Procedure The Inoculate task was developed for the transfer of DNA from a source 
plate to a destination plate.

If you need to perform this task for this or another application, please 
contact the Velocity11 Technical Support for a procedure on how to set 
this task up in a protocol.

Related information

For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80

For information about... See...

Dispensing liquids “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80
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Setting Load, Unload, and Incubate at plate 
storage device task parameters

About this topic This topic describes how to set the parameters for the Load, Unload, 
and Incubate at plate storage device tasks.

Load, Unload, and 
Incubate at storage 
device defined

The Load task instructs a robot to move a defined set of plates into a 
storage device.

The Unload task instructs a robot to remove a defined set of plates from 
a storage device.

Using the Unload task and Load task in sequence instructs the robot to 
move a defined set of plates from one storage device to another.

The Incubate at storage device task moves a defined set of plates into a 
storage device, leaves them there for a specified time period and then 
removes them from the storage device.

These tasks are available for the following devices:

❑ PlateHub Carousel

❑ StoreX incubator

Procedures To set the Unload task parameters:

1. Confirm that the plates you want to move are in the system.

2. Add the Unload task to a protocol process.

3. In the Protocol Task Parameters toolbar, drag the groups or locations 
you want to unload from the Available groups/locations list to the 
Assigned groups/locations list.

To set the Load task parameters:

1. Add the Load task to a protocol process.

2. In the Protocol Task Parameters toolbar, drag the groups or locations 
you want to load into from the Available groups/locations list to the 
Assigned groups/locations list.

To set the incubate at storage device task parameters:

1. Add the Incubate at plate storage device task to a protocol process.

Note: The Incubate at plate storage device task cannot be the last 
task in a process.

2. In the Task Settings page of the Protocol Task Parameters toolbar, 
select the devices that you don’t want to use for the incubation from 
the Available devices list and click Exclude. 

The devices that you exclude appear in the Devices that will be 
excluded from this task list.

3. Enter the length of time to incubate in the Length of incubation (sec) 
field.
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Related topics

Setting Loop task parameters

About this topic This topic describes how to set the Loop task parameters. This task is 
available for all protocol processes and is illustrated with an example in 
which an Aspirate/Dispense pair of tasks is looped four times.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Loop task

Loop task defined The Loop pipette task allows you to repeat a set of tasks within a 
process.

Procedure To set Loop task parameters:

1. Add the Loop task to the protocol process or sub-process, where you 
want the loop to begin. After adding the task, a second icon labeled 
End of Loop is also added. 

2. Drag the End of Loop task where you want the loop to end.

3. Click the Protocol Task Parameters tab. Set the Loop properties. 

An example is shown below.

For information about... See...

Configuring a Liconic StoreX Device Driver User Guide

Configuring a PlateHub Carousel Device Driver User Guide

Setting up plates in the inventory 
editor

“Setting up the inventory management 
database” on page 171

Moving plates to and from storage 
devices

“Moving stored plates out of the system” 
on page 182

Using the inventory editor “BenchWorks software inventory 
overview” on page 168

Property Description

Number of times to loop Enter the number of times you want 
the tasks inside the loop to run.

(Setting this to 1 is equivalent to not 
using the loop tasks.)
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Related topics

Setting Mount/Dismount task parameters

Introduction This topic describes how to set the Mount and Dismount task 
parameters.

About the Mount/
Dismount task 

The Mount task places one plate on top of another plate and works in 
collaboration with the Waitfor task. The Dismount task removes a plate 
from the top of another plate.

The Mount and Dismount tasks are represented by the following icons in 
the Protocol Tasks toolbar:

When to use These tasks are associated with a platepad device and are typically used 
to mount a filter plate onto another plate or reservoir. 

Before you start Before you start make sure that your labware is properly configured.

❑ The plate or reservoir you want to be on the bottom is set to Can be 
mounted in the Labware Editor

❑ The plate you want to be on the top is set to Can mount in the 
Labware Editor

For information about... See...

The loop task in an example “Setting Loop task parameters” on 
page 107

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Procedure To set Mount task parameters:

1. In the protocol process that is downstacking the upper plate (for 
example, a filter plate), add a Waitfor task at the position you want to 
mount the plate.

2. Select the Waitfor task.

3. In the Protocol Task Parameters toolbar, enter a name for the Waitfor 
task.

4. In the protocol process that is downstacking the lower plate (for 
example an elution plate), add the Mount task at the position you 
want to mount the plate.

5. Select the Mount task.

6. In the Protocol Task Parameters toolbar, select the labware you want 
to mount from the list box.

To set the Dismount task parameters:

1. Add the Dismount task to the protocol process to which you’ve 
added the Mount task.

There are no task parameters for the Dismount task.

In the following example, the mounted filter plate (sandwiched with 
the lower plate) was centrifuged, and then the filter plate was 
dismounted and discarded to waste. The lower or elution plate was 
then upstacked.
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Related topics

Setting Pierce task parameters

About this topic This topic describes how to set the Pierce task parameters for 
BenchWorks software.

Read this topic if you are:

❑ An administrator or technician who writes protocols using the 
Pierce task

❑ An operator who needs to specify parameters for the Pierce task

Pierce task defined The Pierce task pierces a plate seal using a PlatePierce.

Procedure To set the Pierce task parameters:

1. Add the Pierce task to a protocol process. 

2. In the Task Settings page of the Protocol Task Parameter toolbar, 
enter a value in the Pierce Pressure text box.

If you are unsure of the best piercing pressure to use for your 
application, contact Velocity11 Technical Support.

Related topics

For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80

For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78
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Setting Place Labware task parameters

About this topic This topic describes how to set the Place Labware task parameters.

When to use The Place Labware task is designed for labs that use multiple types of 
labware for a protocol. It is useful if you have devices where you want to 
use one type of labware on the device for some runs and another type 
for other runs of the same protocol. This saves you from having to create 
a device file for each protocol that uses a different type of labware. 

If you are always using the same labware, you might not want to use this 
task.

The Place Labware task is only used in pre- or startup-protocol 
processes.

The Place Labware task can only be used with labware that is stationary 
throughout the running of the protocol.

The Place Labware task allows you to associate a specific type of 
labware with a device just before starting a run instead of in the device 
file.

Usage example For example, if in one protocol you restrict use of a device to labware1 
only, and in another protocol you restrict use of the same device to 
labware2 only, there are two ways to handle this:

1. Create two device files, one called device for labware1 and another 
called device for labware2, where the labware type is specified in 
the “Allowed / prohibited labware” device property.

2. Create one device file where labware type is not specified, then 
create a startup-protocol for each protocol where the Place Labware 
task specifies the labware that must be used for the protocol.

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80

For information about... See...
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Procedure To set task parameters for the Place Labware startup-protocol 
task:

1. Add the Place Labware task to the protocol process.

2. In the Task Settings page of the Pre/Post Protocol Task Parameters 
toolbar select items from appropriate boxes:

The device you want to use with this task 

The location of the labware on the device you are using

Labware you are using in this protocol
 

Related topics
For information about... See...

Working with device files “About barcode reading and tracking” 
on page 229

Pre-protocol and post-protocol 
processes

“Setting up a pre-protocol or post-
protocol process” on page 74

Creating protocols “Workflow for creating a protocol” on 
page 73
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Setting Place Plate task parameters

About this topic This topic describes how to set the Place Plate task parameters for 
BenchWorks software.

Read this topic if you are:

❑ An administrator or technician who writes protocols using the Place 
Plate task

❑ An operator who needs to specify parameters for the Place Plate task

Place Plate task 
defined

The Place Plate task moves a plate to any location. This task has many 
uses.

The next task in the process after a Place Plate task moves the plate to 
another location.

Place Plate task and 
barcodes

The Place Plate task can be used in combination with a platepad 
barcode reader to read a barcode. The requirements for this are as 
follows:

❑ The platepad must be set up in the device manager as a barcode 
reader for the platepad.

❑ The protocol process for the plate must indicate that the plate has a 
barcode on the side that the barcode reader reads. See Related 
topics at the end of this topic for how to do this.

Whenever a plate is placed on this platepad, the BenchWorks software 
scheduler tells the barcode reader to read the plate’s barcode.

Procedure To set the Place Plate task parameters:

1. Add the Place Plate task to the protocol process.

2. In the Task Settings page of the Protocol Task Parameter toolbar, 
select the device to which you want to move the plate.

3. If the Place Plate task is the first task in the protocol and you want to 
require that the operator confirms the barcode on the plate that is 
placed, check the Manually confirm barcode check box.

This can prevent the wrong plate from being used in the protocol.

To confirm the barcode, when the plate is picked up, the operator is 
prompted to enter the barcode of the plate that should be in the 
placed position. If the two codes do not match, an error is 
generated.

Related topics
For information about... See...

Indicating barcodes on a protocol 
process

“Setting up a protocol process” on 
page 76
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Setting Restack task parameters

About this topic This topic describes how to set the Restack task parameters in 
BenchWorks software.

Read this topic if you are:

❑ An administrator or technician who writes protocols using the 
Restack task

❑ An operator who needs to specify parameters for the Restack task

Restack task defined The Restack task collects plates in a stack, moves them to another stack 
in a definable time and in a way that maintains the proper order of the 
plates, so that they are ready to be passed to another task.

The Restack task can be used as part of a larger process that carries out 
simultaneous, timed incubations of more than one plate, where the 
goals are the following:

❑ Time between the start of the incubation and the reading of the 
plate to be approximately the same for each plate

❑ Evaporation from the plates is to be minimized

Note: Two or more stacks are required to use the Restack task.

Procedure To set Restack task parameters:

1. Add the Restack task to a protocol process.

2. In the Protocol Task Parameters toolbar either:

Select the empty racks that you want to use for the task and click 
Add.

Click Add dynamically-assigned stacker.

With this option, the scheduler automatically assigns racks 
during a run, and there must be at least two racks available for 
this operation.

3. If you have added more than one rack, you can change the order in 
which particular racks are used:

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80

For information about... See...
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a. Select a rack.

b. Click Use earlier to increase the priority of the rack or Use later 
to decrease the priority of it.

4. In the Store up to text box, type a number equal to the number of 
plates you intend to incubate.

This value is important because it can affect the timing of the 
incubation. For example, if the time taken to move all plates to the 
first restack rack is greater than the time specified for the incubation, 
the first plate cannot be moved to the next task in time. This problem 
can be resolved by lowering the number of plates in a restack 
operation and adding more racks.

5. In the Incubate plate for text box, type the time interval between 
when a plate enters the first restack rack and leaves the second 
restack rack.

!! IMPORTANT !! When you start a run that includes a Restack 
task, you must type in a number that is equal to the total number of 
plates you want to restack in the Number of Runs dialog box.
 

Usage example The following screen shot shows one example of how to use the Restack 
task. The plates are first downstacked and delivered to a VPrep pipettor 
for a pipette process. After the pipette process is completed, the plates 
are restacked to their original order, ready for the next step in the assay 
protocol.

Related topics
For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80
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Setting Seal task parameters

About this topic This topic describes how to set the Seal task parameters for BenchWorks 
software. 

Read this topic if you are:

❑ An administrator or technician who writes protocols using the Seal 
task

❑ An operator who needs to specify parameters for the Seal task

Seal task defined The Seal task places a seal on a plate using a PlateLoc Sealer.

If you are sealing more than one type of plate that requires different 
sealing temperatures, we recommend that you use a separate PlateLoc 
Sealer for each temperature. This avoids time delays as the PlateLoc 
Sealer heats and cools between different plate types.

When you open a protocol containing one or more Seal tasks, the 
PlateLoc Sealer immediately starts adjusting to the temperatures defined 
in the task parameters.

Procedure To set Seal task parameters:

1. Add the Seal task to a protocol process.

2. In the Protocol Task Parameters toolbar, enter a seal time and seal 
temperature.

When you enter a seal temperature, the PlateLoc Sealer immediately 
starts adjusting to that temperature.

3. Select the PlateLoc Sealer to use for the sealing operation from the 
Select PlateLoc to use list.

If you are using more than one PlateLoc Sealer, make sure that you 
select the device with the correct seal type temperature and time for 
the plate.

Related topics
For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80
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Setting Spawn Process task parameters

About this topic This topic describes how to configure the Spawn Process task in 
BenchWorks software.

About the Spawn 
Process task

The Spawn Process task instructs BenchWorks software to initiate 
another protocol process. 

Typically, this task is used in conjunction with a script initiating another 
process when a certain condition is met. For example, plates entering 
the system could be funneled into different processes depending on 
their barcode. 

The Spawn Process task is represented by this icon in the Protocol Tasks 
toolbar:

Setting the Spawn 
Process task 
parameters

To set the Spawn Process task parameters:

1. Add the Spawn Process task to the protocol process.

2. In the Protocol Task Parameters toolbar, make sure that the Task 
Setting tab is displayed.

3. Select the process you want to initiate with the Spawn Process task.

4. Select Launch as a subroutine if you want to continue with the 
current process after the Spawn Process task is executed.

Related topics
For information about... See...

Adding tasks to protocols “Adding and deleting tasks” on page 78

Using JavaScript “Using JavaScript in BenchWorks 
software” on page 209

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80
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Setting User Message task parameters

About this topic This topic describes the parameters for the User Message task. 

Read this topic if you are:

❑ An administrator or technician who writes protocols for the 
BenchCel Workstation

❑ An operator who runs protocols and may need to set the parameters 
for this task

User Message task 
defined

The administrator or technician who creates a protocol can add User 
Message tasks to provide reminders to the operator. The reminders are in 
the form of messages that appear on the screen at the appropriate time 
and pause the protocol until acknowledged by the operator.

User message tasks can, for example, be used to remind the operator to 
empty the waste container, fill a reservoir, or remove plates. 

Note: User messages do not appear when running a protocol in 
simulation mode.

!! IMPORTANT !! Remember to remove all user messages from 
protocols that you intend to run unattended.

Example  In the example shown below, the protocol has three user messages that 
remind the operator to perform final run-preparation tasks. The user 
messages appear before the plates are downstacked.The intended 
sequencing of the User Messages tasks can be ensured by the addition 
of Signal tasks to the other processes in the protocol.

Procedure To set User Message task parameters:

1. Add the User Message task to a protocol process. 

2. Set the User Message properties.

Property Description

Title Name of the user message, such as fill 
reservoir.

Body Details about the task, such as which 
locations to fill.

First plate of the series only Displays the message the first time it is 
encountered for that process during the 
run.
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Related topics

Every x plates Displays the message the first time it is 
encountered for that process, and then 
every x number of times it is encountered 
for that process during the run.

For example, if the value of x is 3, the first 
plate and the fourth plates in the protocol 
will trigger the message.

Last plate of the series only Displays the message the last time it is 
encountered for that process during the 
run.

User data entry into 
variable named

Displays a message that asks for input from 
the user. The message is generated from a 
script that is added to one of the tasks.

Property Description

For information about... See...

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73

Adding tasks to protocols “Adding and deleting tasks” on page 78

Using JavaScript with BenchWorks 
software

“Using JavaScript in BenchWorks 
software” on page 209

Signal tasks “Setting Waitfor task and Signal task 
parameters” on page 120

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80
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Setting Waitfor task and Signal task parameters

About this topic This topic describes how to set the Waitfor and Signal task parameters 
for BenchWorks software.

Read this topic if you are:

❑ An administrator or technician who writes protocols for the 
BenchCel Workstation

❑ An operator who runs protocols and may need to set the parameters 
for this task

Waitfor and Signal 
tasks defined

The Waitfor task and a Signal task work together to specify the order in 
which tasks are performed across processes.

You must first set the Waitfor task and then set the Signal task.

Procedure To set Waitfor task parameters:

1. Add a Waitfor task to a protocol process.

2. In the Protocol Task Parameters toolbar, type a name for the task.

To set Signal task parameters:

1. Add a Signal task to a protocol process.

2. In the Available waitfors text box of the Protocol Task Parameters 
toolbar, select the Waitfor task that you want to reference.

3. Click Add.

The task moves to the lower box.

Related topics
For information about... See...

Example usage of Waitfor and 
Signal tasks

“Specifying task order across 
processes” on page 122

Adding tasks to protocols “Adding and deleting tasks” on page 78

Specifying task order “Specifying task order across 
processes” on page 122

User message tasks “Setting User Message task parameters” 
on page 118
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Setting VSpin Access2 Centrifuge task 
parameters

About this topic This topic describes how to set the Access2 Microplate Loader task 
parameters.

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who may need to change the Access2 Microplate 
Loader task parameters

VSpin Access2 
Centrifuge task 
defined

This task moves a plate to an VSpin Access2 Centrifuge and centrifuges 
it.

Setting VSpin 
Access2 Centrifuge 
task parameters

To set VSpin Access2 Centrifuge task parameters:

1. Add the VSpin with Access2 task to a protocol process.

2. In the Task Settings page of the Protocol Task Parameter toolbar, 
select a VSpin from the Select a VSpin with Access2 to use list.

3. Set the desired options in the Load Plate area:

a. Enter the Gripper Z offset (mm) for the plate you are using. This 
value is the distance from the bottom of the plate to where the 
Access2 Microplate Loader grippers will grab the plate. Typically, 
this value is the same as the robot gripper offset.

b. If you don’t want to use the plate sensor on the Access2 
Microplate Loader, select the Ignore optical plate sensor check 
box.

c. If you are using flexible plates, such as PCR plates, select the Grip 
gently check box.

4. Set the spinning parameters in the Spin Plate area. Enter a value for 
the Velocity (%), Acceleration (%) and Deceleration (%). 

These parameters are calculated as a percentage of the maximum 
value possible. Maximum speed is 3000 rpm. For more information, 
see the VSpin Microplate Centrifuge User Guide.

5. Set the spin duration. 

a. Choose a Timer mode option.

Total time includes the time it takes the VSpin Centrifuge to 
accelerate to the target speed and decelerate to a stop. 

Time at speed only includes the time that the rotor is at the target 
speed.

b. Enter the spin duration.

The format for the timer is hours:minutes:seconds.
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Related topics

Specifying task order across processes

About this topic If you are running more than one process in a protocol, you may want to 
specify that a particular task in one process is performed before a 
particular task in another process. You do this when creating a protocol 
by using the combination of Waitfor and Signal tasks.

This topic describes how to use this task by providing an example. Read 
this topic if you are:

❑ An administrator or technician who writes protocols for the 
BenchCel Workstation

❑ An operator who runs BenchWorks software protocols

Example In this example, the administrator or technician creating the protocol 
wants to make sure that a barcode is applied to plate 1 before plate 2.

The operator creates the protocol shown in the following diagram.

The order in which plate 1 and plate 2 are processed is selected by the 
scheduler program. Without the Waitfor and Signal tasks, this would also 
be the case for the bar coding operation. However, in this protocol, the 
Waitfor task, called “Label Me Second”, is included for Plate 2, and this 

For information about... See...

Setting up counterweights BenchCel Microplate Handling 
Workstation User Guide

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80

Signal taskWaitfor task
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causes the process to wait until it receives an instruction to continue. 
Meanwhile, the barcode is applied to Plate 1.

After the barcode has been applied to Plate 1, the Signal task called 
“Label Me Second” releases the wait condition on Plate 2 and the 
barcode is applied.

Related topics
For information about... See...

Workflow for creating protocols “Workflow for creating a protocol” on 
page 73

Adding tasks to protocols “Adding and deleting tasks” on page 78

Pipette tasks “About setting pipette task parameters” 
on page 81

Other tasks “About setting task parameters” on 
page 80



Chapter 5: Setting task parameters
BenchWorks Automation Control  User Guide

124



125Chapter 6: 
BenchWorks Automation Control User Guide
Setting pipette task 
parameters
 6
This chapter gives the procedures for configuring the parameters for 
individual pipette tasks in a protocol. This chapter contains the 
following topics:

❑ “Configuring a pipette process: example” on page 126

❑ “Adding and configuring a Pipette Process task” on page 130

❑ “Configuring a VPrep Pipettor shelf as a device” on page 133

❑ “Setting Aspirate task parameters for a VPrep Pipettor” on page 135

❑ “Setting Aspirate task parameters for a Bravo Platform” on page 137

❑ “Setting Change Instance task parameters” on page 140

❑ “Setting Change Tips task parameters for a VPrep Pipettor” on 
page 142

❑ “Setting Dispense task parameters for a VPrep Pipettor” on page 144

❑ “Setting Dispense task parameters for a Bravo Platform” on page 147

❑ “Setting Dry Tips task parameters” on page 150

❑ “Setting Mix task parameters for a VPrep Pipettor” on page 150

❑ “Setting Mix task parameters for a Bravo Platform” on page 152

❑ “Setting Pump Reagent task parameters for a VPrep Pipettor” on 
page 155

❑ “Setting Pump Reagent task parameters for a Bravo Platform” on 
page 156

❑ “Setting Tips On task parameters for the Bravo Platform” on page 158

❑ “Setting Tips Off task parameters for the Bravo Platform” on page 159

❑ “Setting Wash Tips task parameters for a VPrep Pipettor” on page 160

❑ “Setting Wash Tips task parameters for a Bravo Platform” on page 164
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Configuring a pipette process: example

About this topic This topic gives an example of how to construct a pipette process as a 
sub-process that performs a simple pipetting operation. See Related 
topics at the end of this topic for more information about creating a 
pipette process. 

The example The goal of the pipetting operation in this example is to pipette 20 µL of 
1X TE buffer from a reservoir on a particular VPrep Pipettor into a Costar 
96-well plate.

Creating a protocol The first step is to create a new protocol by setting up a protocol process 
for the plate you want to pipette into.

Name the process “Plate A” and select the “Costar 96-well plate” as the 
plate type.

Downstacking a 
plate

The next step is to add a Downstack task that downstacks a plate from an 
appropriate stacker.

Adding a Pipette 
Process task

Next, you add a Pipette Process task.

Because there can be a number of Pipette Process tasks in a protocol, 
this particular pipetting operation is identified by the name selected 
from the list in the Pipette Task Parameters toolbar. In this simple case 
there is only one name to select, which is “Process1.” (You can rename 
the process, if desired.)
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Selecting a VPrep 
Pipettor

In this example, there are two VPrep Pipettors configured so you need to 
associate the one you want to use with the pipette process.

You do this in the Pipette Process Editor page. In the following example, 
the task will use VPrep1. VPrep2 remains available but is not used for 
this process.

Configuring the 
VPrep Pipettor shelf

You want to aspirate 20 µL of 1X TE buffer from a reservoir. This means 
that you have to configure a shelf of the VPrep Pipettor to hold the 
reservoir that will contain the buffer. You decide to use a 384 V11 
Reservoir (manual fill) 21.5 deep plate type for the reservoir.

We know that the VPrep Pipettor itself has already been configured in 
BenchWorks software as a device because you were able to select it in 
the previous step. We can also see it listed as a device in the device 
manager. To open the device manager you click the Device Manager tab.

Each shelf that you want to use on the VPrep Pipettor must also be 
configured as a device. The shelves are already set up as devices, but 
you need to make sure that shelf 1, where you want to place the buffer 
reservoir, is configured correctly. Again looking at the device manager 
you see that there are two shelves configured as reagent shelves, which 
can hold reservoirs.

On selecting reservoir 1 you see that it is assigned to shelf 1 of VPrep 2, 
which is what you want. However, the labware associated with the shelf 
is the wrong type.
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If you leave it as V11 MicroWash 384, the pipette tips might crash into the 
reservoir because the task will be performed on the assumption that the 
tips are moving into a Microwash tray rather than a 384 V11 Reservoir 
(manual fill) 21.5 deep reservoir.

So, you change the labware association to 384 V11 Reservoir (manual 
fill) 21.5 deep.

Note: To save the changes in the device manager you need to have 
administrator login privileges.

Note that when you associate a type of labware with the VPrep Pipettor 
shelf, you are also associating all of the parameters for that type of 
labware stored in the labware database. The VPrep Pipettor references 
the labware database parameters so that the pipette tips move to the 
right depth, position, and so on, as they enter the reservoir.

After configuring a VPrep Pipettor shelf, you compile the current 
protocol to check for errors.

Adding the Aspirate 
task

The next step is to add the Aspirate task.

Associating the task with a liquid class

In the Pipette Task Parameters toolbar of the Aspirate task, you need to 
tell the system what class of liquid it is aspirating. The system then uses 
the parameters stored in the liquid library database for that class during 
the aspiration operation.

In this case, you select the class 1XTE.

You can see the parameters used for the class by clicking the Edit 
button, which opens the liquid library editor.

Associating the task with the VPrep Pipettor shelf
In the Pipette Task Parameters toolbar of the Aspirate task, you need to 
tell the system from what type of labware to aspirate. 
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In this case there are two choices. If you select Plate A, the Costar 96-well 
plate you downstacked will be moved to the VPrep Pipettor and the 
volume aspirated from it. Instead, you select reservoir1, which is the 
name of the device that holds the buffer reservoir.

Finally, you want to specify a 20 µL aspiration.

The modified task is shown in the following diagram:

Adding a Dispense 
task

To complete the pipetting operation we have to add a Dispense task and 
set the parameters. 

Drag the Dispense task into the pipette process pane.

The task defaults to the first plate in the list, which in this case is Plate A, 
but the dispense volume is incorrect and there is no associated liquid 
class. After editing the task parameters, the task is shown in the 
following diagram:

The pipette process is now complete.

Related topics
For information about... See...

Setting up a protocol process for a 
plate

“Setting up a protocol process” on 
page 76

Liquid library editor “About the liquid library editor” on 
page 280



Chapter 6: 
BenchWorks Automation Control User Guide

130
Adding and configuring a Pipette Process task

About this topic This topic describes how to configure a Pipette Process task. This task is 
used when creating a BenchWorks software protocol that uses a 
Velocity11 VPrep Pipettor or Bravo Platform.

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who may need to change Pipette Process task 
parameters 

Adding a Pipette 
Process task

The first step in creating a pipette process is to add a Pipette Process task 
to the protocol editor. Drag the Pipette process icon into the protocol 
process.

Setting Pipette 
Process parameters

When you add the Pipette Process task, a new process is started in the 
Pipette Process Editor. The pipette process is represented by the Pipette 
Process icon in the Protocol Editor.

Because you can have more than one pipette process in a protocol, you 
must link the Pipette Process task to the pipette process by setting the 
Pipette Process parameters.

To set the Pipette Process task parameters:

1. In the Protocol Editor window, add a Pipette Process task to the 
protocol and then select it in the protocol sequence.

2. In the Pipette Task Parameters toolbar, select the pipette process 
that you want to use for this pipetting task.

Creating a pipette process task “Adding and configuring a Pipette 
Process task” on page 130

For information about... See...
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3. If the pipette process is for a replicate pipetting series, so that the 
same plate can be used over and over again, select the Use single 
instance of plates check box in the Task Setting page of the 
protocol process for the plate. 

Note: If the plate is a tip box, the tips will be picked up and the tip 
box will be moved from the VPrep Pipettor or Bravo Platform. At 
the end of the pipetting series, the tip box will be returned to the 
VPrep Pipettor or Bravo Platform and the tips replaced in it.

Associating the 
Pipette Process task

Because you can have more than one VPrep Pipettor or Bravo Platform 
on a lab automation system, you must link each pipette process with 
one or more devices that you want the task to be able to use. You do this 
by setting the parameter for the pipette process task.

To link a Pipette Process task to a pipette process:

1. In the Pipette Process Editor, select the Pipette process icon.

2. In the Available pipettors list of the Pipette Task Parameters toolbar, 
select one or more pipettors to link to and click Add.
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The selected pipettors move to the lower box and become available 
for the task to use.

Related topics
For information about... See...

Creating a pipette process “Configuring a pipette process: 
example” on page 126

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133
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Configuring a VPrep Pipettor shelf as a device

About this topic All VPrep Pipettor shelves have to be configured in BenchWorks 
software as devices before they can be used in a protocol. All shelves on 
your VPrep Pipettor were set up as devices at the factory. This topic 
shows you how to modify the existing settings for a shelf. 

Read this topic if you are an administrator or technician who writes 
protocols that uses a VPrep Pipettor. 

When to use this 
procedure

Use this procedure when creating a protocol that uses a type of reservoir 
on the VPrep Pipettor that is not currently set up or when a new type of 
shelf device is used in a protocol for the first time.

About associating a 
VPrep Pipettor shelf 
with a task

When you set parameters for some tasks, you have to select the type of 
labware or device used in the task. The following screenshot shows both 
a plate and a device in the list box of an Aspirate task.

The plate in the list box refers to Plate A in the associated process.

With Plate A selected, the robot will move the plate to the VPrep Pipettor 
and liquid will be aspirated from it.

Note: This does not specify which shelf the robot will deliver the plate to. 
If you would like to ensure that particular plate types go to particular 
shelves you should use labware classes in combination with allowed/
prohibited labware to force plates to go to specific shelves.

The device in the list box refers to a reagent shelf on the associated 
VPrep Pipettor. With shelf 1 selected, the VPrep Pipettor head will move 
to shelf 1 and the VPrep Pipettor will aspirate from whatever type of 
labware sits on the shelf.

Before you can run the protocol, you have to associate a type of labware 
with the VPrep Pipettor shelf. You do this in the device manager.

Procedure To configure a VPrep Pipettor reagent shelf as a device:

1. Click the Device Manager tab.

2. Select a reagent shelf in the Device List.
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3. Make sure that:

The Parent device is the VPrep Pipettor you intend to use.

The Shelf number is the shelf you intend to use.

Note: For most BenchCel Workstation configurations, reagent 
shelves have odd numbers, with shelf 1 being at the top left. 

If these are not correct, select another reagent shelf in the Device 
List.

4. Optional. Change the Device name to one that describes the type of 
liquid being used by typing over the existing name.

5. Select the type of labware that will contain the reagent from the 
Labware list box.

6. Click the blank column to the right of Allowed/prohibited labware.

7. Click the ellipsis button.

The Labware Classes dialog box opens.

8. Make sure that the labware you intend to use on this VPrep Pipettor 
shelf is in the Labware classes allowed to use this device column and 
not in the prohibited column.

9. Select File > Device File > Save to save the device file.

!! IMPORTANT !! Making a change to the device file could 
break other protocols that are using that device file. For 
example, if two protocols use the same device file, but one 
protocol calls for a manual fill reservoir on shelf 5 and the 
other calls for a microwash station you'll have to change the 
device file each time you switch protocols. In this case, create 
a separate device file for each protocol.
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Related topics

Setting Aspirate task parameters for a VPrep 
Pipettor

About this topic This topic describes how to set the Aspirate task parameters when 
creating a BenchWorks software protocol that use a VPrep Pipettor. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Aspirate task

Aspirate task 
defined

An Aspirate task is used with a VPrep Pipettor to draw up liquid from a 
plate or reservoir.

Before you start Before you start setting the Aspirate task parameters, you need to 
associate a VPrep Pipettor shelf with the labware type that will be used 
for the aspirating.

Procedure To set Aspirate task parameters:

1. Add an Aspirate task to the pipette process. 

2. If you have defined a liquid class for the liquid you intend to 
aspirate, select it from the Liquid class list at the bottom of the 
Pipette Task Parameters toolbar.

3. Complete the following fields:

For information about... See...

Working with Device files “About barcode reading and tracking” 
on page 229

Labware editor “About the labware editor” on page 248

Field Description

Aspirate volume The volume of liquid to be drawn up 
into each pipette tip.

Aspirate velocity The rate at which to draw up liquid.

If you selected a liquid class, this 
value is entered automatically from 
the liquid library editor and cannot 
be edited here.
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4. If the VPrep Pipettor head has fewer tips than the plate has wells, 
select a quadrant configuration from the Quadrant(s) diagram to 
indicate which well quadrant of the plate you want to aspirate from.

To select a quadrant, click a representative well. Two possible 
examples are shown below.

5. In the Plate to Aspirate from list, select the type of labware or device 
from which to aspirate.

Aspirate acceleration The rate of increase in velocity 
before the maximum aspirate 
velocity is reached.

If you selected a liquid class, this 
value is entered automatically from 
the liquid library editor and cannot 
be edited here.

Distance from well bottom The distance between the bottom of 
the pipette tips and the bottoms of 
the plate wells or MicroWash tray 
chimneys.

If you are using dynamic tip 
retraction this value sets the lowest 
point to which the tips will travel.

Tip retract distance The distance that the tips should 
move downwards per unit volume of 
liquid being aspirated.

This value allows the tips to move 
downwards during aspiration to 
maintain a certain height below the 
surface of the liquid. 

Determine an appropriate value by 
trial-and-error for each type of plate 
you use.

Note: You might want this value to be 
the same as the Tip Retract Distance 
for the Dispense task if both tasks are 
using the same labware type.

Pre-aspirate volume The volume of air to be drawn up 
before the pipette tips enter the 
liquid.

Post-aspirate volume The volume of air to be drawn up 
after the liquid is drawn up.

Field Description
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6. If you do not want to record this dispense in the transfer log, clear 
the Record in transfer log check box.

You might do this, for example, if you are running a casual test 
protocol.

Related topics

Setting Aspirate task parameters for a Bravo 
Platform

About this topic This topic describes how to set the Aspirate task parameters when 
creating a BenchWorks software protocol that uses a Bravo Platform. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Aspirate task

Aspirate task 
defined

An Aspirate task is used to draw up liquid from a plate or reservoir.

Procedure To set Aspirate task parameters:

1. Add an Aspirate task to a pipette process. 

2. Use the table below as a guide to complete the Aspirate Properties 
located in the Task Settings tab of the Task Parameters toolbar. 

For information about... See...

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Field Description

Location Identifies the location at which the 
aspiration will occur.

Volume (0–245 µL) Specifies the volume of liquid to be 
drawn up into each pipette tip.

Pre-aspirate volume (0–245 µL) Specifies the volume of air to be 
drawn before the pipette tips enter 
the plate.

Post-aspirate volume (0–245 µL) Specifies the volume of air to be 
drawn after the liquid is drawn up.

Liquid class Specifies a defined a liquid class for 
this liquid. 

Click the adjacent blank field to 
display an arrow and select the 
liquid from the list.

Distance from well bottom  
(0–100 mm)

Specifies the starting or maximum 
distance from the well bottoms that 
the tips will be during the aspirate 
cycle.

If you are using dynamic tip 
retraction this value sets the lowest 
point to which the tips will travel.

Dynamic tip extension 
(0–20 mm/µL)

Specifies the distance (in 
millimeters) to lower the head for 
each microliter aspirated.

Perform tip touch Specifies whether a tip touch is 
performed after each selection of the 
plate.

Which sides to use for tip touch Specifies which sides and in what 
order to use for the tip touch.

Tip touch retract distance  
(–20–50 mm)

Specifies the height that the tips 
move up before touching the sides of 
the wells.
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Related topics

Tip touch horizontal offset  
(–5–5 mm)

When the value for this parameter is 
0, the tips will move horizontally one 
well radius. The well radius is defined 
in the labware database for the type 
of plate you are using. If you want the 
tips to touch harder, increase this 
value. If you want the tips to touch 
more lightly, enter a negative value.

Well selection Identifies the wells for aspiration. 
Applies only if the Bravo Platform 
head has fewer tips than the plate has 
wells or if you are in single row/
column mode. Click the ellipsis 
button, and, in the Well Selection 
dialog box, select the well 
quadrant(s) of the plate from which 
you want to aspirate. 

Pipette technique Specifies a pipetting method to use 
for the aspiration. Click in the 
adjacent blank field to display an 
arrow and select the method from 
the list.

See the VWorks4 User Guide 
Addendum for more information 
about pipette techniques

Field Description

For information about... See...

Pipette techniques VWorks4 User Guide Addendum

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Change Instance task parameters

About this topic This topic describes how to set the Change Instance task parameters. 
This task is used when creating a BenchWorks software protocol that 
uses a Velocity11 VPrep Pipettor or Bravo Platform.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Change 
Instance task

Change Instance 
task defined

The Change Instance task is used in combination with a pipette loop to 
perform replicate dispense operations from a mother plate into a series 
of daughter plates.

Part of an example protocol, which contains a mother plate and the first 
of 10 daughter plates, is shown below.

An example pipette process for the mother plate is shown below.

When the protocol runs, 100 µl from each well of the mother plate are 
aspirated and 10 µl are dispensed into the first daughter plate (Daughter 
Plate 1). When the Change Instance task is reached, Daughter Plate 2 is 
moved into the system and 10 µl are dispensed into it from the mother 
plate. This loop repeats until all 10 daughter plates have been dispensed 
into.

Procedure To set Change Instance task parameters:

1. Set up a protocol and pipette processes following the example 
shown above.

2. In the Pipette Task Parameters toolbar, from the list, select the first 
daughter plate for the plate icon to change instance on.

!! IMPORTANT !! Only use Change Instance within a loop.
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3. Select a Spawn Option:

Precalculate... Select this option if you know the number of 
plates to use before the run starts. If the number of times to loop 
or the Change Instance task is scripted, you cannot use this 
option.

Spawn new plates... Select this option if you are scripting the 
number of times to loop or the Change Instance task. The 
scheduler will not precalculate the number of plates to use in 
the Change Instance task. Instead, every time this task executes, 
a new plate is brought into the system.

Do not spawn... Select this option to get a combination of the 
other two options. The scheduler will not precalculate nor will it 
bring in new plates when the Change Instance task executes. 
This option enables you to script the number of plates in the run 
and not have to wait for the Change Instance task to execute to 
bring in new plates.

An example of this is as follows:

Process ->Loop x times ->Spawn process y ->End loop
 

Related topics
For information about... See...

Setting up a plate instance “Setting up a protocol process” on 
page 76

Setting Loop task parameters “Setting Mix task parameters for a 
VPrep Pipettor” on page 150

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Change Tips task parameters for a VPrep 
Pipettor

About this topic This topic describes how to set the Change Tips task parameters. This 
task is used when creating a BenchWorks software protocol that uses a 
Velocity11 VPrep Pipettor.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Change Tips 
task

Change Tips task 
defined

The Change Tips task uses the robot to apply or remove VPrep Pipettor 
pipette tips.

Pairs of Change Tips tasks are usually used together. For example, if the 
protocol starts with tips already on the VPrep Pipettor, the first Change 
Tips task would remove the tips and the second Change Tips task would 
install new tips.

Change Tips tasks are always entered in a process created solely for 
changing tips; an example is described in this topic.

Before you start Before you start, you need to configure a shelf on the VPrep Pipettor to 
use tip boxes and have ready a tip box, containing tips, with the tip box 
lid removed and placed in a robot-accessible position.

Also, if you are removing tips first, you need an empty tip box on the tip 
box shelf of the VPrep Pipettor that you intend to use for the operation.

Overall process One method to change tips with a VPrep Pipettor requires you to create 
the following processes:

1. In the protocol editor, create a process for the tip box, such as in the 
following example.

2. In the pipette process editor, create a pipette process to change tips, 
such as in the following simple example.

Creating the process 
for the tip box

Before you can add a Change Tips task, you must create a process for the 
tip box that will contain the tips.
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Creating a process for the tip box:

1. Click the Protocol Editor tab.

2. Click Add.

A plate definition icon appears in the Protocol Editor window.

3. In the Protocol Task Parameters toolbar:

a. Type a name for the tip box in the Plate name text box.

b. In the Plate type list, select the tip box that has already been 
configured for use on the shelf of the VPrep Pipettor that you 
intend to use.

Note: Make sure that you select and use a tip box without lids. 
If the correct tip box is selected, the Plates have lids check 
box is unavailable.

c. In the Simultaneous Plates text box, type the maximum number 
of tip boxes of this type that you want to be available to the 
system at one time.

d. If the tip boxes have a barcode on the south side or west side, 
select the appropriate Incoming plates have a barcode... check 
box and list box option.

4. Add the Downstack task to the protocol process.

5. Set the Downstack task parameters.

6. Add the Pipette Process task to the protocol process.

7. Set the Pipette Process task parameters.

8. Add any other tasks that you want to for the tip box.

For example, you could add an Apply Label task to place a barcode 
on the tip box.

Creating the pipette 
process for 
changing tips

After you have created a process for the tip box, create a pipette process 
for the Change Tips task.

To create a pipette process for changing tips:

1. Click the Pipette Process Editor tab.

2. Add a Change Tips task to the pipette process.

3. In the Pipette Task Parameters toolbar, select either:

4. From the Select the tip box to use list, select the name of the tip box 
that you have assigned to the tip box process.

5. Add other tasks, including a second Change Tips task, as required. 

Option With this option, during the protocol...

❑ Press On New Tips

❑ Tips Off

Puts tips on to a VPrep Pipettor head.

Removes tips from a VPrep Pipettor head.
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Note: If you would like to use one box of tips, not delivered by the 
robot you can do so, but you must configure shelf 7 or 8 as a 
tipbox shelf with the appropriate labware definition.

Related topics

Setting Dispense task parameters for a VPrep 
Pipettor

About this topic This topic describes how to set the Dispense task parameters. This task is 
used when creating a BenchWorks software protocol that uses a VPrep 
Pipettor.

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Dispense task

Dispense task 
defined

A Dispense task is used with a VPrep Pipettor to dispense liquid into a 
plate.

Dispense value 
limits

You cannot dispense more volume than you aspirated.

If you enter a total dispense volume that is greater than the total aspirate 
volume you will get an error message when you compile the protocol. 
More specifically, the Aspirate Volume + Pre-Aspirate Volume + Post-
Aspirate Volume must be greater than or equal to the Dispense 
Volume + Blowout Volume + Post Dispense Volume.

For information about... See...

How to set the number of 
simultaneous plates

“Compiling and saving protocols” on 
page 83

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Labware editor “About the labware editor” on page 248

Applying labels “Setting Apply Label task parameters” 
on page 91

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Before you start Before you can set the Dispense task parameters, you need to associate 
a VPrep Pipettor shelf with the labware type from which you will 
aspirate.

Procedure To set Dispense task parameters:

1. In the pipette process window add the Dispense task to a pipette 
process.

2. If you have defined a liquid class for the liquid you intend to 
dispense, select it from the Liquid class list at the bottom of the 
Pipette Task Parameters toolbar.

3. Either:

Type the volume that you want to move out of each pipette tip in 
the Dispense Volume text box.

Select the Empty tips check box. Select this option if you want to 
empty the tips rather than deliver a specific volume of liquid.

Note: You might need to drag the toolbar to widen it so you 
can see the check box. 

4. Complete the remaining fields:

Field Description

Dispense velocity The rate at which to dispense the 
liquid.

If you selected a liquid class, this value 
is entered automatically from the 
liquid library editor and cannot be 
edited here.

Dispense acceleration The rate of increase in velocity before 
the dispense velocity is reached.

If you selected a liquid class, this value 
is entered automatically from the 
liquid library editor and cannot be 
edited here.

Distance from well bottom The distance between the bottom of 
the pipette tips and the bottoms of the 
plate wells or MicroWash tray 
chimneys.

If you are using dynamic tip retraction 
this value sets the lowest point to 
which the tips will travel.
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5. If the VPrep Pipettor head has fewer tips than the plate has wells, 
select a quadrant configuration from the Quadrant(s) diagram to 
indicate which well quadrant of the plate to which you want to 
dispense.

To select a quadrant, click a representative well. Two possible 
examples are shown below.

6. If you want the tips to touch one or more sides of the plate wells:

a. Select the Enable tip touch check box.

b. Type a value for the tip touch rise height.

This is the height that the tips should move upwards before 
touching the side of the wells.

c. Type a value for the Tip touch horiz distance.

When the value for this parameter is zero, the tips will move 
horizontally one well radius. The well radius is defined in the 
labware database for the type of plate you are using. If you want 
the tips to touch harder, increase this value. If you want the tips 
to touch more lightly, enter a negative value.

Retract distance The distance that the tips should move 
upwards per unit volume of liquid 
being dispensed.

This value allows the tips to move 
upwards during dispensing to 
maintain a certain height above the 
surface of the liquid. 

Determine an appropriate value by 
trial-and-error for each type of plate 
you use.

You might want this value to be the 
same as the Tip Retract Distance for 
the Aspirate task.

Blowout volume The volume of air to blow out when 
the tips are in the liquid.

This is typically the same as the pre-
aspirate volume.

Note: Blowout only occurs in the last 
quadrant dispensed into for a given 
Dispense task.

Post-dispense volume The volume of air to blow out when 
the tips are out of the liquid.

Field Description
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d. In the Number of sides to touch text box, type a value for 
number of sides of the wells that you want the tips to touch.

7. In the Plate to dispense to list, select the plate or device to which to 
dispense.

8. If you do not want to record this dispense in the transfer log, clear 
the Record in transfer log check box.

You might do this, for example, if you are running a casual test 
protocol. 

Related topics

Setting Dispense task parameters for a Bravo 
Platform

About this topic This topic describes how to set the Dispense task parameters when 
creating a BenchWorks software protocol that uses a Bravo Platform. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Aspirate task

Dispense task 
defined

A Dispense task is used to dispense liquid to a plate.

Procedure To set Dispense task parameters:

1. Add a Dispense task to a pipette process. 

2. Use the table below as a guide to complete the Dispense Properties 
located in the Task Settings tab of the Task Parameters toolbar. 

For information about... See...

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Field Description

Location Identifies the location at which the 
dispense will occur.

Empty tips Indicates whether to empty entire 
contents of tips, including fluid and 
air. Volume parameter is ignored if 
this option is yes.

Volume (0–245 µL) Specifies the volume of liquid to be 
dispensed from each pipette tip.

Blowout volume (0–245 µL) Specifies the volume of air to 
dispense after the main volume has 
been dispensed.

Typically, the blowout volume is the 
same as the pre-aspirate volume.

Note: Blowout only occurs in the last 
quadrant dispensed for a given 
Dispense task. 

Liquid class Specifies a defined a liquid class for 
this liquid. 

Click the adjacent blank field to 
display an arrow and select the 
liquid from the list.

Distance from well bottom  
(0–100 mm)

Specifies the starting or maximum 
distance from the well bottoms that 
the tips will be during the dispense 
cycle.

If you are using dynamic tip 
retraction, this value sets the lowest 
point to which the tips will travel.

Dynamic tip retraction 
(0–20 mm/µL)

Specifies the distance to lower the 
head for each microliter dispensed.

Perform tip touch Specifies whether a tip touch is 
performed after each selection of the 
plate.

Which sides to use for tip touch Specifies which sides and in what 
order to use for the tip touch.
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Tip touch retract distance  
(–20–50 mm)

Specifies the height that the tips 
move up before touching the sides of 
the wells.

Tip touch horizontal offset  
(–5–5 mm)

When the value for this parameter is 
0, the tips will move horizontally one 
well radius. The well radius is defined 
in the labware database for the type 
of plate you are using. If you want the 
tips to touch harder, increase this 
value. If you want the tips to touch 
more lightly, enter a negative value.

Well selection Identifies the wells for dispensing. 
Applies only if the Bravo Platform 
head has fewer tips than the plate has 
wells or if you are in single row/
column mode. Click the ellipsis 
button, and, in the Well Selection 
dialog box, select the well 
quadrant(s) of the plate to which you 
want to dispense. 

Pipette technique Specifies a pipetting method to use 
for the dispense. Click in the adjacent 
blank field to display an arrow and 
select the method from the list.

See the VWorks4 User Guide 
Addendum for more information 
about pipette techniques

Field Description

For information about... See...

Pipette techniques VWorks4 User Guide Addendum

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130



Chapter 6: 
BenchWorks Automation Control User Guide

150
Setting Dry Tips task parameters

Special note The Dry Tips task is associated with the VPrep Pipettor tip dryer. This tip 
dryer hardware is no longer available. If you have a tip dryer, contact 
Velocity11 Technical Support before using the Dry Tips task.

Setting Mix task parameters for a VPrep 
Pipettor

About this topic This topic describes how to set the Mix task parameters. This task is used 
when creating a BenchWorks software protocol that uses a VPrep 
Pipettor.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Mix task

Mix task defined The Mix task is used with a VPrep Pipettor to mix reagents by aspirating 
and then dispensing.

Before you start Before you start, you must associate a VPrep Pipettor shelf with the 
labware you will be using for the aspiration step of the mixing.

Procedure To set Mix task parameters:

1. Add the Mix task to the pipette process.

2. If you have defined a liquid class for the liquid you intend to mix, 
select it from the Liquid class list at the bottom of the Pipette Task 
Parameters toolbar.

3. Complete the following properties:

Property Description

Mixing volume The volume of liquid to be aspirated and 
dispensed to each plate well.

Number of mixing cycles The number of aspirate/dispense operations.

Aspirate velocity The rate at which to draw up liquid.

If you selected a liquid class, this value is 
entered automatically from the liquid library 
editor and cannot be edited here.

Aspirate acceleration The rate of increase in velocity before the 
maximum aspirate velocity is reached.

If you selected a liquid class, this value is 
entered automatically from the liquid library 
editor and cannot be edited here.
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4. If the VPrep Pipettor head has fewer tips than the plate has wells, 
select a quadrant configuration from the Quadrant(s) diagram to 
indicate in which well quadrant of the plate you want to mix.

To select a quadrant, click a representative well. Two possible 
examples are shown below.

5. If you want the tips to touch one or more sides of the plate wells:

a. Select the Enable tip touch check box.

b. Type a value for the Tip touch rise height.

Dispense velocity The rate at which to dispense the liquid.

If you selected a liquid class, this value is 
entered automatically from the liquid library 
editor and cannot be edited here.

Dispense acceleration The rate of increase in velocity before the 
dispense velocity is reached.

If you selected a liquid class, this value is 
entered automatically from the liquid library 
editor and cannot be edited here.

Distance from well 
bottom

The distance between the bottom of the 
pipette tips and the bottoms of the plate 
wells or MicroWash tray chimneys.

If you are using dynamic tip retraction this 
value sets the lowest point to which the tips 
will travel.

Retract distance The distance that the tips should move 
upwards or downwards per unit volume of 
liquid being dispensed or aspirated.

This value allows the tips to move upwards 
or downwards during dispensing or 
aspirating to maintain a certain height 
below or above the surface of the liquid.

You will need to determine an appropriate 
value by trial-and-error for each type of plate 
you use.

Pre-aspirate volume The volume of air to be drawn up before the 
pipette tips enter the liquid, and before 
mixing begins.

Last-cycle blowout 
volume

The volume of air to blow out when the tips 
are in the liquid once the mixing is 
complete.

This is typically the same as the pre-aspirate 
volume.

Property Description
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This is the height that the tips should move upwards before 
touching the side of the wells.

c. Type a value for the Tip touch horizontal distance.

When the value for this parameter is zero, the tips will move 
horizontally one well radius. The well radius is defined in the 
labware database for the type of plate you are using. If you want 
the tips to touch harder, increase this value. If you want the tips 
to touch more lightly, enter a negative value.

d. In the Number of sides to touch text box, type a value for the 
number of sides of the wells that you want the tips to touch.

6. In the Plate to mix list, select the type of labware or device in which 
to mix.

Related topics

Setting Mix task parameters for a Bravo 
Platform

About this topic This topic describes how to set the MIx task parameters when creating a 
BenchWorks software protocol that uses a Bravo Platform. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Aspirate task

Mix task defined A Mix task is used to dispense liquid to a plate.

Procedure To set Mix task parameters:

1. Add a Mix task to a pipette process. 

For information about... See...

Defining labware “About the labware editor” on page 248

Configuring VPrep shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280
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2. Use the table below as a guide to complete the “Mix” Properties 
located in the Task Settings tab of the Task Parameters toolbar. 

Field Description

Location Identifies the location at which the 
mix will occur.

Volume (0–245 µL) Specifies the volume of liquid to be 
mixed for each plate well.

Pre-aspirate volume (0–245 µL) Specifies the volume of air to be 
drawn before the pipette tips enter 
the plate.

Blowout volume (0–245 µL) Specifies the volume of air to 
dispense when the tips are in the 
liquid of the last quadrant after the 
last cycle.

Note: Typically the same as the pre-
aspirate volume. 

Liquid class Specifies a defined a liquid class for 
this liquid. 

Click the adjacent blank field to 
display an arrow and select the 
liquid from the list.

Mix cycles (0–100) Specifies the number of aspirate/
dispense operations.

Distance from well bottom  
(0–100 mm)

Specifies the starting or maximum 
distance from the well bottoms that 
the tips will be during the dispense 
cycle.

If you are using dynamic tip 
retraction, this value sets the lowest 
point to which the tips will travel.

Dynamic tip extension 
(0–20 mm/µL)

Specifies the distance that the tips 
will move downwards and upwards 
per unit volume of liquid being 
dispensed or aspirated.

For an approximation, use well 
volume/well depth. 
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Related topics

Perform tip touch Specifies whether a tip touch is 
performed after each selection of the 
plate.

Which sides to use for tip touch Specifies which sides and in what 
order to use for the tip touch.

Tip touch retract distance  
(–20–50 mm)

Specifies the height that the tips 
move up before touching the sides of 
the wells.

Tip touch horizontal offset  
(–5–5 mm)

When the value for this parameter is 
0, the tips will move horizontally one 
well radius. The well radius is defined 
in the labware database for the type 
of plate you are using. If you want the 
tips to touch harder, increase this 
value. If you want the tips to touch 
more lightly, enter a negative value.

Well selection Identifies the wells for dispensing. 
Applies only if the Bravo Platform 
head has fewer tips than the plate has 
wells or if you are in single row/
column mode. Click the ellipsis 
button, and, in the Well Selection 
dialog box, select the well 
quadrant(s) of the plate to which you 
want to mix. 

Pipette technique Specifies a pipetting method to use 
for the mix. Click in the adjacent 
blank field to display an arrow and 
select the method from the list.

See the VWorks4 User Guide 
Addendum for more information 
about pipette techniques

Field Description

For information about... See...

Pipette techniques VWorks4 User Guide Addendum

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Pump Reagent task parameters for a 
VPrep Pipettor

About this topic This topic describes how to set the Pump Reagent task parameters. This 
task is used when creating a BenchWorks software protocol that uses a 
VPrep Pipettor.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Pump Reagent 
task

Pump Reagent task 
defined

The Pump Reagent task is used on a VPrep Pipettor (or Bravo Platform) 
to pump liquid into an installed autofilling reservoir. Reservoirs are 
typically filled with washing buffer or water, and drained through the 
gravity drain.

!! IMPORTANT !! If you run an empty reservoir step and a fill 
reservoir step in the same protocol, check the protocol to make sure 
that it will not lead to an overflow.

Procedure To fill a VPrep Pipettor reservoir:

1. Add the Pump Reagent task to the pipette process.

2. In the Pipette Task Parameters toolbar, select Fill reservoir.

The Fill reservoir and Empty reservoir values determine whether the 
pumps will fill or empty the reservoir.

To empty the reservoir you must complete the Autofill Configuration 
information on the Shelves tab of the VPrep Diagnostics. 

3. In the list, select the shelf on which the reservoir is located.

4. In the for text box, type the pumping duration. This is the time in 
seconds that the pumps pump.

5. In the at text box, type the percentage of maximum pumping rate. 
This, combined with the pumping duration, determines the volume 
of fluid moved.

6. In the every text box, type a number that controls how frequently the 
liquid is pumped. For example, if you type 3, the pump will run 
every third time the task runs.

7. If you are using a Weigh Shelf, in the If liquid is below this level text 
box, enter the minimum percentage of liquid that you want the 
reservoir to contain. A typical value is 45%.

8. If you are using a Weigh Shelf, in the then fill reservoir to this level 
text box, enter the maximum percentage of liquid that you want the 
reservoir to contain. A typical value is 60%.
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Related topics

Setting Pump Reagent task parameters for a 
Bravo Platform

About this topic This topic describes how to set the Pump Reagent task parameters when 
creating a BenchWorks software protocol that uses a Bravo Platform. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Pump Reagent 
task

Pump reagent task 
defined

The Pump Reagent task is used on a Bravo Platform (or VPrep Pipettor) 
to pump liquid into an installed autofilling reservoir. Reservoirs are 
typically filled with washing buffer or water, and drained through the 
gravity drain.

!! IMPORTANT !! If you run an empty reservoir step and a fill 
reservoir step in the same protocol, check the protocol to make sure 
that it will not lead to an overflow.

Procedure To set Pump Reagent task parameters:

1. Add a Pump Reagent task to a pipette process. 

2. Use the table below as a guide to complete the “Pump Reagent” 
Properties located in the Task Settings tab of the Task Parameters 
toolbar. 

For information about... See...

Defining labware “About the labware editor” on page 248

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280
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Related topics

Field Description

Location Identifies the location at which the 
filling or emptying will occur.

Reservoir mode Specifies whether you want to fill or 
empty the reservoir.

Pump speed (0–100%) Specifies the percentage maximum 
speed.

Pump on time (0–600s) Specifies the pump time in seconds.

Use weigh station Indicates whether you are using a 
weigh station

Weigh station action threshold 
(0–100%)

Specifies the percentage of 
maximum weight for activating the 
Pump Module.

Weight station stop action 
threshold (0–100%)

Specifies the percentage of 
maximum weight for de-activating 
the Pump Module.

For information about... See...

Configuring accessories for the 
Bravo Platform

Bravo User Guide

Pump Module Bravo User Guide

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Tips On task parameters for the Bravo 
Platform

About this topic This topic describes how to set the parameters for the Tips On task when 
creating a BenchWorks software protocol that uses a Bravo Platform. 
Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to edit the Tips On task in a protocol

Tips On task defined A Tips On (Bravo) task puts fresh tips on the pipette head.

This task is available in Bravo Platform pipette and sub-processes and 
only with a pipette head that uses disposable tips (not fixed tips). 

Procedure To set the Tips On task parameters:

1. Add the Tips On (Bravo) task to a pipette process.

2. Use the table below as a guide to complete the “Tips On” properties 
located in the Task Settings tab of the Task Parameters toolbar. 

Related topics

Property Description

Location Identifies the location at which the 
tips on task will occur.

Well selection Identifies the wells for dispensing. 
Applies only if the Bravo Platform 
head has fewer tips than the plate has 
wells or if you are in single row/
column mode. Click the ellipsis 
button, and, in the Well Selection 
dialog box, select the well 
quadrant(s) of the plate to which you 
want the tips on task to correspond. 

For information about... See...

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Tips Off task parameters for the Bravo 
Platform

About this topic This topic describes how to set the parameters for the Tips Off task when 
creating a BenchWorks software protocol that uses a Bravo Platform. 
Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to edit the Tips Off task in a protocol

Tips Off task defined A Tips Off (Bravo) task removes the pipette tips from the pipette head.

This task is available in Bravo Platform pipette processes and only with a 
pipette head that uses disposable tips (not fixed tips). 

Procedure To set the Tips Off task parameters:

1. Add the Tips Off (Bravo) task to a pipette process.

2. Use the table below as a guide to complete the “Tips Off” properties 
located in the Task Settings tab of the Task Parameters toolbar. 

Related topics

Property Description

Location Identifies the location at which the 
tips will be removed.

Well selection Specifies the tips to be removed. 
Applies only if the Bravo head has 
fewer tips than the plate has wells or 
if you are in serial dilution mode. 
Click the ellipsis button, and, in the 
Well Selection dialog box, click wells, 
rows, or columns to highlight where 
in the tip box or tip trash the removed 
tips will be placed.

For information about... See...

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Setting Wash Tips task parameters for a VPrep 
Pipettor

About this topic This topic describes how to set the Wash Tips task parameters. This task 
is used when creating a BenchWorks software protocol that uses a VPrep 
Pipettor.

Read this topic if you are:

❑ An administrator or technician who writes protocols 

❑ An operator who needs to specify parameters for the Wash Tips task

Wash Tips task 
defined

A Wash Tips task is used with a VPrep Pipettor to wash pipette tips. 

Before you start Before you start, you need to have a VPrep Pipettor shelf associated with 
the labware type with which you want to wash.

Procedure To wash pipette tips:

1. Add the Wash Tips task to the pipette process.

2. If you have defined a liquid class for the liquid you intend to use for 
washing, select it from the Liquid class list at the bottom of the Task 
Parameters toolbar.

3. Complete the following properties:

Property Description

Wash volume The volume of liquid to be aspirated and 
dispensed to each plate well.

Dispense only Select this if you want to dispense the wash 
liquid to waste instead of dispensing it 
back into the reservoir of washing liquid. 

Note: The Dispense to waste at height 
of check box must be selected for this 
option to be available.

Enter the amount to dispense in the Wash 
Volume field.

Empty tips This option is only available if you select 
Dispense only. Select this if you want to 
empty the tips, regardless of the volume.

Number of wash cycles The number of aspirate/dispense 
operations.

Aspirate velocity The rate at which to draw up the liquid.

If you selected a liquid class, this value is 
entered automatically from the liquid 
library editor and cannot be edited here.
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4. If the VPrep Pipettor head has fewer tips than the plate has wells, 
select a quadrant configuration from the Quadrant(s) diagram to 
indicate which well quadrant of the plate you want to dispense to.

To select a quadrant, click a representative well. Two possible 
examples are shown below.

Aspirate acceleration The rate of increase in velocity before the 
aspirate velocity is reached.

If you selected a liquid class, this value is 
entered automatically from the liquid 
library editor and cannot be edited here.

Dispense velocity The rate at which to dispense the liquid.

If you selected a liquid class, this value is 
entered automatically from the liquid 
library editor and cannot be edited here.

Dispense acceleration The rate of increase in velocity before the 
dispense velocity is reached.

If you selected a liquid class, this value is 
entered automatically from the liquid 
library editor and cannot be edited here.

Distance from well bottom The distance between the bottom of the 
pipette tips and the bottoms of the 
MicroWash tray chimneys.

Retract Distance The distance that the tips should move 
upwards or downwards per unit volume of 
liquid being dispensed or aspirated.

This value allows the tips to move upwards 
or downwards during dispensing or 
aspirating to maintain a certain height 
below or above the surface of the liquid. 

You will need to determine an appropriate 
value by trial-and-error.

Pre-aspirate volume The volume of air to be drawn up before 
the pipette tips enter the liquid, and before 
mixing begins.

Last-cycle blowout volume The volume of air to blow out when the tips 
are in the liquid once the mixing is 
complete.

This is typically the same as the pre-
aspirate volume.

Property Description
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5. Type a value for the Inflow pump, which is the relative rate of liquid 
flow into the MicroWash tray manifold.

This value should be high enough for the washing liquid to just 
bubble over the tops of the chimneys.

6. Type a value for the Outflow pump, which is the relative rate of liquid 
flow out of the MicroWash tray manifold.

This value should be zero.

7. If you want to dispense the wash liquid to waste instead of 
dispensing it back into the reservoir of washing liquid:

a. Select the Dispense to waste at height of check box.

b. Type a value into the associated text box for the height above the 
chimney from which you want the liquid to be dispensed.

The value can be a positive or negative number.

The pipette tips move up and sideways to dispense the wash 
liquid between the chimneys into waste.

8. If you want the tips to touch the outside tops of the chimneys to 
remove drops from the tips, select the Enable tip touching check 
box:

a. Type a value for the Tip touch rise height.

This is the height that the tips should move upwards before 
touching the side of the wells.

b. Type a value for the Tip touch horizontal distance.

When the value for this parameter is zero, the tips will move 
horizontally one well radius. The well radius is defined in the 
labware database for the type of plate you are using. If you want 
the tips to touch harder, increase this value. If you want the tips 
to touch more lightly, enter a negative value.

9. In the Plate to wash list, select the VPrep Pipettor and shelf position 
of the MicroWash tray.

If the name that you chose does not appear in this list, you probably 
associated the VPrep Pipettor shelf with the labware type after 
adding the Wash tips task to the pipette process. Remove the task 
and add it again for the choice to appear.

Washing the 
MicroWash tray 
manifold

To wash the MicroWash tray manifold:

1. Create a protocol process that contains only a pipette process.

2. Add a Wash Tips task to the pipette process.

3. Enter the following values for the task:
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4. Run the process.

Related topics

Property Value

Wash volume 0

Number of wash cycles 0

Inflow pump Typically set below 100%. 

The actual rate of inflow depends 
on the viscosity of the liquid and 
the height of the reservoir above 
the Microwash tray. It is best to 
observe the height of the fluid in 
the tray and set the inflow pump 
value so that there is an even flow 
of liquid and the height does not 
rise to cause an overflow.

Outflow pump Typically set to 100%

For information about... See...

Defining labware “About the labware editor” on page 248

Configuring VPrep Pipettor shelves “Configuring a VPrep Pipettor shelf as a 
device” on page 133

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280
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Setting Wash Tips task parameters for a Bravo 
Platform

About this topic This topic describes how to set the Wash Tips task parameters when 
creating a BenchWorks software protocol that uses a Bravo Platform. 

Read this topic if you are:

❑ An administrator or technician who writes protocols

❑ An operator who needs to specify parameters for the Aspirate task

Wash Tips task 
defined

A Wash Tips task is used with a Bravo Platform to wash pipette tips and 
prime the Microwash Reservoir manifolds.

This task is available in pipette processes and sub-processes and only if a 
Microwash Reservoir is installed. 

Procedure To set Wash Tips task parameters:

1. Add a Wash Tips task to a pipette process. 

2. Use the table below as a guide to complete the “Wash Tips” 
Properties located in the Task Settings tab of the Task Parameters 
toolbar. 

Field Description

Location Identifies the location at which the 
mix will occur.

Empty tips Indicates you want to empty the tips, 
regardless of the volume.

Volume (0–245 µL) Specifies the volume of liquid to be 
aspirated and dispensed to each 
plate well.

Pre-aspirate volume (0–245 µL) Specifies the volume of air to be 
drawn before the pipette tips enter 
the liquid.
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Blowout volume (0–245 µL) Specifies the volume of air to 
dispense when the tips are in the 
liquid of the last quadrant after the 
last cycle.

Note: Typically the same as the pre-
aspirate volume. 

Liquid class Specifies a defined a liquid class for 
this liquid. 

Click the adjacent blank field to 
display an arrow and select the 
liquid from the list.

Mix cycles (0–100) Specifies the number of aspirate/
dispense operations.

Distance from well bottom  
(0–100 mm)

Specifies the minimum distance from 
the bottoms of the plate wells or 
MicroWash chimneys that the tips 
will be during a wash cycle.

Dynamic tip extension 
(0–20 mm/µL)

Specifies the distance that the tips 
should move upwards or downwards 
per unit volume of liquid being 
dispensed or aspirated.

Determine an appropriate value by 
trial-and-error. 

Perform tip touch Specifies whether a tip touch is 
performed after each selection of the 
plate.

Which sides to use for tip touch Specifies which sides and in what 
order to use for the tip touch.

Tip touch retract distance  
(–20–50 mm)

Specifies the height that the tips 
move up before touching the sides of 
the wells.

Tip touch horizontal offset  
(–5–5 mm)

When the value for this parameter is 
0, the tips will move horizontally one 
well radius. The well radius is defined 
in the labware database for the type 
of plate you are using. If you want the 
tips to touch harder, increase this 
value. If you want the tips to touch 
more lightly, enter a negative value.

Well selection Specifies the tips to be washed. 
Applies only if the Bravo Platform 
head has fewer tips than the plate has 
wells. Click the ellipsis button, and, 
in the Well Selection dialog box, click 
wells to highlight which MicroWash 
chimneys the tips will be washed in.

Field Description
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Related topics

Pump fill speed (0–100%) Specifies the relative rate of liquid 
flow into the MicroWash manifold.

This value should be high enough for 
the washing liquid to just bubble over 
the tops of the chimneys. 

Pump empty speed (0–100%) Specifies the relative rate of liquid 
flow out of the MicroWash manifold.

This value should be slightly higher 
than that of the inflow pump to 
prevent an overflow. 

Dispense to waste during wash Specifies the dispense step of the 
wash cycle will take place outside of 
the MicroWash chimneys. Dispensing 
to waste provides a more efficient 
wash than dispensing the waste into 
the chimneys. However, dispensing 
to waste takes longer because the 
pipette head must move more.

Dispense to waste at height  
(–10–5 mm)

Specifies the height at which the 
dispense takes place. For example, if 
–10 mm, the tip dispenses 10 mm 
below the top of the chimneys.

Field Description

For information about... See...

Defining liquid handling 
parameters

“About the liquid library editor” on 
page 280

Labware editor “About the labware editor” on page 248

Configuring a pipette process ❑ “Configuring a pipette process: 
example” on page 126

❑ “Adding and configuring a Pipette 
Process task” on page 130
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Using the BenchWorks 
software inventory
 7
This chapter describes how to use the inventory to track plates that move 
in and out of long-term plate storage devices. This chapter contains the 
following topics:

❑ “BenchWorks software inventory overview” on page 168

❑ “Setting up the inventory management database” on page 171

❑ “Opening the inventory editor” on page 172

❑ “About inventory groups” on page 173

❑ “Creating a location group” on page 175

❑ “Creating a plate group” on page 177

❑ “Moving plates into a storage device” on page 179

❑ “Moving stored plates out of the system” on page 182

❑ “Moving plates between storage devices” on page 185

❑ “Using a plate group to incubate plates” on page 187

❑ “Creating a plate group with a barcode input file” on page 189

❑ “Inventory editor views and filters” on page 191

❑ “Reinventorying the plate inventory” on page 195

❑ “Resolving plate inventory problems” on page 197
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BenchWorks software inventory overview

About this topic This topic provides the background information you need to understand 
how to use the inventory manager to track groups of plates moving into 
and out of a plate storage device.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX, 
Heraeus Cytomat PLC, or a Velocity11 PlateHub Carousel and you are 
using, or want to set up, inventory management with a database. 

Before you start Before starting to create protocols that use a StoreX also read:

❑ The StoreX information in the Device Driver User Guide

❑ “Resolving plate inventory problems” on page 197

Before starting to create protocols that use a PlateHub Carousel also 
read:

❑ The PlateHub Carousel information in the Device Driver User Guide

❑ “Resolving plate inventory problems” on page 197

Barcode tracking 
versus inventory 
management

Barcode tracking
Barcode tracking without an inventory system is limited because the 
plate locations are stored in memory and are lost when you exit 
BenchWorks software. 

Inventory management
The inventory management system allows long-term tracking of plates as 
barcode data is permanently stored in a database. This is useful for lab 
automation systems with devices that store plates for a long time, such 
as a Heraeus Cytomat PLC and Liconic StoreX.

Required database To use inventory management you must have a SQL database set up, 
either on the computer that runs BenchWorks software or a computer 
that is on the same local area network.

How plates are 
stored

The long-term storage devices supported by BenchWorks software store 
plates in cassettes and slots. A cassette is a vertical rack of plates that has 
many slots, with each holding one plate.

Information that is 
stored

The inventory maintains a list of plates in every long-term plate storage 
device.

The information contained about each plate in the inventory includes:

❑ Device in which the plate is located

❑ Cassette and slot location of the plate

❑ Name of the group or location to which it belongs
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❑ Labware type

❑ Any north-side, south- side, east-side, and west-side barcodes.

West side barcodes are tracked only if an optional barcode reader is 
used. 

❑ Volume of the wells in the plate

The list of plates in the inventory is displayed in the Inventory Plate 
Group Editor Preview dialog box. An example view is shown below.

The list of plates in the inventory is updated every time a plate is moved 
with a robot in to or out of a storage device so that at all times, the list is 
current.

Inventory manager The Inventory Editor dialog box is where you manage the inventory. 
From here you can:

❑ Create plate groups

❑ Create location groups

❑ Review information about plates in a group

❑ Import groups from a barcode file

❑ Change the plate type associated with plates in the database

❑ Delete plates from the database

❑ Inventory the plates in a plate storage device

Plate groups and 
Location groups

With long-term storage devices, typically only a sub-set of the plates 
stored in the device is used in one protocol. You can set up two different 
types of plate sub-sets, called plate groups and location groups. Which 
you choose for a particular protocol depends on what you are planning 
to do.

Plate groups are a group of plates based on the unique database 
identifier for that plate.

Location groups are a group of slots that are not based on information in 
the plate database.

Inventory 
management tasks

The following tasks are used with the inventory management system. 
These are the tasks that move plates in to and out of a long-term storage 
device:

❑ Load

❑ Unload

❑ Incubate at plate storage device
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About manually 
moving plates

Keeping the database synchronized
It is important to note that the database cannot track plates that you 
manually add, remove, or move. To keep the database synchronized 
with the long-term storage device, load and unload the plate storage 
device robotically, or periodically reinventory the storage device.

Instead of manually adding plates to the storage device, write a protocol 
to downstack the plates and load them. Instead of manually removing 
plates from the storage device, write a protocol to unload the plates and 
upstack them.

If you must manually load and unload plates

If you must manually load and unload plates you will need to create a 
protocol to load or unload the exact plates that you are manually adding 
or removing and then run the simulator.

With an appropriate protocol, the simulated run accurately changes the 
plates listed in the database without actually moving any plates. 

Terminology When describing the movement of plates, it is important to use terms 
correctly. The terms load and unload are used from the storage device’s 
perspective. 

Database backup The inventory management database can be backed up onto another 
computer using a software utility. If you want to do this, contact the 
Velocity11 Technical Support for more information.

Term Definition

Unload The act of moving a plate from a storage device into the system.

Load The act of moving a plate from the system into a storage device.

System Plates that are being processed by the current protocol are 
considered to be in the system.

For example:

❑ A plate on a platepad is in the system.

❑ A plate in a plate hotel is in the system.

❑ A plate being incubated in an incubator is in the system.

❑ A plate half-way up a VStack rack is not in the system, unless it 
will be moved during the current protocol.

❑ A plate being stored in a PlateHub is not in the system unless 
it will be moved during the current protocol.
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Related topics

Setting up the inventory management database

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX, 
Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel and you are 
using, or want to set up, inventory management with a database. 

About setting up the 
database

To set up the inventory management database, contact Velocity11 
Technical Support for assistance.

Setting the database 
connection

The database connection is specified in BenchWorks software.

To set the database connection:

1. Navigate to Tools > Options.

2. Click the Log Options tab.

3. In the Database connection string text box, type 
dsn=velocity11. 

4. Click Test & Save to test the connection.

Related topics

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 173

Setting up the database “Setting up the inventory management 
database” on page 171

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 173
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Opening the inventory editor

About this topic This topic describes how to open and close the inventory editor. 

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX, 
Heraeus Cytomat PLC, or a Velocity11 PlateHub Carousel and you are 
using inventory management with a database.

Before you start Before you can open the inventory editor, the inventory database that 
the editor communicates with must be set up. 

Opening the 
inventory editor

To open the inventory editor:

1. Select Tools  > Inventory Editor

You can also open it by selecting a Load or Unload task in a protocol and 
clicking Edit location groups or Edit plate groups.

Closing the inventory 
editor

To close the inventory editor:

1. Click the close box in the top right corner.

Related topics

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

For information about... See...

For information about... See...

Setting up the inventory 
management database

“Setting up the inventory management 
database” on page 171

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 173
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About inventory groups

About this topic This topic explains what inventory groups are and how to choose which 
type of plate group to use.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Inventory groups 
defined

An inventory group is a group of plates that is a subset of the plates listed 
in the plate inventory. 

Types of inventory 
group

There are two types of inventory groups:

❑ Location group

❑ Plate group

Location groups Location groups are used to move plates from a specific location in the 
storage device.

Example:
In this example, a location group that contains slots 1–10 in cassette 1 is 
created. 

When an Unload task uses this location plate group, the robot moves 
whatever plates are in cassette 1, slots 1–10, regardless of the identity of 
the plates, out of the storage device and in to the system. 

When a Load task uses a location group, it moves the plates that are in 
the system into to cassette 1, slots 1–10 of the storage device, regardless 
of the identity of the plates.

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

For information about... See...
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When to use

Location plate groups are used:

❑ When the storage device is being filled or emptied.

❑ When groups of plates are removed from the lab automation system 
and replaced with other groups of plates on a regular basis. This 
would be done by replacing a cassette of plates with a new one.

Plate groups Plate groups are used to move specific plates to or from the storage 
device, but without regard for the location. Plate groups can be used 
when operators do not routinely remove and replace whole cassettes of 
plates.

When a plate is first moved into the system by the BenchCel Workstation 
robot, such as when it is downstacked, it is assigned an identifier in the 
database. After that BenchWorks software tracks where that plate is at all 
times. This tracking does not require the plates to have barcode labels, 
BenchWorks software knows what it does with every plate during a 
protocol and so is able to track where each plate goes. 

Plate groups make use of this tracking system. 

Note: You cannot use a plate group with a Load task— you have to 
specify a location group. You can, though, associate a plate group with 
the location group so that the plates that are loaded are immediately 
given a plate group.

Note: When you load into a plate group you must also load into a 
location group or choose return to original locations, otherwise the 
software will not know where to put the plates.

Example:

A plate group in a plate storage device contains the following plates:

❑ Plate 26

❑ Plate 31

❑ Plate 41

❑ Plate 107

These plates are scattered around the storage device, not necessarily in 
adjacent slots of the same cassette. When the Unload task uses this plate 
group, it moves these plates out of the storage device into the system.

When to use

Plate groups are typically used in compound management systems 
where plates are housed in the storage device almost permanently. 

For each protocol, a different plate group is unloaded, run and then 
loaded back to a storage device. 

Group membership A single plate can be a member of more than one plate group.
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Related topics

Creating a location group

About this topic This topic describes how to create a location group, which is a list of 
slots that might contain plates ready to unload, or might be empty 
waiting to be filled.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Procedure To create a location group:

1. Select Inventory Editor from the Tools menu.

2. Click the Location Groups tab.

3. Click Create new and enter a name for the group.

4. Click OK.

5. Select a group of available slots.

For information about... See...

Creating a location group “Creating a location group” on page 175

Creating a plate group “Creating a plate group” on page 177

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189
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You can use CTRL + click or SHIFT + click to select more than one 
slot.

6. Drag the group into the Location Members list.

7. Click Save Changes.

8. Click the close box to close the inventory editor.

The location group is listed in the Available locations list of the Load 
Protocol Task Parameters toolbar.

Deleting a location 
group

To delete a location group from the inventory:

1. Open the inventory editor.

2. Select a location group in the Saved Locations group box.

3. Click Delete.

Related topics
For information about... See...

Creating a plate group “Creating a plate group” on page 177

Opening the inventory editor “Opening the inventory editor” on 
page 172
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Creating a plate group

About this topic This topic describes how to create a plate group, which is a list of 
specific plates that can be moved to or out of a plate storage device 
without regard for in which slots they are stored.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Procedure To create a plate group:

1. Select Inventory Editor from the Tools menu.

2. Click the Plate Groups tab.

3. Click Create new and enter a name for the group.

4. Click OK.

5. Select a group of available plates.

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

For information about... See...
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If there are no available plates, you must first move plates into the 
storage device.

You can use CTRL + click or SHIFT + click to select more than one 
slot.

6. Drag the group into the Group Members list.

7. Click Save Changes.

8. Click the close box to close the inventory editor.

The plate group is listed in the Available locations list of the Load 
Protocol Task Parameters toolbar.

Changing the 
processing order

You can change the order in which the plates in a plate group will be 
processed.

To change the processing order:

1. In the plate group list, select a plate.

2. Drag it to a higher position in the list.

Deleting a plate 
group

To delete a plate group from the inventory:

1. Open the inventory editor.



179Chapter 7: 
BenchWorks Automation Control User Guide
2. Select the plate group in the Saved Groups group box.

3. Click Delete.

Related topics

Moving plates into a storage device

About this topic This topic describes how to add plates into the system for storage in a 
plate storage device. You would do this when first filling the device. 
Adding plates into the system means more than just loading them into a 
storage device. It means adding the plate identifications into the record 
that BenchWorks software keeps of plates in the system.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Ways to fill a storage 
device

There are two ways to fill an empty storage device with plates.

❑ Robotically

❑ Manually

Loading plates 
robotically 

To load plates robotically, the plates are placed in a stacker, 
downstacked and moved to the storage device.

For information about... See...

Creating a location group “Creating a location group” on page 175

Opening the inventory editor “Opening the inventory editor” on 
page 172

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189
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To load plates robotically:

1. If you are using the simulator to “virtually” load plates, make sure 
that the Enable plate tracking in simulation mode check box is 
selected in the Log Options dialog box.

2. Create a protocol like the one in the following screenshot:

3. Make sure that the Downstack task is configured to use the stacker.

4. Create a location group.

Make sure that the location group is listed in the Available locations 
list of the Load Protocol Task Parameters toolbar.

5. Drag the group into the Assigned locations list.

6. Click Start and resolve any error messages.

7. In the Number of Cycles dialog box, enter a number that equals the 
number of plates you want to load into the storage device.

8. Click OK.

9. Confirm that the plates are in the inventory:

a. Click the Load task.

b. Click Edit location groups to open the inventory editor.

c. Click the Inventory Management tab.
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Loading plates 
manually

To load plates manually, cassettes of plates are physically put in to the 
storage device and a run is simulated to create the matching list of plates 
in the inventory. 

To load plates manually:

1. Physically load the cassettes of plates in to the storage device.

2. Follow the procedure for loading plates robotically, but click 
Simulation is off to turn on the simulator.

Make sure that the location group matches the cassettes that you 
loaded.

3. Click Start to run the simulator.

4. Review the inventory editor to make sure that the plates listed in the 
inventory match the plates actually in the device.

5. Click Simulation is on to turn off the simulator.

Related topics
For information about... See...

Moving plates out of a storage 
device

“Moving stored plates out of the system” 
on page 182

Moving plates between storage 
devices

“Moving plates between storage 
devices” on page 185
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Moving stored plates out of the system

About this topic This topic describes how to remove plates that are in a storage device 
from the system. Removing plates from the system is more than just 
unloading them from the storage device. It means removing the plates 
from the lab automation system as well as removing the plate 
identifications from the record of the plates in the system that 
BenchWorks software keeps.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Ways to remove 
plates

There are two ways to remove plates from a plate storage device.

❑ Robotically

❑ Manually

Removing plates 
robotically

To move plates from a storage device robotically:

1. Create a protocol like the one shown in the following screenshot 
(shown using Vworks software but works identically in BenchWorks 
software):

2. Make sure that the Upstack task is configured to use the stacker.

3. In the inventory editor, identify the plates that you want to move:

a. Click the Unload task.

b. Click Edit location groups to open the inventory editor.

c. Click the Inventory Management tab.
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4. Create a location group in the inventory editor, saving the changes 
and confirming it by making sure that it is listed in the Available 
locations list of the Load Protocol Task Parameters toolbar.

5. Drag the group into the Unload from list.

6. Click Start.

7. In the Number of Cycles dialog box, enter a number that equals the 
number of plates you want to remove from the storage device.

8. Click OK.

9. Confirm that the plates are no longer in the inventory:

a. Click the Load task.

b. Click Edit location groups to open the inventory editor.

c. Click the Inventory Management tab.

Emptying a storage 
device manually

To empty a storage device manually, cassettes of plates are physically 
removed from the storage device and a run is simulated to remove the 
matching list of plates from the inventory. 

To remove plates manually:

1. Physically remove the cassettes of plates from the storage device.

2. Follow step 1 to step 5 in the procedure above for emptying a storage 
device robotically.

3. Make sure that the Enable plate tracking in simulation mode (located 
under Tools > Options > Log Options) is selected.

4. Click Simulation is off to turn on the simulator.

5. Click Start.
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6. In the Number of Cycles dialog box, enter a number that equals the 
number of plates you want to remove from the storage device.

7. Click OK.

8. Confirm that the plates are no longer in the inventory:

a. Click the Load task.

b. Click Edit location groups to open the inventory editor.

c. Click the Inventory Management tab.

Note: You can also remove the plates and delete the relevant rows from 
the inventory editor.

Related topics
For information about... See...

Creating a location group “Creating a location group” on page 175

Creating a plate group “Creating a plate group” on page 177

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving plates between storage 
devices” on page 185

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189
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Moving plates between storage devices

About this topic This topic provides an example to illustrate how you can move a group 
of plates out of one plate storage device and put them into another. The 
general procedure could also be used to move a group of plates within a 
single storage device.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Before you start Make sure that both plate storage devices are properly configured in the 
device manager.

Moving a plate In this example procedure, a group of four plates is moved from one 
plate storage device (PlateHub) to another (PlateHub2).

To move a plate:

1. Create a process that has a Load and an Unload task, as shown in the 
following example.

2. Select either the Load or Unload task and click Edit location groups.

The inventory editor opens.

3. Click the Inventory Management tab and note the device, cassette, 
and slot locations of the plates that you want to move.

In this example, the plates will be moved from PlateHub, cassette 1, 
slots 5–8.

4. Click the Location Groups tab and create a location group for these 
plates.

Note: The plates do not need to be in adjacent slots for them to be 
in a location group.
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5. Return to the Inventory Management tab and note the device, 
cassette and slot numbers for the slots that you want to move the 
plates to. 

In this example, the plates will be moved to PlateHub2, cassette 1, 
slots 1–4.

6. Click the Location Groups tab and create a location group for these 
slots.

7. Click Save changes and close the inventory editor.

8. Select the Unload task and in the Protocol Task Parameters toolbar 
drag the location group in the first device to the Unload from list.

9. Select the Load task and in the Protocol Task Parameters toolbar drag 
the location group in the second device to the Assigned locations 
list.

10. Compile the protocol and check for errors.

11. Click Start to start the run.

12. In the Number of Cycles dialog box, type in the number of plates that 
you are moving and click OK.

13. Open the inventory editor and click the Inventory Management tab to 
make sure that the plates moved as expected.

Related topics
For information about... See...

Creating a location group “Creating a location group” on page 175

Creating a plate group “Creating a plate group” on page 177

Opening the inventory editor “Opening the inventory editor” on 
page 172
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Using a plate group to incubate plates

About this topic This topic shows an example protocol where a plate group is moved out 
of a PlateHub Carousel into a StoreX incubator at 42 degrees Celsius, 
and then returned to the PlateHub Carousel.

Location groups 
versus plate groups

Location groups are used for:

❑ Groups of plates that are moved into the system and then to 
particular slots in a storage device

❑ Groups of plates in particular slots in a storage device that are 
moved out of the system 

Several topics in this section describe how location groups are used.

Some applications require that plates are stored in the storage device for 
a long time but where exactly the plates are stored is not important. With 
these applications operators do not routinely remove and replace whole 
cassettes of plates so the plates do not need to be stored in particular 
cassettes. As long as the identities of the plates are tracked, they can be 
stored anywhere. Plate groups can be used for these applications.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, Velocity11 PlateHub Carousel.

Procedure This procedure assumes that there are already plates in the PlateHub 
Carousel.

To incubate a plate group:

1. Create a protocol like the one shown below.

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

Incubating plates “Using a plate group to incubate plates” 
on page 187

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

For information about... See...
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2. Create a new plate group in the inventory editor and save the 
changes.

3. Select the Unload task and in the Protocol Task Parameters toolbar, 
drag the plate group to the Unload list.

4. Select the Incubate task and exclude any devices that you do not 
want to be used for the incubation task.

In this example, the plates should not be incubated on a PlateHub 
Carousel that is available.

5. Select the Load task and in the Protocol Task Parameters toolbar, drag 
the plate group to the Unload list.
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6. Run the protocol.

Related topics

Creating a plate group with a barcode input file

About this topic This topic describes how to use a barcode input file to create a plate 
group. This is the most efficient way to create plate group if you 
previously used a barcode input file to label a collection of plates. 
which are now stored in a plate storage device.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Procedure !! IMPORTANT !! All plates with barcodes listed in the selected 
barcode input file series must already be in the storage device.

To create a plate group with a barcode input file:

1. Open the inventory editor.

2. Click the Groups tab.

3. Click the Browse button and navigate to the .bar file that you want to 
use.

For information about... See...

Software inventory “BenchWorks software inventory 
overview” on page 168

Creating a plate group “Creating a plate group” on page 177

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Using barcode input files “Creating a plate group with a barcode 
input file” on page 189

Starting a run “About performing a run” on page 50.
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4. From the Available Barcode groups list box, select the group that you 
want to use.

In the following example of a barcode input file, the options would 
be Set1 and Set2.

5. Click Import.

The plates labelled with west-side barcodes listed in the series will 
be used to create a group and will appear in the Plates currently in 
the selected group list.

6. Specify a labware type for each plate using the labware selection 
function in the Inventory Management tab.

Related topics
For information about... See...

Software inventory “BenchWorks software inventory 
overview” on page 168

Opening the inventory editor “Opening the inventory editor” on 
page 172

Using the labware selection list “Reinventorying the plate inventory” on 
page 195
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Inventory editor views and filters

About this topic This topic describes how to make the inventory editor easier to work 
with by showing only the items in the inventory editor that are relevant 
at the particular time.

Who should read 
this

Read this topic if your lab automation system has a Liconic StoreX 
incubator, Heraeus Cytomat PLC, or Velocity11 PlateHub Carousel.

Inventory editor 
views

There are three ways to view the plates in the inventory editor.

To set the view:

1. Open the inventory editor.

2. Click to select the Inventory Management tab.

3. From the Select view type list, select one of the following options:

Filtering displayed 
plates

You may have many plates stored in the database. To simplify your view 
of the database, you can filter the records that are displayed.

To filter the plate records:

1. Right-click on a list in any of the tabbed pages of the inventory editor 
and select Show all.

2. Right-click on a particular cell and select from the available filtering 
options.

View Description

View by plate Displays every plate in the inventory. 

This is the most frequently used view.

View by location Displays both plates and slots.

View unassigned plates Displays plates that were orphaned 
during previous runs. This means 
plates that are on the system but not 
in a plate storage device.

Unassigned plates do not appear in 
linker groups so cannot be used.

View Description

Use last filter Returns the display of items to that 
displayed when the last filter was 
applied

Filter by row The items that have the same value as 
the selected item in the row are 
displayed

Filter by column The items that have the same value as 
the selected item in the column are 
displayed
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The items that have the same value as the selected item in the row 
are displayed.

The result is that only those plates in cassette number 2 are listed.

To show all plate records:

1. Right-click on the database list and select Show all.

Related topics
For information about... See...

Software inventory “BenchWorks software inventory 
overview” on page 168

Opening the inventory editor “Opening the inventory editor” on 
page 172
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Auditing plate volumes in the inventory editor

About this topic Sometimes it is useful to view the results of pipetting tasks visually. 
BenchWorks software does this by tracking the pipetting tasks 
performed on a plate during a protocol run, calculating the volume 
resulting from those tasks, and storing the information in the database. 
When the plate Then representing the volume with color.

This topic describes how to audit a plate’s volume using the inventory 
editor.

Procedure To audit the volume of a plate:

1. Open the inventory editor.

2. Click the Inventory Management tab.

3. From the Select view type list, select the view.

4. Select the plate you want to audit.

5. Click Visualize Plate. The Audit Plate dialog box opens.
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Related topics
For information about... See...

Software inventory “BenchWorks software inventory 
overview” on page 168

Opening the inventory editor “Opening the inventory editor” on 
page 172
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Reinventorying the plate inventory

About this topic This topic describes how to use the reinventory feature of plate 
inventory.

This feature can be used to check for mismatches by comparing the 
identities of the plates actually in a plate storage device with the plates 
that the inventory database says should be in the plate storage device. 

Mismatches can arise, for example, if you physically load plates into the 
storage device and then use the simulator to virtually “move the plates” 
into the database. In this case there will be no labware associated with 
the plates.

The reinventory feature can also be used to enter barcode information 
for plates that have been manually placed into the storage device.

Note: Reinventorying requires that the storage device have a barcode 
reader.

Who should read 
this

Read this topic if your lab automation system has a plate storage device 
that includes an optional barcode reader.

About performing an 
inventory

The accuracy of the inventory database can be checked by performing a 
new inventory of the database. You can perform an inventory of the 
entire storage device or part of it.

The device’s barcode reader checks all selected slots for the presence of 
a barcode and reads those that it finds. The results are checked against 
the inventory database.

!! IMPORTANT !! For reinventorying to be successful, each plate 
must have a unique barcode.

Reinventorying logic If a plate is found in a slot that, according to the inventory database, 
should not have a plate, a line is added to the inventory editor for that 
slot and the plate’s barcode is recorded. If that barcode is already 
associated with another slot in the database, the previous association is 
deleted. In doing this, the system assumes that the plate has been 
manually moved.

If the inventory has a line for a plate in a particular slot, but the 
inventory finds no plate in that slot, the line is removed from the 
inventory. However, the data in the system that is associated with the 
plate is not deleted. If in the future, a plate with an identical barcode is 
returned to the system, when the next inventory is performed the data 
can be reassociated with it.

Procedure To reinventory the plate storage device:

1. Open the inventory editor.

2. Click the Inventory Management tab.
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3. From the Select view type list box, select View by location.

This lists the plates in the inventory database by location.

4. Select the plates that you want to inventory.

You can use SHIFT + click to select a range of listed plates.

5. In the Name text box, type the name of the location group.

6. From the Labware list box, select the type of labware to associate.

7. Select one of the following options:

8. Click Reinventory selected locations.

A barcode reader reads each plate in the storage device and adds 
the barcode data to the inventory database.

Related topics

Option Comments

Replace any inventoried labware 
with the labware selected above

Labware for all selected items are 
replaced with the labware displayed 
in the list box. This overwrites 
labware already assigned.

Replace inventoried labware 
with the labware selected above 
ONLY if a labware is not already 
assigned

Labware for all selected items that do 
not already have a labware entry are 
replaced with the indicated labware.

For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 173

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185

Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the plate inventory” on 
page 195

Inventory editor filters “Inventory editor views and filters” on 
page 191
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Resolving plate inventory problems

About this topic This topic describes how to check and test the Windows Open Database 
connection that is used by the BenchCel Workstation inventory 
management system. 

Checking the 
database settings

The inventory management database uses a Windows Open Database 
Connectivity (ODBC) interface. If you encounter inventory management 
problems, you may need to check the database settings.

To check the database settings:

1. In Windows, navigate to Start > Settings > Control Panel > 
Administrative Tools > Data Sources (ODBC).

The ODBC Data Sources Administrator dialog box opens.

2. Click the System DSN tab.

3. Click Configure.

The Connector/ODBC dialog box opens showing the database 
settings.
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The Data Source Name and Database Name fields must both 
contain “velocity11”.

Testing the 
connection

To test the database connection:

1. Follow the procedure in “Checking the database settings” on 
page 197 to open the Connector/ODBC dialog box.

2. Click Test.

A dialog box like the following example confirms a successful 
connection.

Related topics
For information about... See...

Inventory groups, plate groups and 
location groups

“About inventory groups” on page 173

Moving plates in and out of a 
storage device

❑ “Moving plates into a storage 
device” on page 179

❑ “Moving stored plates out of the 
system” on page 182

❑ “Moving plates between storage 
devices” on page 185
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Changing the labware associated 
with plates in the inventory 
database

“Reinventorying the plate inventory” on 
page 195

Inventory editor filters “Inventory editor views and filters” on 
page 191

For information about... See...
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Creating a protocol: 
advanced topics
 8
This chapter is intended for people with technician or administrator 
privileges. It provides the background information necessary to set up 
certain tasks.

Before reading this chapter you should be familiar with the concepts 
presented in the following chapters:

❑ “Creating a protocol basics” on page 67 

❑ “Setting task parameters” on page 89

❑ “Setting pipette task parameters” on page 125

Note: This chapter is not a tutorial on writing protocols — it provides the 
basic reference information you will need to write protocols.

This chapter contains the following topics:

❑ “Setting up the LabwareSelector plug-in” on page 202

❑ “About the FileReader plug-in” on page 203

❑ “About the FileReader file format” on page 204

❑ “Using the FileReader plug-in in a protocol” on page 206

❑ “Using JavaScript in BenchWorks software” on page 209

❑ “The JavaScript task object and properties” on page 216

❑ “Related topics” on page 229

❑ “About barcode reading and tracking” on page 229

❑ “Using barcode input files” on page 230

❑ “Using barcode data files” on page 233
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Setting up the LabwareSelector plug-in

About this topic The LabwareSelector plug-in allows you to assign a plate type at the time 
you start your run.

Use this plug-in if your laboratory is using many plate types with the 
same protocols.

Procedure To set up the LabwareSelector plug-in:

1. Select the plate icon (the first icon in a protocol process). 

2. In the Task Settings page of the Protocol Task Parameters toolbar, 
select LabwareSelector.dll from the Plugin list box.

3. Select <From Plugin> from the Plate type list box.

Note: The software defaults to whatever is selected in the Plate type field. 
For example, if you have the LabwareSelector.dll selected as a Plugin and 
Costar 99 pp black selected as the Plate type, the software will execute 
the run with Costar 99 pp black as the plate type and will ignore the 
plugin.

Related topics
For information about... See...

Plate icon “About tasks, processes, and protocols” 
on page 68

Setting tasks parameters “About setting task parameters” on 
page 80



203Chapter 8: 
BenchWorks Automation Control User Guide
About the FileReader plug-in

About this topic Velocity11 has created a plug-in for BenchWorks software, called 
FileReader.dll. This topic describes this plug-in.

The FileReader plug-in lets BenchWorks software read from a tab-
delimited or a CSV (comma separated values) file to specify the content 
of label fields printed with a VCode Microplate Labeler.

Read this topic if you are a technician or an administrator who writes 
protocols with Apply Label task and who wants the FileReader plug-in to 
read and process the label text.

Defining label field 
content

The Apply Label task provides several ways to define the contents of the 
label fields printed on a series of plates during a run. However, without 
plug-ins and scripting, for each label in a given run, the Apply Label task 
cannot apply:

❑ Two different pieces of data from the same file

❑ Two different increments for two fields

❑ Numeric increments for one field and alphanumeric increments for 
another different field

In the following screenshot, Field2 and Field3 use the same label input 
file for the data in the fields. However, this function is limited because 
there is no way to specify two different locations in the same file for the 
same label.
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The FileReader plug-in allows BenchWorks software to input the data in 
the label fields from a text file. Functionally, the text file is similar to a 
label data file except that it includes data for all fields in a label instead 
of just one field. This allows two fields on the same label to contain 
different data from the same file in the same run, without using prefixes 
and suffixes.

Related topics

About the FileReader file format

About this topic This topic describes the format of the text file that is read by the 
FileReader plug-in. 

Read this topic if you are a technician or administrator who writes 
protocols with Apply Label tasks and who want to use the FileReader 
plug-in to read and process the label text.

The header row The first row in the text file must contain a header row.

The header row is a human-readable guide to show where the contents 
of each column will print.

The FileReader plug-in will assume that the rest of the text contains the 
same text separation method as the header row.

For example, if the header row uses a CSV format but the rest of the file 
uses a tab-delimited format, the FileReader plug-in expects commas to 
separate the values in the file. Having found none, it assumes that the 
entire text for each row after the header row is one field.

A screenshot of a FileReader plug-in text file is shown below. This 
example is a tab-delimited text file, but a CSV text file could also be 
used.

For information about... See...

Setting up the file reader plug-in “Using the FileReader plug-in in a 
protocol” on page 206

Using JavaScript with BenchCel 
Workstation

“Using JavaScript in BenchWorks 
software” on page 209

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73
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The order of the 
columns

Note how the order of the columns references the order of the tabs in 
the Apply label task Protocol Task Parameters toolbar.

The six columns of a particular side correspond to the six fields in the 
protocol task parameters.

The column “South3” is the column that contains the root data that will 
be printed on the south side of the plate in field 3. Each row of the table 
represents a different cycle in the run. The first row contains the root 
data that will be printed during the first run cycle, and so on.

The following screenshots show how the same plug-in is used in a total 
of four fields, on two sides of the plate.

Using these parameters, data from the above plug-in file would print the 
following labels:

Field Printed labels in run cycle 1

South, Field 2 r1c2

South, Field 3 r1c3

West, Field 1 r1c7
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Repeating columns A text file with data for labels on only one side of the plate is sufficient to 
print the same labels on other sides of the plate. 

To understand this, think of the columns as occurring in six column sets. 
If there are fewer than six columns, the remaining columns will be left 
blank.

If there is only one set in the file, the set is repeated for the other sides of 
the plate where you have selected “Use this label” from the box. 

Related topics

Using the FileReader plug-in in a protocol

About this topic The FileReader plug-in is installed and registered during the standard 
BenchCel Workstation installation. You should see the FileReader.dll file 
in your Velocity11\BenchWorks software\plugins directory. 

This topic describes how to modify the task parameters in the protocol 
so that the Apply Label task uses the FileReader plug-in. 

Read this topic if you are a technician or administrator who writes 
protocols with Apply Label tasks and who wants the FileReader plug-in 
to read and process the label text.

Setting up the 
protocol

Create a protocol, and then modify the plate icon and Apply Label task 
parameters as described here. 

To set up the protocol to use the File Reader plug-in:

1. Select a plug-in to use:

a. Click the plate icon in the Protocol Editor.

b. Select FileReader.dll from the Plugin list of the Protocol Task 
Parameters area.

If the FileReader.dll is not available for selection, it is because 
the FileReader.dll file is missing from the plug-ins folder.

West, Field 3 r1c9

Field Printed labels in run cycle 1

For information about... See...

Setting up the file reader plug-in “Using the FileReader plug-in in a 
protocol” on page 206

Using JavaScript with BenchCel 
Workstation

“Using JavaScript in BenchWorks 
software” on page 209
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2. Populate the Apply label task fields:

a. Click the Apply label icon in the Protocol Editor.

b. Populate the Apply label task fields with the From user plugin 
button.

c. If you would like to use prefixes or suffixes, enter them before or 
after [PLUGIN] in the relevant Field text box.

An example field with a prefix is shown in the following 
screenshot.

Running the protocol To run a protocol with a FileReader plug-in file:

1. Open the protocol that you created to use the FileReader plug-in.

2. Click Start from BenchWorks software to start the protocol.

3. Select the plug-in text file from the dialog box that opens.
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4. In the FileReader dialog box that opens, check the list of names of 
the columns of the text file and the total number of rows in the file.

5. Click OK.

The Number of Cycles dialog box opens.

6. Enter the number of cycles to run.
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7. Click OK.

Note the following:

If the file is not the one you intend to use, you can cancel the run.

If the number of rows in the file is greater than the number of cycles 
that are run, the extra rows will be unused.

If the number of rows is less than the number of cycles that are run, 
an error occurs when the rows are executed. If the error is ignored, 
additional labels are left blank.

The input file does not change during a run, so if you perform 
another run with the same file, the same labels will print.

If a power outage occurs during a run, and you are unable to resume 
the run, delete the first few rows after the header row. Then run the 
protocol again.

Related topics

Using JavaScript in BenchWorks software

About JavaScript in 
BenchWorks 
software

In BenchWorks software, JavaScript programs (scripts) can be used to:

❑ Configure tasks in ways that task parameters do not allow

❑ Change the parameters of a protocol task immediately before it is 
scheduled

This extends the capability of BenchWorks software because the 
parameters can be changed dynamically during a run, based on:

❑ Information passed from an external source, such as a database

❑ The number of times the protocol has cycled

❑ Feedback on changing conditions during the run

Scripts can be run before the start or after the finish of a protocol and 
within a protocol.

About JavaScript JavaScript is a general-purpose programming language that requires an 
interpreter to run its programs. 

You are probably most familiar with JavaScript where it is used to create 
dynamic effects in Web pages. This form of JavaScript is made up of a 

For information about... See...

Using JavaScript with BenchWorks 
software

“Using JavaScript in BenchWorks 
software” on page 209

The workflow that this procedure 
belongs to

“Workflow for creating a protocol” on 
page 73
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core language plus Web browser-specific language. It is processed by the 
JavaScript interpreter that is built into modern browsers. 

The core JavaScript language can be used to write scripts that have 
nothing to do with web pages. These scripts can be used for any 
application that includes a JavaScript interpreter. BenchWorks software 
is an example of such an application—it uses a JavaScript 1.5 
interpreter.

JavaScript resources There are many JavaScript resources available online and in print. If you 
want to learn more about JavaScript for use in BenchWorks software, 
look for resources that cover the core JavaScript language separately 
from the Web browser-specific language and the Document Object 
Model. 

Web references 

You can find useful information at:

http://www.mozilla.org/js/

Print reference

A good print reference is JavaScript: The Definitive Guide, Fourth Edition, 
published by O’Reilly. 

Examples of use You can use JavaScript to:

❑ Print the parameters of a task to the BenchWorks software log

❑ Run a command line that launches an external application, such as 
a batch file or database updating program

❑ Simplify protocol writing, for example, by incrementing pipetting 
volumes each cycle of a protocol to perform a dilution series

Where scripts are 
written

Scripts can be written directly into the protocol, or they can be written 
in an external file that is called during the protocol execution.

A script can be entered directly into the text box of:

❑ The Start/Finish tab of Protocol Options. In this case, the script is 
executed before the start of the protocol (including the pre-
protocol) or after the completion of the protocol (including the 
post-protocol). 

Start and Finish scripts are typically used to initialize variables and 
define functions for all the scripts used throughout the protocol. 
Note that they are associated with the protocol rather than the task 
and therefore less susceptible to accidental deletion.

❑ The Advanced Settings tab in the Task Parameters toolbar. In this 
case, the script is associated with a specific task and executed 
before the task.

An external script can be called by:

❑ Embedding the “open()” function in the text box

http://www.mozilla.org/js/
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❑ Clicking Browse to locate and then open the script file

About BenchWorks 
software-defined 
functions and 
objects

The BenchWorks software interpreter supports the JavaScript 1.5 core 
functions and objects. Velocity11 has also defined its own functions and 
objects that can be used in BenchWorks software scripts.

The BenchWorks software JavaScript interpreter provides two objects 
that can be accessed by a script. They are the plate object and task 
object.

BenchWorks 
software-defined 
global functions

The following BenchWorks software-defined functions are available 
globally, meaning that they are not restricted to a particular object or 
programming context.

Plate object The plate object provides access to properties of the plate that the 
current task is operating upon.

Properties

The plate object has the following properties:

Function Description

print() Prints time-stamped messages to the 
BenchWorks software log.

Parameter: Text string

Example: print(plate.name)

open() Opens a file.

Parameter: Text string

Example: open("c:\VWorks4 
workspace\text.txt")

run() Runs a program as though it is being 
called from a command line.

Parameters:

❑ Text string. Required. Allows you to 
initiate a command that you could 
otherwise enter into the Windows 
Run dialog box, such as notepad 
text.txt (opens a file named 
text.txt in Windows Notepad).

❑ Boolean True/False. Optional. 
Default is False. If True, 
BenchWorks software waits for the 
function to complete before 
continuing (blocking).

Property Data type Description

plate.name String Name of the plate.
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Methods

Methods are JavaScript functions invoked through an object.

The plate object has the following methods, available on those systems 
with the volume-tracking database option.

Task object The task object is a BenchWorks software-defined generic object that 
refers to the currently executing task. It allows the properties of the task 
to be accessed using a standard syntax. Depending on which task is 
executing, a different set of properties might be available.

Properties
The task object provides a comprehensive set of properties that can be 
read/write, or read-only. These properties specifically affect the behavior 
of the task that is about to be executed by the BenchWorks software 
scheduler.

For example, the Aspirate (BenchWorks software) task has a property 
called “volume”. To store this property in a variable you would write:

x = task.Volume

To set the volume property of the Aspirate (BenchWorks software) task 
to the value stored in the variable “x”, you would write:

task.Volume = x

plate.instance Integer Plate instance number.

plate.labware String Name of the labware type.

plate.barcode Array Array of four strings corresponding to 
SOUTH=0, WEST=1, NORTH=2, EAST=3.

Example:

plate.barcode[SOUTH]= "mybarcode"

plate.volume Array of 
arrays

An array of floating point numbers. The 
array size depends on the number of wells 
in the labware (96, 384, or 1536), arranged 
in row, column format.

This property is only enabled on 
BenchWorks software systems that have 
the volume-tracking database option.

Method Comments

plate.setUserData(string key, string 
value)

Stores ‘value’ under the key ‘key’ in a 
database record associated with this 
plate

plate.getUserData(string key) Returns the ‘value’ stored earlier using 
plate.setUserData

Property Data type Description
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In this example, the run-time interpreter determines through the context 
that “task.” refers to the currently executing Aspirate (BenchWorks 
software) task.

Attempting to access properties that are inappropriate for the current 
task will result in a scripting syntax error, but will not halt the execution 
of your protocol.

Methods

The task object has the following methods:

None of the task object methods accept any parameters.

These are generic methods that are the same regardless of the task that 
is executing them. The properties of these methods are specific to the 
current task.

About variables The default behavior of BenchWorks software JavaScript is that the 
values of all variables are cleared (set to undefined) before the next 
protocol is run. 

You have the option to change this so that the value of a variable 
assigned in a script is held in memory until BenchWorks software is 
closed. This means that if you assign the value to a variable in one 
protocol, the same value will be used in the next protocol with the same 
variable. This is the reset script context feature.

Method Comments

task.skip() Skips execution of the current task. Use 
this function to conditionally execute a 
task, such as in this example which 
skips the task if the simulator is not 
running:

if (!isSimulatorRunning())

task.skip()

task.pause() Pauses the protocol and opens a dialog 
box that asks you whether you want to 
continue or abort the run.

Use this function if you need to pause 
the protocol to, for example, replenish 
the fluid in a static reservoir. You could 
use the print() function to add a note to 
the log toolbar describing the action to 
take when the BenchWorks software 
has paused.

task.isSimulatorRunning() Returns true if this is a simulated run.

Has no arguments.

task.repeat() Schedules the task to be repeated.
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To clear the reset variables default option:

1. Select the Protocol Options tab.

2. In the Startup-Protocol Rules area, clear the Reset script context 
(erase all variables) before protocol executes check box. 

Quadrant 
representation

In JavaScript, an array is a built-in object that stores a collection of like 
values, called elements. Each element is accessed by an index value 
that is enclosed in square brackets. Index values can be non-negative 
integers or strings. 

The following example script declares an array with three elements:

var vehicle_type = new Array(3);

vehicle_type[0] = “car”;

vehicle_type[1] = “truck”;

vehicle_type[2] = “van”;

Because a plate is already an array of wells, locations on plates 
(quadrants) are represented in Velocity11 JavaScript as an array of 
arrays. for example, the quadrant property of the task object for one task 
is represented as:

[[1,1]]

In this representation, the first number refers to the plate row and the 
second number refers to the plate column. These numbers can be 
represented by variables in a script, as shown in the following statement.

task.quadrants = [[disp_row,disp_column]]

For two quadrants, the representation would be:

[[1,1],[1,2]]

Cautions When you run a script that dynamically changes the values of task 
properties, there is a risk that a value will be set that causes a problem. 
We therefore recommend that before using a script, you run the 
simulator with each set of values that will be set by the script. Running 
scripts cannot cause robot crashes, because scripts cannot modify 
teachpoints. However, an incorrect task.tipOffset property (Distance 
from well bottom parameter) on a VPrep could cause the pipette tips to 
crash into the bottom of the wells resulting in loss of sample and 
damage to plates.

In addition, be aware that when a protocol is being compiled, it uses the 
values displayed in the Protocol Task Parameters toolbar screen and not 
the values that will be set by any scripts. This means that there might be 
errors in the protocol that are not detected during compilation. The 
values that appear in the Task Parameter toolbar do not change to reflect 
the effect of any script.
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Also, scripts do not check pipetting volumes before the run begins, so 
you must make sure that the pipetting steps make logical sense. For 
example, you will not be alerted beforehand if a script will attempt to 
aspirate 1 mL from a plate well that can only hold 0.5 mL.

Example scripts Example 1

This script prints the word “hello” to the log toolbar and log.txt file. 

print("hello");

Example 2

This one-line script opens an external file that could contain another 
script. The new script is run immediately.

open("C:\scripts\script1.txt")

Example 3
This script cycles through quadrants within a loop for an Aspirate, 
Dispense, or Mix task. 

//put this script in wherever you want to cycle 
through quadrants within a loop for an aspirate, 
dispense, or mix task.

var row 
if(row == undefined) 
{ 
row = 1 
} 
if(row <=2) 
{ 
task.quadrants= [[1,row]] 
row++ 
}

else if(row > 2) 
{ 
var column = row-2 
task. quadrants = [[2, column]] 
row++ 
}

if(row > 4) 
{ 
row = 1 
}

print("Dispensing to quadrant "+task.quadrants+" 
of Destination plate.")

Example 4
This script prints a list of the properties for the task to the log toolbar. It is 
an essential part of determining the names of properties when creating 
JavaScripts.

for(x in task) {
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print("task[" + x + "]=" + task[x]);

}

Script-writing 
service

Velocity11 offers a custom script-writing service for BenchWorks 
software and other applications. Please contact us for more information.

Related topics

The JavaScript task object and properties

About this topic The BenchWorks software JavaScript interpreter includes a task object 
that is defined by Velocity11.

This topic lists the properties for the Velocity11 JavaScript task object. 
One of the properties is for the Apply Label task. The other properties 
are all for pipette tasks.

Task properties Properties available to all tasks

The following properties can be used for any task.

Apply Label task
The JavaScript Apply Label task properties are listed below, along with 
the data type of the property and the names of the corresponding Apply 
Label task parameters. 

The task.side property is an array of four label_data objects: 

❑ task.side[SOUTH]

❑ task.side[EAST]

For information about... See...

Using JavaScript in BenchWorks 
software

“The JavaScript task object and 
properties” on page 216

Property Data type Description

task.name String Name of the task, for example, 
“Aspirate”

task.description String Description of the task that is given 
under the icon in the protocol editor.

For example, a downstack task that 
has the script 
print(task.description) 
will send the following text to the 
protocol log:

Downstack from stacker2
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❑ task.side[NORTH]

❑ task.side[WEST]

Each of these task.side properties has nine properties, representing the 
fields on the Protocol Task Parameters toolbar for the Apply Label task. 

In the table below, point can be replaced by SOUTH, EAST, NORTH, or 
WEST. For example, the Printing option field for the south label (see 
screenshot) is represented as:

task.side[SOUTH].printLabel

Property Data type Task parameter(s) Comments

task.side[point].field An array of 
six strings

Field 1, Field 2, Field 3, 
Field 4, Field 5, Field 6

For example, 
task.side[WEST].field[2] 
matches the Field 2 text box in 
the West tab of the Protocol 
Task Parameters toolbar.

Note: The options here must 
be all caps.

task.side[point].format Integer Format to use A number that corresponds to 
the barcode format that you 
want for side point. You can set 
a different format for each side 
of the plate.

For information about formats, 
see the VCode Barcode Print 
and Apply Station User Guide.

task.side[point].increment
Chars

Integer Increment chars The number of alphanumeric 
characters that you want to be 
appended to the root data.

task.side[point].startingIn
crement

Integer Starting increment # The number that you want to 
be printed on the first label.

task.side[point].base Integer Numeric (0-9)

Alphanumeric (0-Z)

0 for numeric increments

1 for alphanumeric increments

task.side[point].verifyBarc
ode

Integer Verify barcodes 0 for no barcode verification

1 for barcode verification

task.side[point].maxVerify
Attempts

Integer Reapply up to __ times The number of attempts made 
to verify a barcode.
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Aspirate task
The JavaScript Aspirate task properties are listed below, along with the 
data type of the property, the names of the corresponding aspirate 
properties in the Protocol Task Parameters toolbar, and a reference to 
more information.

task.side[point].sourceBar
codeSide

Integer Use existing barcode 
from ____ side

Copies the barcode from this 
side of the plate

0 = South

1 = West

2 = North

3 = East

task.side[point].printLabel Integer Printing option 0 = No label on side point

1 = Yes label on side point

Property Data type Task parameter(s) Comments

Property Data type Task parameter Comments

task.plateName String Plate name The name of the plate.

Read only.

task.acceleration Float Aspirate acceleration The rate of increase in velocity 
before the maximum aspirate 
velocity is reached.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.liquidClass String Liquid class list The name of the liquid class.

task.postAspirateVolume Float Post aspirate volume The volume of air to be drawn 
up after the liquid is drawn up.

task.preAspirateVolume Float Pre aspirate volume The volume of air to be drawn 
up before the pipette tips enter 
the liquid.

task.quadrants An array of 
pairs of 
integers

Quadrant selection 
diagram

A quadrant is an evenly 
spaced array of locations that 
is addressable by the tips on a 
pipette head. A 96-well head 
can dispense into a 96-well 
plate, four quadrants of a 384-
well plate, and 16 quadrants of 
a 1536-well plate. A 384-well 
head can dispense into a 384-
well plate or the four 
quadrants of a 1536-well plate.
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Change Tips task

These properties are the same as the properties described for the 
Change Tips task.

task.retract Float Tip retract distance The distance that the tips 
should move downwards per 
unit volume of liquid being 
aspirated.

This value allows the tips to 
move downwards during 
aspiration to maintain a 
certain height below the 
surface of the liquid. 

You will need to determine an 
appropriate value by trial-and-
error for each type of plate you 
use.

You might want this value to 
be the same as the Tip Retract 
Distance for the Dispense 
pipette task.

task.tipOffset (Distance 
from well bottom)

Float Distance from well 
bottom

The distance between the 
bottom of the pipette tips and 
the bottoms of the plate wells 
or MicroWash tray chimneys.

If you are using dynamic tip 
retraction this value sets the 
lowest point to which the tips 
will travel.

task.velocity Float Aspirate velocity The rate at which to draw up 
liquid.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.volume Float Aspirate volume The volume of liquid to be 
drawn up into each pipette tip.

Property Data type Task parameter Comments

Property Data type Task parameter Comments

task.plateName String Plate name The name of the plate.
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Dispense task

These properties are the same as the properties described for the 
Dispense task.

task.quadrants An array of 
pairs of 
integers

Quadrants (diagram) A quadrant is an evenly spaced 
array of locations that is 
addressable by the tips on a 
pipette head. A 96-well head 
can dispense into a 96-well 
plate, four quadrants of a 384-
well plate, and 16 quadrants of 
a 1536-well plate.

task.action Integer ❑ Press On New Tips 
(integer = 1)

❑ Tips off (integer = 
2)

Puts tips on to a VPrep head or 
removes tips from a VPrep 
head.

Property Data type Task parameter Comments

Property Data type Task parameters Comments

task.plateName String Plate name The name of the plate.

task.acceleration Float Dispense acceleration The rate of increase in velocity 
before the Dispense Velocity is 
reached.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.blowoutVolume Float Blowout volume The volume of air to blow out 
when the tips are in the liquid.

This is typically the same as the 
pre-aspirate volume.

task.liquidClass String Liquid class (list) The name of the liquid class.

task.postDispenseVolume Float Post dispense volume The volume of air to blow out 
when the tips are out of the 
liquid.

task.quadrants An array of 
pairs of 
integers

Quadrants (diagram) A quadrant is an evenly spaced 
array of locations that is 
addressable by the tips on a 
pipette head. A 96-well head 
can dispense into a 96-well 
plate, four quadrants of a 384-
well plate, and 16 quadrants of 
a 1536-well plate. A 384-well 
head can dispense into a 384-
well plate or the four quadrants 
of a 1536-well plate.
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task.retract Float Retract distance The distance that the tips 
should move upwards per unit 
volume of liquid being 
dispensed.

This value allows the tips to 
move upwards during 
dispensing to maintain a 
certain height above the 
surface of the liquid. 

You will need to determine an 
appropriate value by trial-and-
error for each type of plate you 
use.

You might want this value to be 
the same as the Tip Retract 
Distance for the Aspirate 
pipette task.

task.tipOffset Float Distance from well 
bottom

The distance between the 
bottom of the pipette tips and 
the bottoms of the plate wells 
or MicroWash tray chimneys.

If you are using dynamic tip 
retraction this value sets the 
lowest point to which the tips 
will travel.

task.tipTouch Boolean Enable tip touching Whether you want the tips to 
touch the sides of the plate 
wells or not.

task.tipTouchHorizontalDi
stance

Float Tip touch horizontal 
distance

When the value for this 
parameter is zero, the tips will 
move horizontally one well 
radius. The well radius is 
defined in the labware 
database for the type of plate 
you are using. If you want the 
tips to touch harder, increase 
this value. If you want the tips 
to touch more lightly, enter a 
negative value.

task.tiptouchRiseHeight Float Tip touch rise height The height that the tips should 
move upwards before touching 
the side of the wells.

task.tipTouchSides Integer Number of sides to 
touch

The number of sides of the 
wells that you want the tips to 
touch.

Property Data type Task parameters Comments
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Loop task
These properties are the same as the properties described for the Loop 
task.

Mix task
These properties are the same as the properties described for the Mix 
task.

task.velocity Float Dispense velocity The rate at which to dispense 
the liquid.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.volume Float Dispense volume The volume of liquid to be 
moved out of each pipette tip.

task.enableShake Boolean Enable shaking Turns on shelf shaking during 
dispense.

task.shakeRPM Integer Shake RPM Shaking speed (in RPM).

task.shakeDelay Integer Post-dispense delay Wait time (in milliseconds) 
before shaking starts.

task.shakeTime Integer Shake time Duration (in milliseconds) of 
shaking.

Property Data type Task parameters Comments

Property Data type Task parameter Comments

task.numberOfLoops Integer Number of times to 
loop 

Number of times to loop.

Property Data type Task parameters Comments

task.plateName String Plate name The name of the plate.

task.aspirateAcceleration Float Aspirate acceleration The rate of increase in velocity 
before the maximum aspirate 
velocity is reached.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.aspirateVelocity Float Aspirate velocity The rate at which to draw up 
liquid.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.
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task.blowoff Float Last cycle blowout 
volume

The volume of air to blow out 
when the tips are in the liquid.

This is typically the same as the 
pre-aspirate volume.

task.cycles Integer Number of mixing 
cycles

The number of aspirate/
dispense operations.

task.dispenseAcceleration Float Dispense acceleration The rate of increase in velocity 
before the Dispense Velocity is 
reached.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.dispenseVelocity Float Dispense velocity The rate at which to dispense 
the liquid.

If you selected a liquid class, 
this value is entered 
automatically from the liquid 
library editor.

task.liquidClass String Liquid class (list) The name of the liquid class.

task.preAspirateAirGap Float Pre-aspirate volume The volume of air to be drawn 
up before the pipette tips enter 
the liquid.

task.quadrants An array of 
pairs of 
integers

Quadrants (diagram) A quadrant is an evenly spaced 
array of locations that is 
addressable by the tips on a 
pipette head. A 96-well head 
can dispense into a 96-well 
plate, four quadrants of a 384-
well plate, and 16 quadrants of 
a 1536-well plate. A 384-well 
head can dispense into a 384-
well plate or the four quadrants 
of a 1536-well plate.

Property Data type Task parameters Comments
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task.retract Float Retract distance The distance that the tips 
should move upwards or 
downwards per unit volume of 
liquid being dispensed or 
aspirated.

This value allows the tips to 
move upwards or downwards 
during dispensing or aspirating 
to maintain a certain height 
below or above the surface of 
the liquid.

You will need to determine an 
appropriate value by trial-and-
error for each type of plate you 
use.

task.tipOffset Float Distance from well 
bottom

The distance between the 
bottom of the pipette tips and 
the bottoms of the plate wells 
or MicroWash tray chimneys.

If you are using dynamic tip 
retraction this value sets the 
lowest point to which the tips 
will travel.

task.tipTouch Boolean Enable tip touching Whether you want the tips to 
touch the sides of the plate 
wells or not.

task.tipTouchHorizontalDi
stance

Float Tip touch horiz. dist When the value for this 
parameter is zero, the tips will 
move horizontally one well 
radius. The well radius is 
defined in the labware 
database for the type of plate 
you are using. If you want the 
tips to touch harder, increase 
this value. If you want the tips 
to touch more lightly, enter a 
negative value.

task.tiptouchRiseHeight Float Tip touch rise height The height that the tips should 
move upwards before touching 
the side of the wells.

task.tipTouchSides Integer Number of sides to 
touch

The number of sides of the 
wells that you want the tips to 
touch.

task.volume Float Mixing volume The volume of liquid to be 
aspirated and dispensed to 
each plate well.

Property Data type Task parameters Comments
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Pump Reagent task

These properties are the same as the properties described for the Pump 
Reagent task.

Wash Tips task

These properties are the same as the properties described for the Wash 
Tips task.

Property Data type Task parameter Comments

task.action Integer ❑ Fill reservoir 
(value = 0)

❑ Empty reservoir 
(value = 1)

The Fill reservoir and 
Empty reservoir values 
determine whether the 
pumps will fill or empty 
the reservoir.

To empty the reservoir 
you must complete the 
Autofill Configuration 
information on the 
Shelves tab of the VPrep 
Diagnostics software. For 
more information, see the 
VPrep Pipetting System 
User Guide.

task.howOften Integer Every The number that controls 
how frequently the liquid 
is pumped. 

For example, if you type 
3, the pump will run 
every third time the task 
runs.

task.maxLevel Integer Max level The maximum 
percentage of liquid that 
you want the reservoir to 
contain.

task.minLevel Integer Min level The minimum 
percentage of liquid that 
you want the reservoir to 
contain.

task.plateName String Plate name The name of the plate.

task.shelf String (unnamed list) The shelf on which the 
reservoir is located.

task.speedPercent Integer at The percentage of 
maximum pumping rate.

task.time Integer for The time in seconds that 
the pumps pump.
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Property Data type Task parameters Comments

task.plateName String Plate name The name of the plate.

task.aspirateVelocity Float Aspirate velocity The rate at which to draw 
up liquid.

If you selected a liquid 
class, this value is entered 
automatically from the 
liquid library editor.

task.aspirateAcceleration Float Aspirate acceleration The rate of increase in 
velocity before the 
maximum aspirate 
velocity is reached.

If you selected a liquid 
class, this value is entered 
automatically from the 
liquid library editor.

task.blowoff Float Last cycle blowout 
volume

The volume of air to blow 
out when the tips are in 
the liquid.

This is typically the same 
as the pre-aspirate 
volume.

task.cycles Integer Number of wash cycles The number of aspirate/
dispense operations.

task.dispenseAcceleration Float Dispense acceleration The rate of increase in 
velocity before the 
Dispense Velocity is 
reached.

If you selected a liquid 
class, this value is entered 
automatically from the 
liquid library editor.

task.dispenseToWaste Boolean Dispense to waste at 
height of (check box)

The tips will dispense 
outside the MicroWash 
tray chimneys. 

task.dispenseVelocity Float Dispense velocity The rate at which to 
dispense the liquid.

If you selected a liquid 
class, this value is entered 
automatically from the 
liquid library editor.
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task.heightAboveWaste Float Dispense to waste at 
height of (text box)

The height, in 
millimeters, above the 
MicroWash chimneys at 
which the tips will 
dispense. Used in 
combination with the 
dispense to waste 
property. Enter a negative 
number to make sure that 
the tips are below the 
tops for the chimneys.

task.inFlowPercent Integer Inflow pump The relative rate of liquid 
flow into the MicroWash 
tray manifold. This value 
should be high enough 
for the washing liquid to 
just bubble over the tops 
of the chimneys.

task.liquidClass String Liquid class (list) The name of the liquid 
class.

task.outFlowPercent Integer Outflow pump The relative rate of liquid 
flow out of the 
MicroWash tray manifold. 
This value is typically 
zero because the fluid is 
drained by gravity.

task.preAspirateAirGap Float Pre-aspirate volume The volume of air to be 
drawn up before the 
pipette tips enter the 
liquid.

task.quadrants An array of 
pairs of 
integers

Quadrants (diagram) A quadrant is an evenly 
spaced array of locations 
that is addressable by the 
tips on a pipette head. A 
96-well head can 
dispense into a 96-well 
plate, four quadrants of a 
384-well plate, and 16 
quadrants of a 1536-well 
plate. A 384-well head 
can dispense into a 384-
well plate or the four 
quadrants of a 1536-well 
plate.

Property Data type Task parameters Comments
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task.retract Float Retract distance The distance that the tips 
should move upwards or 
downwards per unit 
volume of liquid being 
dispensed or aspirated.

This value allows the tips 
to move upwards or 
downwards during 
dispensing or aspirating 
to maintain a certain 
height below or above 
the surface of the liquid.

You will need to 
determine an appropriate 
value by trial-and-error 
for each type of plate you 
use.

task.tipOffset Float Distance from well 
bottom

The distance between the 
bottom of the pipette tips 
and the bottoms of the 
plate wells or MicroWash 
tray chimneys.

If you are using dynamic 
tip retraction this value 
sets the lowest point to 
which the tips will travel.

task.tipTouch Boolean Enable tip touch Whether you want the 
tips to touch the sides of 
the plate wells or not.

task.tipTouchHorizontalDistance Float Tip touch horiz. dist. When the value for this 
parameter is zero, the tips 
will move horizontally 
one well radius. The well 
radius is defined in the 
labware database for the 
type of plate you are 
using. If you want the tips 
to touch harder, increase 
this value. If you want the 
tips to touch more lightly, 
enter a negative value.

task.tiptouchRiseHeight Float Tip touch rise height The height that the tips 
should move upwards 
before touching the side 
of the wells. 

task.volume Float Wash volume The volume of liquid to 
be drawn up into each 
pipette tip.

Property Data type Task parameters Comments
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Related topics

About barcode reading and tracking

About this topic This topic gives an overview of the barcode reading and tracking 
abilities of the BenchCel Workstation.

Read this topic if you are a technician or administrator who writes 
protocols with barcode reader tasks or Apply Label tasks.

barcode readers A customized can have barcode readers installed that can read 
barcodes on one side of a plate (the side varies, depending on your 
application needs). These may be installed on VPrep Pipettor shelves or 
platepads. Every time a plate is moved to one of these devices, the 
barcode is read. 

Note: To read a barcode at a platepad barcode reader or VCode 
Microplate labeler, use the Place Plate task. 

VCode: barcode 
printer and optional 
reader

If your has a VCode Microplate Labeler, you have the ability to print and 
apply barcode labels. 

If the VCode Microplate Labeler includes an optional reader, barcode 
labels can be read on any side of the plate, because the VCode 
Microplate Labeler can rotate the plate in a full circle.

Related topics

For information about... See...

JavaScript in BenchWorks software “Using JavaScript in BenchWorks 
software” on page 209

Labware editor “About the labware editor” on page 248

For information about... See...

Planning to add barcode labels to 
plates

“Using barcode input files” on page 230

Adding the Apply barcode task to 
a protocol

“Setting Apply Label task parameters” 
on page 91

Reading plates at a platepad “Setting Place Plate task parameters” on 
page 113
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Using barcode input files

About this topic This topic describes how to create and use barcode input files.

Read this topic if you are a technician or an administrator who writes 
protocols with barcode reader or Apply Label tasks.

Barcode fields When setting up a VCode Microplate Labeler, you set task parameters 
that specify the content of barcode fields.

An example of a barcode field is:

NAW1001

Barcode fields can be imported from barcode input files.

For detailed information about barcode fields and formats, see the 
VCode Barcode Print and Apply Station User Guide.

Barcode input files Filename and location
Barcode input files are text files with the naming convention 
(filename.bar). They are stored in the location specified in the general 
BenchWorks software options. 

When to use
You can use barcode input files to do the following:

❑ Verify the barcodes on incoming plates, which are plates that are 
downstacked into the system.

This function is set in the parameters for the plate icon of the 
incoming plates:

❑ Specify each field of a barcode that is printed on a plate.

How they are created
Barcode input files are typically generated by a LIMS system, although 
you can create them manually.
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File structure

Barcode input files contain lists of barcode fields, or parts of fields, that 
are grouped together in series. In the following example, there are two 
series:

❑ Set1

❑ Set2

Each series could be used to label a different side of the same plate or 
label plates during different runs.

Viewing a barcode 
file in BenchWorks 
software

You can view the barcode file that is currently associated with 
BenchWorks software as follows.

To view the associated barcode input file: 

1. Select Tools > Show Barcode File.

This opens a view of the barcode input file.
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2. Click a tab to show a different series of data.

3. To close the window, click the close box.

Updating a barcode 
input file

If you change a barcode input file while a protocol is running, you must 
reload the file for the change to be registered.

To reload a barcode input file:

1. Select Tools > Reload BarCode File.

The barcode input file is reloaded.

Related topics
For information about... See...

Selecting barcode files “Setting BenchWorks software options” 
on page 22

Using the FileReader “About the FileReader plug-in” on 
page 203
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Using barcode data files

About this topic This topic describes how to create and use barcode data files in 
collaboration with barcode input files.

Read this topic if you are a technician or an administrator who writes 
protocols with Apply Label tasks.

Barcode data files File format and location
Barcode data files are tab-delimited text files with the name 
filename.dat. They are stored in a location specified in the general 
BenchWorks software options. 

How they work
A barcode data file acts as a lookup table that specifies what barcode 
fields to print on other sides of a plate. The typical sequence of events is 
as follows:

1. A plate with a south-side barcode is downstacked into the system.

2. The robot picks up the plate, reads the barcode, and verifies it 
against a barcode input file.

3. The robot moves the plate to a VCode Microplate Labeler.

4. The barcode that was read is used as a key to look up the barcode 
fields to print on the other sides of the plate, using the barcode data 
file as the lookup table.

5. The VCode Microplate Labeler prints a barcode on the north-side, 
east-side, and west-side of the plate.

Barcode data files can also be used with incoming plates that have west-
side barcodes. In this case, the barcode must be read at the VCode 
Microplate Labeler or platepad and not by the robot’s barcode reader.

!! IMPORTANT !! Barcode data files cannot currently be used 
with incoming barcodes on the north or east sides.

Barcode data files can still be used if the downstacked plate has no 
barcode, provided that incoming barcode verification is turned off. The 
plate could be moved to the VCode Microplate Labeler and labelled on 
its south or west side. That label could then be read and used with a 
barcode data file to specify the labels to be printed on the other sides of 
the plate.

Where they are specified
The use of barcode data files is specified when configuring task 
parameters for an Apply Label task.

File structure An example of a barcode data file is shown below. The columns are 
separated by tabs.
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!! IMPORTANT !! The columns must be in the order north, east, 
south and west, from left to right.

Related topics
For information about... See...

Selecting barcode data files “Setting BenchWorks software options” 
on page 22

Barcode input files “Using barcode input files” on page 230

Applying barcodes “Setting Apply Label task parameters” 
on page 91
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Administrator 
procedures
 9
This chapter is for people with administrator login privileges. It describes 
assorted administrative tasks. This chapter contains the following topics:

❑ “About user accounts and privileges” on page 236

❑ “Adding and deleting a user account” on page 237

❑ “Setting up email” on page 239

❑ “Moving or sending a registry file” on page 240

❑ “Obtaining information about the BenchCel Workstation network 
cards” on page 242
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About user accounts and privileges

About this topic You must have a user account to log in to BenchWorks software. Your 
user account is associated with a user role that determines the privileges 
you have to perform particular functions.

This topic describes the privileges associated with different user roles.

The effect of 
privileges

Privileges have the following effects:

❑ If you do not have the privilege to perform a function associated 
with a particular menu command, the text of the command is gray.

❑ If you do not have the privilege to perform the functions accessed 
from a particular tabbed page, the tab is not visible to you.

❑ In some cases, if you do not have the privilege to perform an 
operation, when you attempt the operation you get an error message 
telling you that your privileges are insufficient.

User roles and 
privileges

User roles enforce the following privileges:

Related topics

User role Has privileges to...

Guest Run existing protocols.

Operator ❑ Perform guest functions (see above).

❑ Operate devices in real-time using diagnostics software.

Technician ❑ Perform operator functions (see above).

❑ Create and save protocols.

❑ Edit the labware database and liquid library database.

Administrator ❑ Perform technician functions (see above).

❑ Manage devices through the device manager.

❑ Create and delete user accounts.

❑ Run a protocol that contains compiler errors.

For information about... See...

Adding and deleting accounts “Adding and deleting a user account” 
on page 237

Setting up email “Setting up email” on page 239

Sending a registry file “Moving or sending a registry file” on 
page 240
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Adding and deleting a user account

About this topic We recommend that BenchCel Workstation administrators create an 
account for every user. The privileges set for the account should be 
appropriate for the users’ job role. 

This topic explains how to add and delete user accounts.

About user accounts 
and passwords

User accounts and passwords use the following conventions:

❑ User names and passwords are case-sensitive.

❑ Passwords must contain six or more characters.

❑ If a user enters an incorrect password three times consecutively, the 
user is locked out until an administrator resets the account.

Adding a user 
account

To add a user account:

1. Select Tools > Manage Users.

2. In the User Editor dialog box, click Add.

3. Enter the name if the user in the User name field.

4. Select an Access level from the list.

5. Click Change password.

6. Enter a password in the New field. 

Note: Leave the Old field empty since there is no previous 
password for a new account.

7. Repeat the entry in the Confirm field.

8. Click OK.
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Deleting a user 
account

To delete a user account:

1. Select Tools > Manage Users.

2. Select the account.

3. Click Delete.

4. Click Yes in the alert dialog to delete the account.

Changing a 
password

An administrator can reset the password of any account. Operators and 
technicians can change their own passwords at Log in.

To reset a password:

1. Select Tools > Manage Users.

2. Select an account.

3. Click Change password.

4. Enter the old password in the Old field.

5. Enter the new password in the New and Confirm fields.

6. Click OK.

Related topics
For information about... See...

User accounts and privileges “About user accounts and privileges” on 
page 236

Setting up email “Setting up email” on page 239
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Setting up email

About this topic This topic describes how to add an email address to BenchWorks 
software so you can be notified by email or pager when there is a run 
error.

Email setup in BenchWorks software enables you to do the following 
tasks:

❑ Automatically be notified by email or pager when errors occur 
during a protocol run

❑ Send a bug report to Velocity11

Requirements for 
email setup

Before you can send an email from BenchWorks software, the 
controlling computer must:

❑ Be connected to a network with internet access

❑ Have network access to an outgoing mail server that supports one of 
the authentication methods available through BenchWorks software.

Setting up email To set up the outgoing email server:

1. Select Tools  > Options.

2. In the Mail Server Setup area, enter the name of your SMTP server 
name (outgoing email server).

3. If the server requires a user name and password:

a. Select the Authentication type from the list.

!! IMPORTANT !! The authentication type is critical. Check with 
your network administrator to determine the best authentication 
network for your email server.

b. Enter your User name and Password for the selected 
authentication type.

c. Click Add. A new email address entry appears in the Recipient 
list for error notification.

d. Click on the New email address entry and type in your email.

e. Click OK in the Options dialog box, to save the email setup 
information and close the dialog box.
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This information only needs to be set up once, provided the email 
account remains active. All email sent from BenchWorks software is 
authenticated using this account.

Related topics

Moving or sending a registry file

About this topic This topic provides instructions on how to export a Windows registry file 
for import to another computer or for emailing to Velocity11.

When to do this You might need to copy or send a registry file in the following situations:

❑ To move a labware or liquid library database to other devices using 
a different controlling computer

❑ To make a backup of a BenchWorks software profile

❑ To transfer a BenchWorks software profile from one computer to 
another

❑ To email a labware or liquid library database or BenchWorks 
software profile when requested by personnel at Velocity11

About moving data The labware and liquid libraries and profiles are maintained in the 
Windows registry of the controlling computer. 

If you make a change to the labware or liquids database or a profile, you 
can use a two-step process to propagate the change to another 
computer. 

For information about... See...

Sending a bug report “Sending a bug report” on page xiv

Sending a registry file “Moving or sending a registry file” on 
page 240
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1. Export the Windows registry key containing the data to a file.

2. Import the file to the other computer’s registry.

Damage hazard !! DAMAGE HAZARD !! Making a mistake when editing the 
registry might cause critical failures with your operating system.

Exporting a registry 
key

To export a registry key:

1. From the Windows Start menu, select Run.

2. In the Open text box, type regedit.

3. Click OK.

The Windows registry editor opens.

4. Expand folders to display and select one of the following folders:

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\Shared\Labware
\Labware_Entries

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\Shared\Liquid 
Library

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\device 
name\Profiles

5. From the Registry (or File) menu, select Export.

The Export Registry File browser box opens.

6. Before saving the file, make sure you: 

Select Selected branch.

If you are moving the file to a computer with a different 
Windows operating system, set Save as type appropriately.

7. Save the file.

8. Select Registry > Exit (or File > Exit) to close the registry editor.

Importing a registry 
key

If this is the first time you are importing a registry file to the computer, 
you need to use the Open With command.

Before you start
You must have Windows Administrator permissions to perform this task.
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To import a registry key:

1. Copy the registry file to any location on the recipient computer. If 
necessary, change the file’s extension from .re_ to *.reg.

2. On the recipient computer, double-click the registry file.

3. Click Yes to the prompt asking if you are sure you want to do this. 
The information in the file is written automatically to the registry and 
this will be confirmed with a message.

Note: When importing labware definitions, the labware class must 
be reassigned. See Related topics at the end of this topic for a 
procedure.

Emailing a registry 
file

Occasionally, you might be asked to send a registry file to Velocity11. 

To email a registry file:

1. Export the Windows registry key containing the data to a file.

2. Change the file’s extension to .re_ (This is necessary because many 
email servers do not allow *.reg files to be emailed.) 

3. Email the file.

Related topics

Obtaining information about the BenchCel 
Workstation network cards

About this topic You might need to provide some of the information to your network 
administrator for your BenchCel Workstation to be connected to your 
organization’s network.

Your BenchCel Workstation has two network cards. The network 
connections for these cards are named WAN and LAN.

This topic describes the BenchCel Workstation network cards and how 
to obtain their network IP addresses.

BenchCel 
Workstation 
computer network 
connections

Note: Depending on how you have personalized your operating system, 
you might need to use a slightly different procedure from the one below.

To see the network connections in Windows:

1. In Windows, from the Start menu select Settings > Control Panel.

For information about... See...

Sending a bug report “Sending a bug report” on page xiv

Setting up email for error 
notification

“Setting up email” on page 239
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2. Double-click the Network and Dial-Up Connections icon.

The Network and Dial-up Connections window opens.

LAN network card

The LAN network card is used for communication between the 
computer and devices that use Ethernet communication cable. This 
network is considered to be the local area network.

The LAN network card has a fixed IP address, which is 192.168.0.1. 

WAN network card

The WAN network card is for networking with your organization’s 
network. The settings for this card should be configured by your network 
administrator in the same way that any PC would be configured to make 
it available to your network.

The WAN network card has an IP address that is dynamically assigned by 
your domain name server when you start you BenchCel Workstation’s 
computer.

Obtaining network IP 
addresses

To see the IP address of the two network cards:

1. In BenchWorks software, click the Device Manager tab.

2. Select a stack from the Device List.

3. Click Device Diagnostics.

4. In the Discovered BioNet Devices dialog box, click the drop-down 
arrow for the Select the Ethernet adapter to use... list.

!! IMPORTANT !! Make sure that you do not change the 
selected IP address when you do this. VStacks should always 
be connected to the LAN network with the 192.168.0.1 IP 
address.

Related topics
For information about... See...

Sending a bug report “Sending a bug report” on page xiv

Setting up email for error 
notification

“Setting up email” on page 239
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Users and privileges “About user accounts and privileges” on 
page 236

For information about... See...
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Defining labware
 10

This chapter is for people with administrator or technician login 
privileges. It describes the use of the labware editor dialog box and the 
labware parameters group box, which are used to enter information 
about labware. This contains the following topics:

❑ “About defining labware in BenchWorks software” on page 246

❑ “Workflow for defining labware” on page 247

❑ “About the labware editor” on page 248

❑ “Labware editor overview” on page 249

❑ “Opening the labware editor” on page 252

❑ “Adding a labware entry” on page 254

❑ “Defining general properties” on page 256

❑ “Defining plate properties” on page 257

❑ “Defining labware properties for a BenchCel Workstation” on 
page 261

❑ “Defining stacker properties” on page 265

❑ “Inserting an image” on page 268

❑ “About labware classes” on page 269

❑ “Using labware classes” on page 272

❑ “Managing labware entries” on page 275

❑ “About the Labware tab in BenchCel Diagnostics” on page 277
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About defining labware in BenchWorks software 

Labware defined Labware is a physical object such as a plate, lid, or tip box that will be 
acted upon by the tasks stored in your protocol.

Labware entry 
defined

A labware entry is the collection of property values used to describe a 
piece of labware. This information is used by BenchWorks software to 
command the robot and other devices to do tasks based on the 
information in the definition.

Entering labware 
parameters

All labware parameters are accessible through the Labware Editor. A 
subset of these parameters is also accessible in the Control tab of 
BenchCel Diagnostics.

Related topics
For information about... See...

Using the labware editor “About the labware editor” on page 248

Labware tab in BenchCel 
Diagnostics

❑ “About the Labware tab in 
BenchCel Diagnostics” on page 277

❑ BenchCel Microplate Handling 
Workstation User Guide

Opening the labware editor “Opening the labware editor” on 
page 252
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Workflow for defining labware

About this topic This topic describes the workflow for defining labware.

Labware standards !! IMPORTANT !! All labware used with Velocity11 products must 
conform to the American National Standards Institute (ANSI) 
microplate standards. This includes deepwell and PCR plates. A 
group within the Society for Biomolecular Sciences (SBS) 
recommends and maintains the standards. Visit www.sbsonline.org 
for more information, or contact your labware’s manufacturer.

Workflow This topic provides the sequence of steps for defining labware for 
BenchCel Workstation.

Note: The BenchCel Microplate Handling Workstation User Guide has 
additional information on some of these steps.

Step For this task... See...

1 Add the labware entry to 
the labware editor

❑ “Opening the labware editor” 
on page 252

❑ “Adding a labware entry” on 
page 254

2 Define the general 
properties of the labware

“Defining general properties” on 
page 256

3 Define the plate properties “Defining plate properties” on 
page 257

4 Specify the robot and 
stacker gripping positions

❑ “Defining labware properties for 
a BenchCel Workstation” on 
page 261

❑ BenchCel Microplate Handling 
Workstation User Guide

5 Specify any plate notch 
positions

❑ “Defining stacker properties” on 
page 265

❑ BenchCel Microplate Handling 
Workstation User Guide

6 Assign the labware to a 
class

❑ “About labware classes” on 
page 269

❑ “Using labware classes” on 
page 272

http://www.sbsonline.org
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Related topics

About the labware editor

Labware editor 
defined

The labware editor is the BenchCel Workstation interface through which 
you can enter information about labware.

You must be logged in as an administrator or technician to use the 
labware editor.

Types of information 
stored

Three types of information are stored in the labware database:

❑ Information about the physical and non-physical properties such as 
thickness, well depth, and robot handling speed.

❑ Information regarding the robot such as handling speed, offsets and 
other plate-handling options.

❑ Information about labware classes to which the labware belongs. 
Labware definitions are allowed or prohibited from being processed 
by a device, based on their labware classes.

About labware 
properties

Labware properties include both the physical properties and the robot-
specific properties associated with that piece of labware.

Once a piece of labware is defined, all you have to do is select it from 
the labware list when you set up a protocol.

About labware 
classes

Labware classes are sets of labware entries, grouped so they are easier to 
manage than many individual labware entries.

Labware classes are used to restrict labware types from one or more 
locations during a protocol run. This helps to prevent wasted runs and 
damage to the devices on the workstation. 

Related topics

For information about... See...

Using diagnostics to access some 
of the labware settings

❑ “About the Labware tab in 
BenchCel Diagnostics” on page 277

❑ BenchCel Microplate Handling 
Workstation User Guide

For information about... See...

Moving the labware database to 
another computer

“Moving or sending a registry file” on 
page 240
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Labware editor overview

About this topic This topic gives an overview of the organization of the labware editor’s 
user interface.

Labware Editor 
pages

The labware editor has two tabs at the top of the screen:

❑ Labware Entries. The tab contains labware definitions

❑ Labware Classes. The tab contains a list of labware classes and the 
labware entries for each class 

Labware Entries 
page

Sub-pages

The Labware Entries tab contains the following tabs at the bottom of the 
screen:

❑ Plate Properties

❑ BenchCel

❑ Stacker

❑ Pipette/Well Definition 

❑ Bravo

❑ Image

❑ Labware Classes

Labware selection box

The labware selection box, which is the left-hand column, is used to 
select a labware entry that you want to edit.

Defining labware “Workflow for defining labware” on 
page 247

Opening the labware editor “Opening the labware editor” on 
page 252

Editing labware parameters “” on page 277

For information about... See...
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Labware-Entry General Properties area
The Labware-Entry General Properties area displays the labware-entry 
general properties whose selections apply across all sub-tabs.

Labware Classes 
page

In the Labware Classes page, you create labware classes and assign 
defined labware to a labware class.
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Related topics
For information about... See...

Moving the labware database to 
another computer

“Moving or sending a registry file” on 
page 240

Defining labware “Workflow for defining labware” on 
page 247

Opening the labware editor “Opening the labware editor” on 
page 252

Editing labware parameters “” on page 277
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Opening the labware editor

About this topic This topic explains how to open the labware editor. 

You open the labware editor when you want to:

❑ View existing labware entries or classes

❑ Edit labware entries or classes

❑ Add new labware entries or classes

❑ Delete labware entries or classes

❑ Rename labware entries or classes

Before you start You must be logged in as an administrator or technician to open the 
labware editor.

If you are adding labware, make sure you have the following:

❑ Calipers

❑ Two samples of the labware you are adding

Procedure You can open the labware editor from the device manager and from the 
protocol editor.

To open the labware editor from the device manager:

1. Click the Device Manager tab.

2. In the Device List toolbar, expand System and double-click Labware 
(or click Device diagnostics).

To open the labware editor from the protocol editor:

1. Click the Protocol Editor tab.

2. Select a plate process icon.

3. In the Protocol Task Parameters toolbar, click Edit labware settings.
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The Labware Editor dialog box opens.
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Related topics

Adding a labware entry

About this topic The first step in defining a new piece of labware is to add a labware 
entry for it.

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start Before you add a new labware entry:

❑ Check to see if it is already defined in the labware editor. 

Some common labware and some Velocity11 labware comes 
already defined in BenchWorks software.

❑ Contact Velocity11 with the definition you need.

Velocity11 maintains a large collection of labware definitions and 
might be able to supply you with what you need. However, these 
labware definitions will still require some fine-tuning for each 
particular system. The generic definitions available for some plate 
types is a good starting point.

To find out if a type of plate is already defined:

1. In BenchWorks software, click the Protocol Editor tab, and select the 
plate icon in a process.

For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

Editing labware parameters BenchCel Microplate Handling 
Workstation User Guide
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2. In the Protocol Task Parameters toolbar, click the down arrow on the 
list box and look for the name of the plate.

If there is no entry for the plate, it is not defined.

Procedure To add a labware entry:

1. Open the Labware Editor.

2. Under the labware selection box on the left side of the window, click 
New labware entry.

Note: You can save a lot of time by first checking to see if there's a 
similar piece of labware already defined. Click Save changes as 
and enter a name for the new labware.

3. In the New Labware Entry dialog box, enter a name for the plate and 
click OK.

For clarity, enter a detailed name for the labware that includes the 
manufacturer’s name and plate-specific information.

The entry appears in the labware selection box.

Related topics
For information about... See...

Opening the labware editor “Opening the labware editor” on 
page 252
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Defining general properties

About this topic After adding a labware entry, define the general properties of the 
labware. This topic describes how to define the labware’s general 
properties.

You must be logged in as an administrator or technician to perform this 
procedure.

About general 
properties

The general properties describe the type of labware that is being entered 
into the database and are visible on all of the sub-tabs of the labware 
editor.

Before you start You must have added a labware entry that you want to define.

Procedure To define the general properties of a piece of labware:

1. Open the Labware Editor.

2. Select the labware in the left column.

3. In the Description text box, type in a detailed description of the 
labware.

4. For your reference, in the Manufacturer part number text box, enter 
the appropriate number. 

5. In the Number of wells list, select the number of wells in the plate. 

If you are defining a tip box, this is the number of tips that the box 
can hold.

Defining general properties of 
your new labware entry

“Defining general properties” on 
page 256

Defining the Plate Properties “Defining plate properties” on page 257

Defining BenchCel platform 
properties

“Defining labware properties for a 
BenchCel Workstation” on page 261

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

Editing labware parameters BenchCel Microplate Handling 
Workstation User Guide

For information about... See...
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6. In the Base Class area, select one of the options.

The option you select determines which labware editor properties 
are available. For example, when a base class of Microplate is 
selected, the Length of filter tip/pin tool (mm) property is 
unavailable.

Related topics

Defining plate properties

About this topic You can specify the plate properties in either the Labware Editor or in 
BenchWorks software Diagnostics. The plate properties you specify in 
one place is automatically updated in the other.

This topic describes how to specify the plate properties in the Labware 
Editor.

You must have a technician or administrator user account to perform 
this procedure.

Defining plate 
properties

To define plate properties:

1. Click the Plate Properties sub-tab of the Labware Editor.

2. Enter the values for the available parameters according to the type 
of plate or labware you are defining. 

The parameters on the Plate Properties sub-tab are described in the 
following screenshot and table. 

Note: Only the parameters associated with the Base Class you 
selected in the General Properties section will be available. 

For information about... See...

Opening the labware editor “Opening the labware editor” on 
page 252

Adding a labware entry “Adding a labware entry” on page 254

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

Editing labware parameters BenchCel Microplate Handling 
Workstation User Guide
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Property Description

Robot gripper 
offset

This parameter is not used by BenchWorks software. 
This parameter refers to the offset for a BioCel System 
robot. The comparable parameter for the BenchCel 
robot is located on the BenchCel tab. 

Thickness The distance, in millimeters, from the bottom surface 
of the plate to the top surface of the plate.

For a tip box, this is the distance from the bottom 
surface of the box to the top of the tips.

To increase the number of contact points, measure the 
distance at the corner of the plate or tip box (using 
calipers). This method is especially useful if the plate 
has a lip at the top and the caliper can angle inward, 
producing inaccurate measurements.
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Stacking 
thickness

The thickness, in millimeters, of two stacked plates 
minus the thickness of one plate.

Measure the distance using calipers.

Example:

Thickness of two stacked plates (x) = 23.14 mm

Thickness of one plate = 14.14 mm

Stacking thickness: 23.14 mm - 14.14 mm = 9.00 mm

Can be 
sealed?

The option to include the plate seal. 

Sealed 
thickness

The thickness, in millimeters, of the plate with a seal in 
place.

Available only if Can be sealed? is selected.

Sealed 
stacking 
thickness

The stacking thickness, in millimeters, of the plate with 
a seal in place.

Available only if Can be sealed? is selected.

Can have lid? The option to include a plate lid.

Lidded 
thickness

The thickness, in millimeters, of the plate with a lid in 
place.

Available only if Can have lid? is selected.

Lidded 
stacking 
thickness

The stacking thickness, in millimeters, of the plate with 
the lid in place.

Available only if Can have lid? is selected.

Lid gripper 
offset

The height, in millimeters, above the lid resting height 
at which to grip the lid. (Shown as b below.)

Lid resting 
height

The height, in millimeters, above the bottom of the 
plate at which the bottom of a plate lid rests. (Shown as 
a below.)

Property Description

Vstack
plate and stacking thickness
00022

Plate Thickness

Stacking Thickness

x

00022

b

a
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Related topics

Lid departure 
height

The height, in millimeters, above the bottom of the 
plate to which the lid is lifted.

Lower plate at 
VCode

The option to lower the plate on the stage of the 
VCode, if the plate has a thick skirt. This allows the 
VCode to place the label above the thick skirt.

Can mount The option to place the plate on top of another plate.

This property is for filter plates that are placed on top of 
waste plates during filtration steps of a protocol.

Can be 
mounted

The option to place another plate on top of this plate.

This property is for collection plates that collect filtrate 
from filter plates during the filtration steps of a 
protocol. Many different plates might be able to fit 
under any one type of filter plate. 

!! IMPORTANT !! The wells of the waste 
plate must have a large enough diameter that 
the filter plate does not stick on the waste plate. 
The robot must be able to pick up the filter 
plate without the waste plate lifting up with it.

Maximum 
robot 
handling 
speed

The maximum speed at which this type of plate should 
be moved.

The general robot speed is set in BenchWorks software. 
If the plate-specific robot speed (set here) is different 
from the general robot speed, the slower of the two 
speeds is used.

Length of 
filter tip/pin 
tool

The length, in millimeters, the filter nozzle extends 
below the bottom edge of the skirt. Use a caliper to 
measure the length.

Property Description

c

For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

Editing labware parameters BenchCel Microplate Handling 
Workstation User Guide

Adding a piece of labware “Adding a labware entry” on page 254
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Defining labware properties for a BenchCel 
Workstation

About this topic This topic describes the properties on the BenchCel sub-tab of the 
Labware Editor dialog box.

Note: You must also define a subset of the Stacker properties (under the 
Stacker sub-tab) because they apply to the built-in stackers of the 
BenchCel Workstation.

About the BenchCel 
Workstation 
properties

The BenchCel Workstation X-Series and R-Series each have their own 
gripper offsets and positions. When you add a new labware entry, default 
property values are automatically inserted for both series. These values 
are approximate and should be ignored because the labware you are 
defining may be different.

Any labware that you are using with the X-Series will need to be 
redefined to work with the R-Series BenchCel Workstation because the 
property values are different for the same piece of labware. 

Procedure To define the BenchCel Workstation properties:

1. Click the button that corresponds to the BenchCel Workstation type 
that is currently operating and for which you are defining the 
labware.

!! IMPORTANT !! Make sure you are entering data for the correct 
BenchCel Workstation type. Fields for X-Series and R-Series 
BenchCel Workstations can be enabled regardless of the type of 
BenchCel Workstation that you are operating.

2. Measure the labware and enter the values into the appropriate fields.

The properties on the BenchCel sub-tab are described in the 
following sceenshot and table. All of the properties on this sub-tab 
apply to the BenchCel Workstation.

Deleting a labware entry “Managing labware entries” on 
page 275

For information about... See...
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Click the button to enable the text fields

Property Description

Robot gripper offset The distance, in millimeters, from the 
bottom of the plate to the point where 
the grippers grip the plate. Typically this 
value is 6–10 mm.

!! IMPORTANT !! Make sure 
that the gripper points are not 
closing near the very edge of the 
skirt causing some of the gripper 
points to slip onto the body of the 
plate and the plate to be dropped.
Note: The robot gripper offset that 
appears on the Plate Properties page 
applies to Velocity11 robots used in 
BioCel Systems, not BenchCel 
Workstation robots.

Gripper open position The distance, in millimeters, that each 
gripper moves from its home position 
as the robot releases a microplate. An 
larger value moves the grippers closer 
together. A smaller value opens the 
grippers wider.

The parameter value is applied to both 
robot grippers. For example, a value of  
–1.00 mm opens each robot gripper  
–0.50 mm from its home position.

Set this to –1 for R series and 0.1 for X 
Series BenchCel Workstations.
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Gripper holding plate position The distance, in millimeters, that the 
grippers move inward from their home 
position when holding a microplate 
that is not in a stack. A larger value 
moves the grippers closer together and 
holds the microplate tighter. A smaller 
value opens the grippers wider.

The parameter value is applied to both 
robot grippers. For example, a value of 
5.25 mm moves each robot gripper 
2.625 mm toward each other from its 
home position.

Note: How tightly the robot grippers 
should hold a microplate depends on 
the microplate material and design. You 
might want to run some tests to 
optimize the parameter.

Gripper holding lidded plate 
position

The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a lidded 
microplate. 

An increasing value moves the grippers 
closer together and holds the lidded 
microplate tighter. A decreasing value 
opens the grippers wider.

Gripper holding lid position The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a microplate lid. 
An larger value moves the grippers 
closer together and holds the 
microplate tighter. A smaller value 
opens the grippers wider.

The parameter value is applied to each 
robot gripper. For example, a value of 
5.25 mm moves each robot gripper 
2.625 mm toward each other from its 
home position.

In general, type a value that is less than 
Gripper holding plate position to open 
the grippers slightly. Holding the lid too 
tightly might cause the microplate to be 
lifted with the lid.

Property Description
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Gripper holding stack position The distance, in millimeters, that each 
gripper moves inward from its home 
position when holding a microplate 
that is in a stack. An increasing value 
moves the grippers closer together and 
holds the microplate tighter. A 
decreasing value opens the grippers 
wider.

The parameter value is applied to both 
robot grippers. For example, a value of 
5.25 mm moves each robot gripper 
2.625 mm toward each other from its 
home position.

Note: Because the weight of the entire 
stack will be on the robot grippers, you 
should use a value greater than the 
Gripper holding plate parameter.

Stacker gripper offset Adjusts the height at which the stacker 
grippers will grab the plate. This 
distance is measured in millimeters 
from the bottom of the plate. 

Be careful not to grab the plate on the 
top edge of the skirt where the stacker 
grippers could slip onto the plate body.

Change this value only if the stacker is 
not gripping the plates correctly.

Orientation sensor offset The distance, in millimeters, from the 
bottom of a microplate to where the 
orientation sensors will check for 
notches.

Velocity11 recommends that you 
calculate the offset as follows: 
Determine the halfway distance 
between the top of the microplate and 
the top of the microplate skirt, and then 
add the height of the skirt.

Property Description

Divide this height by 2

Add the skirt height
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Defining stacker properties

About this topic This topic describes how to define the stacker properties for your 
labware definition.

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start Make sure you have read the portions of the BenchCel Microplate 
Handling Workstation User Guide that describes the location and 
function of the stacker sensors.

Stack holding method (R-Series 
only)

Determines how the stacker holds the 
stack of plates.

Holding the stack with grippers is more 
precise and slower than holding the 
stack with a shelf.

Choose Hold with stacker gripper if 
your plate has a narrow gripping 
tolerance requiring a specific stacker 
gripper offset.

Choose Hold with shelf if your plate has 
a wider gripping tolerance and does 
not require a specific stacker gripper 
offset.

Note: Cycle time is faster with the shelf 
method.

Property Description

For information about... See...

Opening the labware editor “Opening the labware editor” on 
page 252

Adding a labware entry “Adding a labware entry” on page 254

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

Editing labware parameters BenchCel Microplate Handling 
Workstation User Guide
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Defining properties To define stacker properties:

1. Click the Stacker sub-tab of the Labware Editor.

2. Enter the values for the available parameters according to the type 
of plate or labware you are defining. 

The properties on the Stacker sub-tab are described in the following 
screenshot and table. 

For BenchCel Workstations, you only need to set the maximum 
orientation sensor threshold, sensor intensity and notch locations. 
The other settings are used by the VStack Stacker, not the BenchCel 
Workstation.

Set these properties for 
BenchCel stackers

Property Description

Orientation sensor threshold 
(max)

Specifies the highest value that an 
orientation sensor can register when 
sensing a notch. Any sensor reading 
above this value indicates that a solid 
plate wall is present. Any sensor 
value below this threshold indicates 
that either a notch, or no plate is 
present.

If the stacker does not sense a notch 
when it should, you will get a “wrong 
plate type” or a “plate rotated 180 
degrees” error message. Adjust the 
sensor threshold value.

The maximum value is 255.
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Sensor intensity Sets the percentage of maximum 
sensor intensity for all sensors. If the 
sensor intensity is set too low, a plate 
will not be detected even though one 
is present. If it is set too high, the 
sensors might become saturated, 
causing failure to detect the 
orientation of a plate.

This property adjusts for the fact that 
clear, black, and white plates reflect 
light differently. For example, white 
plates generally reflect more light so 
the sensor intensity should be set 
lower. 

Notch locations With the A1 well of your plate 
positioned in the far, left corner as 
you face the BenchCel Workstation., 
select the corresponding notch or 
notches for your plate in the Notch 
Locations area.

Check orientation Turns on plate-orientation checking.

The notch locations are ignored 
when this option is cleared.

Property Description

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Notches

For information about... See...

How sensors work and their 
location

BenchCel Microplate Handling 
Workstation User Guide

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

General properties “Defining general properties” on 
page 256

Plate properties “Defining plate properties” on page 257

BenchCel System properties “Defining labware properties for a 
BenchCel Workstation” on page 261
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Inserting an image

About this topic To make it easier for operators to identify a plate type, you can insert an 
image of each plate type in the labware editor. This topic describes how 
to insert an image into the labware editor.

Image files must be in the JPG, GIF or BMP format. 

Procedure To insert an image:

1. Open the labware editor.

2. Select the labware in the left column.

3. Click the Image sub-tab of the labware editor. 

4. Click the ellipsis button (...), and navigate to the folder location of 
the image file.

5. Double-click the image file.

The image appears below the file name.

6. Click Save changes.

Related topics
For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

General properties “Defining general properties” on 
page 256

Plate properties “Defining plate properties” on page 257

BenchCel System properties “Defining labware properties for a 
BenchCel Workstation” on page 261
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Labware classes 
defined

Labware classes contain labware entries. When you configure a device 
for the BenchCel System, you can associate the device with labware 
classes to indicate what labware can (and cannot) be used with the 
device. Associating a device with a labware class is performed in the 
Device Manager under the Allowed/prohibited labware property.

Before you create labware classes, consider what labware you want used 
or prohibited on each of your devices.

BenchWorks software is provided with six labware classes already 
defined: 

❑ Uses Filter Platepad

❑ Uses Standard Platepad

❑ Uses Taller Plate

❑ Uses Tip Box

❑ Uses Vacuum Delidder

❑ Uses Vacuum Platepad

❑ Uses Tip Box 

These default classes should be enough for your plate handling needs. 
However, if you want an additional special class that is excluded from a 
particular device or set of devices, you can create a new class.

Two places to define 
classes

You can view and define which plate types are associated with which 
labware classes in:

❑ The Labware Classes tab

❑ The Labware Classes sub-tab of the Labware Entries tab

These views present the same information in different ways.

About the Labware 
Classes tab

The Labware Classes tab is used to create and manage labware classes 
and to edit labware entry membership. The Labware Classes tab is 
located in the Labware Editor dialog box. 

Select a class to see the labware entries that are members and non-
members for that class. In the example below, the class Uses Filter 
Platepad is selected and the labware that are members and non-
members of this class are displayed.
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About the Labware 
Classes sub-tab

The Labware Classes sub-tab is used to assign one or more labware class 
to a labware entry. It is accessed through a bottom tab located on the 
Labware Entries tab of the Labware Editor dialog box.

In the example below, a 1536 Greiner plate is selected and the classes for 
which it is a member displayed.
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For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

General properties “Defining general properties” on 
page 256

Plate properties “Defining plate properties” on page 257

BenchCel Workstation properties “Defining labware properties for a 
BenchCel Workstation” on page 261



Chapter 10: 
BenchWorks Automation Control User Guide

272
Using labware classes

About this topic This topic provides an example of how to use labware classes in 
conjunction with a device. 

The example You have configured VPrep Pipettor shelves 2, 4, and 6 as devices that 
are accessible by the system’s robot. You are using a mix of plates, some 
of which are too tall to fit on shelf 2. By using labware classes, you will 
ensure that the robot will never try to place the wrong type of labware 
on shelf 2.

The labware has been defined and added to the labware editor but it 
still has the default settings for class membership. All labware, by 
default, are members of the Uses Standard Platepad class.

Assigning the 
labware

The first task is to assign the tall labware to the appropriate labware 
class.

To assign the labware:

1. Open the Labware Entries tab of the Labware Editor.

2. Select the labware from the list. The classes that the labware are and 
are not a member of is displayed.

3. Select Uses Taller Plates from the All labware classes area.

4. Move it to the Labware classes that this labware entry belongs to 
area by clicking the  > arrow.

5. Click Save changes.
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for shelf 2

The next task is to restrict shelf 2 from using any labware that is a 
member of the Uses Taller Plates class.

To restrict shelf 2:

1. Open the Device Manager.

2. Select Shelf 2 in the Device List.

3. Click in the cell next to Allowed/prohibited labware in Device 
Properties. The Allowed/Prohibited Labware Classes for Shelf 2 
dialog box opens.

4. Select Uses Taller Plates in the Unassigned labware classes area and 
move it to the Labware classes prohibited... area using the left arrow 
(<).

5. Click OK.
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Creating a new 
labware class

If you have special labware that is not covered by the six classes 
provided, you can create a new one.

To create a labware class:

1. Open the labware editor.

2. In the Labware Classes tab, click New labware class.

3. In the New Labware Class dialog box, enter a name for the labware 
class and click OK.

The class appears in the list of labware classes.

Assign the desired labware to the new class:

1. Select the labware class.

2. Select the labware from the non-members entry list. 

3. Move the labware to the member list by clicking the right arrow (>).

4. Click Save changes.
 



275Chapter 10: 
BenchWorks Automation Control User Guide
Related topics

Managing labware entries

About this topic You can manage your labware entries by copying, renaming, or deleting 
them. For example, to save time when creating a new entry that is similar 
to an existing one, you can copy an existing labware entry. 

This topic describes how to do these tasks. 

You must be logged in as an administrator or technician to perform this 
procedure.

Before you start If you are renaming an entry, make sure either:

❑ The entry you are renaming is not already referenced in protocols, 
or

❑ If the entry is referenced in protocols, you update those protocols

!! IMPORTANT !! If you rename a labware entry that is already 
referenced in protocols, the link between the protocol and the 
labware data will be broken and the protocol will not run until the 
protocols are updated.

If you are deleting an entry, make sure the entry you are deleting is not 
referenced in a protocol.

Procedures To rename a labware entry:

1. Open the labware editor.

2. In the labware selection box on the left side of the window, select 
the labware entry to be renamed.

3. Click Rename labware entry.

4. In the V11Labware dialog box, click Yes to confirm that you want to 
rename this entry.

For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

General properties “Defining general properties” on 
page 256

Plate properties “Defining plate properties” on page 257

BenchCel System properties “Defining labware properties for a 
BenchCel Workstation” on page 261
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5. In the Rename Labware Entry dialog box, enter the new name for the 
plate and click OK.

To copy a labware entry:

1. Open the labware editor.

2. In the labware selection box on the left side of the window, select a 
labware entry.

3. Click Save changes as.

4. In the Save Labware Entry As dialog box, type a name for the new 
entry that is different from the selected one, and click OK.

The copied entry appears in the labware selection box.

To delete a labware entry:

1. Open the labware editor.

2. In the labware selection box on the left side of the window, select 
the labware entry to be deleted.

3. Click Delete labware entry.

4. In the V11Labware dialog box, click Yes to delete the entry.

Related topics
For information about... See...

Defining labware ❑ “Labware editor overview” on 
page 249

❑ “Workflow for defining labware” on 
page 247

General properties “Defining general properties” on 
page 256

Plate properties “Defining plate properties” on page 257

BenchCel System properties “Defining labware properties for a 
BenchCel Workstation” on page 261
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About the Labware 
tab in BenchCel 
Diagnostics

The BenchCel Diagnostics Labware tab exposes a subset of labware 
parameters that are critical for proper plate handling by the BenchCel. 

Access the labware parameters directly from the Labware tab on the 
BenchWorks software Diagnostics Controls page.

Note: The Labware tab does not contain the parameters relevant to the 
any of the instruments that are integrated with the BenchCel 
Workstation. 

When to use Use the Labware tab to:

❑ Test a new plate. Once you have created an initial definition for your 
labware, use the Labware tab in combination with BenchCel 
diagnostics to fine-tune your labware definition.

❑ Troubleshoot a plate sensor or plate placement errors

For more information on using BenchCel Diagnostics to define labware, 
see the BenchCel Microplate Handling Workstation User Guide.

Related topics
For information about... See...

BenchWorks software Diagnostics BenchCel Microplate Handling 
Workstation User Guide
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Setting liquid-
handling definitions
 11
This chapter is for people with administrator or technician login 
privileges. It describes the liquid library editor, which is used to set 
parameters that affect pipetting speed, accuracy and precision, and to 
save the parameters as classes for convenient reuse. This chapter 
contains the following topics:

❑ “About the liquid library editor” on page 280

❑ “Opening the liquid library editor” on page 282

❑ “Creating a liquid class” on page 283
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About the liquid library editor

Accessing the liquid 
library editor

Use the liquid library editor when you have a VPrep Pipettor or Bravo 
Platform connected to the BenchCel Workstation. Access the liquid 
library editor through the diagnostic page of the device.

Liquid library editor 
defined

The liquid library editor is a dialog box through which users with 
technician or administrator privileges can enter values for properties 
that affect pipetting speed, accuracy, and precision. 

Default liquid library 
entries

When installing BenchWorks software, you might have elected to install 
the default liquid library entries. These entries are provided as examples 
and thus might only approximate your particular reagents. For the best 
performance, you should create your own liquid library definitions.

When to use the 
liquid library editor

You open the liquid library editor when you want to:

❑ View the properties that are defined for a liquid class

❑ Edit the properties that are defined for a liquid class

❑ Add new liquid classes

!! IMPORTANT !! You should verify the pipetting of your VPrep 
Pipettor or Bravo Platform. Accurate and precise pipetting depends 
on a variety of factors including the liquid properties. Use the 
Liquid Library to fine-tune the volume delivered.

Liquid classes 
defined

The values entered into the liquid library editor can be saved as a 
collection, known as a liquid class. Using liquid classes saves time when 
writing protocols because you do not have to enter values for the liquid 
properties every time you create a protocol.

Types of liquid classes 

You might want to create different classes for different:

❑ Types of liquids

For example, water versus DMSO

❑ Volumes of liquids

For example, 1 µL versus 200 µL

❑ Liquid operations

For example, washing versus mixing

Liquid library 
database defined

The data that represents a liquid class is saved to the liquid library 
database, which is maintained in the Windows registry.
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Using a liquid class When preparing for a protocol run, you select the liquid class that you 
want to use. During the run, the liquid class values are referenced for 
pipetting operations.

Calibrating the 
Bravo Platform and 
VPrep Pipettor

The liquid library editor also has an equation editor that can be used to 
calibrate the Bravo Platform and VPrep Pipettor.

Liquid Library Editor 
dialog box

A screenshot of the liquid library editor follows.

Related topics
For information about... See...

Opening the liquid library editor “Opening the liquid library editor” on 
page 282

Creating a new liquid class “Creating a liquid class” on page 283
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Opening the liquid library editor

About this topic This topic explains how to open the liquid library editor. 

You must be logged in as an administrator or technician to open the 
liquid library editor.

Procedure To open the liquid library editor from BenchWorks software:

1. Select Tools > Liquid Library Editor.

The Liquid Library Editor opens.

Related topics
For information about... See...

The liquid library editor “About the liquid library editor” on 
page 280

Creating a new liquid class “Creating a liquid class” on page 283
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About this topic This topic describes how to create a liquid class using the liquid library 
editor.

You must be logged in as an administrator or technician to perform this 
procedure.

Liquid compatibility !! INJURY HAZARD !! Velocity11 products are intended to be 
used with non-hazardous liquids. Please contact Velocity11 before 
using any non-aqueous solvents or solvents generally considered to 
be hazardous. 

Procedure To create a liquid class:

1. Open the liquid library editor.

2. Click New liquid entry. 

3. In the New Liquid Entry dialog box, enter a name for the liquid class 
and click OK.

4. Optionally, in the text box at the top right, type a note describing the 
liquid library entry for your records.

5. Enter values for the aspirate properties.

The following table describes these properties.

Note: The upper limits for some of the properties might not be 
achievable for the device you are using.

Aspirate property Definition

Velocity Specifies the speed of the aspiration 
stroke, in microliters per second.

Acceleration Specifies acceleration during the 
aspiration stroke, in microliters per 
second squared.

Post-aspirate delay Specifies the time the pipettor waits 
after aspiration is complete before 
moving the tips out of the wells, in 
milliseconds.

Z-axis velocity into wells Specifies how fast the pipettor moves 
as the tips enter the wells, in 
millimeters per second.

Z-axis acceleration into wells Specifies the acceleration of the 
pipettor as the tips move into the wells, 
in millimeters per second squared. 

Z-axis velocity out of wells Specifies how fast the tips leave the 
wells, in millimeters per second.

Z-axis acceleration out of wells Specifies the acceleration of the 
pipettor as the tips move out of the 
wells, in millimeters per second 
squared. 
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6. Click the Dispense tab and enter values for the dispense properties.

The following table describes these properties.

7. Click Save changes. 

The changes are now stored in the liquid library database.

Related topics

Dispense property Definition

Velocity Specifies the maximum speed of 
the dispensing stroke, in 
microliters per second.

Acceleration Specifies acceleration during the 
dispensing stroke, in microliters 
per second squared.

Post-dispense delay Specifies the time the pipettor 
waits after the dispense stroke 
before moving the tips out of the 
wells, in milliseconds.

Z-axis velocity into wells Specifies how fast the pipettor 
moves as the tips enter the wells, in 
millimeters per second.

Z-axis acceleration into wells Specifies the acceleration of the 
pipettor as the tips enter the wells, 
in milliliters per second squared.

Z-axis velocity out of wells Specifies how fast the pipettor 
moves as the tips leave the wells, in 
millimeters per second.

Z-axis acceleration out of wells Specifies the acceleration of the 
pipettor as the tips leave the wells, 
in millimeters per second squared.

For information about... See...

Opening the liquid library editor “Opening the liquid library editor” on 
page 282

The liquid library editor “About the liquid library editor” on 
page 280
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Index
Note: You can also search our technical documentation on our website at http://
www.velocity11.com/site/?q=node/113.
Symbols
.bar filename extension, 22
.bwl file format, 10
.dev file format, 10
.xml file format, 10

A
aborting a run, 59
acceleration property, 283, 284
administrator privilege, 73, 236
Advanced Settings tab, 210
alarm, adding, 35
Apply Label task, 203

defined, 90
JavaScript properties, 216
setting parameters, 91

aspirate
acceleration, 150, 161
liquid class, 135, 138
quadrant, 136
velocity, 150, 160

Aspirate pipette task
adding, 128
defined, 135, 137
JavaScript properties, 218
setting parameters, 135, 137

automatically release stacker racks 
after protocol finishes (protocol rule), 
34

B
barcode

field modifiers, 95
fields, example, 230
format files, 90
input file, 203, 230
inventory manager, 168
labelling requirements, 90
log file, 40, 96
misread errors, 25
printer, 229
readers, about, 229
tracking, 168
updating input file, 232
using data files, 233
using input files, 230

viewing input file, 231
barcode input file

creating plate group, 189
barcodelog.txt, 40
BenchWorks software

control toolbar, 6
creating a protocol, 73
creating pre- and post-protocol 

processes, 74
defining plate properties, 261
description, 2
finding the version number, ix
installing, 14
logging in, 20
monitoring a run, 61
new features, x
pausing a run, 59
performing a run overview, 50, 

247
preparing for a run workflow, 18
protocol definition, 9
setting BenchWorks options, 22
setting error options, 24
setting simultaneous plates, 85
starting, 19
starting run from command line, 

54
uninstalling, 16

blowout volume, 146, 151, 161

C
can be mounted property, 260
can be sealed? property, 259
can have lid? property, 259
can mount property, 260
cassette, defined, 168
Change Instance task

defined, 140
setting parameters, 140

Change Tips pipette task
defined, 142
requirements for, 142
using, 142

check orientation property, 267
chimney. see MicroWash tray
class, labware, 248
command line BenchWorks launch, 
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54
compiling protocols, 83
computer, disk space option, 26
configuration components, 10
control toolbar buttons, 6
copying a labware entry, 276
creating a protocol, workflow, 73
creating process for a tipbox, 143
Cytomat, 179

manually loading plates, 181
manually unloading plates, 183
moving between, 185
robotically unloading plates, 182
with inventory manager, 168

D
database

backup, 170
connection, 171
copying, 240
inventory management, 168
labware, 146, 152, 162, 221, 

224, 228, 240
liquid library, 240
reinventorying, 195
reinventorying, connection check-

ing, 197
setting up, 171
SQL, 168
synchronizing, 170

deadlock, 84, 86
default user account, password for, 
20
Delid task

defined, 97
device file

defined, 12
definition, 9
filename extension, 10
loading, 13
location, 12
saving, 12

dispense
acceleration, 145, 151, 161
limits, 144
liquid class, 148
velocity, 145, 151, 161
volume, 145

Dispense pipette task
adding, 129
defined, 144, 147
setting parameters, 145, 147

Dispense task

JavaScript properties, 220
dispensing to waste, 160, 162
distance from well bottom, 145
Downstack task

defined, 98
setting parameters, 98

Dry Tips pipette task, 150

E
email

notification of errors by, 28, 239
setting up, 28, 239
when errors occur, 25

errors
message display. see Log tool-

bar.
notification of, 28, 239
reporting, xiii
setting handling options, 25
setting handling options for pro-

tocols, 31
setting options, 24
setting scheduler behavior op-

tions, 26
event messages. see log toolbar

F
file format for protocol, 71
FileReader plug-in, 203

text file format, 204
firmware version, ix
first login, 20

G
general properties for labware, defin-
ing, 256
guest privilege, 236

H
Handle plates in instance order (pro-
tocol rule), 34

I
image root folder, 41
image, inserting labware, 268
Incubate at Storage Device task, 169

defined, 106
setting parameters, 106

Incubate task
defined, 103
setting parameters, 103

Inoculate task
defined, 105
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setting parameters, 105
installing BenchWorks software, 14
inventory editor

close, 172
opening, 172

inventory group, defined, 173
inventory management, database, 
168
inventory manager

database connection, checking, 
197

filters, 191
overview, 168
views, 191

inventory, synchronizing, 170
inventory. see reinventory

J
JavaScript

about, 209
cautions when using, 214
examples, 215
global functions, 211
plate object, 211
resources, 210
script-writing service, 216
task object, 212, 216
variables, 213
VWorks objects, 211

job roles for readers of this guide, vi

L
labware

adding, 255
associating plate with a class, 

274
BenchCel Diagnostics, 277
classes page, 269
classes, about, 248
copying, 276
defining BenchCel Workstation 

properties, 261
defining classes, 269
defining general properties, 256
defining plate properties, 257
defining stacker properties, 266
editor, about, 248
inserting an image, 268
methods for defining, 246
plate process icon, 68
renaming, 275
standards for, 247

labware classes sub-page, 270

labware database, 146, 152, 162, 
221, 224, 228, 240
labware editor

classes page, 250
entries page, 249
opening, 252

LabwareSelector plug-in, setting up, 
202
length of filter tip/pin tool property, 
260
lid

departure height property, 260
gripper offset property, 259
resting height property, 259

lidded stacking thickness property, 
259
lidded thickness property, 259
linking a pipette process, 131
liquid class, 145
liquid library

adding an entry, 283
calibrating VPrep, 281
changing database, 240
classes defined, 280
database defined, 280
editor defined, 280
opening the editor, 282

liquid library editor
about, 281, 283
opening, 282

Load task, 169, 172
defined, 106, 170
setting parameters, 106

location group, 169
creating, 175
defined, 173
deleting, 176
versus plate group, 187

log file
barcode, 40, 96
importing into Excel, 45
pipette, 39
protocol, 39, 45
searching, 63
setting options for, 42
types, 38

Log measurement readings check 
box, 35
Log toolbar, 7, 63

adding a note, 64
message display, 42
options for, 63

log toolbar, 53
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log.txt file
about, 39
adding a note to, 64

logging in to BenchWorks sofware, 20
Loop pipette task

defined, 107
setting parameters, 107

Loop task
JavaScript properties, 222

lower plate at VCode property, 260

M
manifold of MicroWash tray, 162
maximum robot handling speed prop-
erty, 260
MicroWash tray, 162
mix

cycles, 150
liquid class, 153
volume, 150

Mix task
defined, 150, 152
JavaScript properties, 222
setting parameters, 150, 152

monitoring a run, 61
Mount/Dismount task

defined, 108
setting parameters, 109

N
network connections

obtaining IP addresses, 243
viewing, 242

notch locations property, 267

O
online help, vii
opening

device file, 13
labware editor, 252
liquid library editor, 282

operator privilege, 236
options

log and data file, 42
protocol error, 31
setting, 22
setting error, 25
setting general, 22

orientation sensor threshold (max) 
property, 266

P
pager, notification of errors by, 28, 

239
passwords

about, 237
changing, 237
first login, 20

pausing a run, 59
PDF guide, vii, viii
Pierce task

defined, 110
setting parameters, 110

pipette log file, 39
Pipette plates in instance order (pro-
tocol rule), 33
pipette process

creating for changing pipette tips, 
143

defined, 69
linking a pipette task to, 131
setting parameters, 130

pipette process task
adding, 126, 130
adding example, 126

pipette task defined, 70
pipette tips, 142

changing, 142, 143
touching, 162
washing, 160

pipetting operation, example, 126
piplog.txt, 39
Place Labware task, setting parame-
ters, 111
Place Plate task

defined, 113
setting parameters, 113

plate group, 169
changing processing order, 178
creating, 177
creating with barcode input file, 

189
defined, 174
deleting, 178
incubating plates using, 187
versus location group, 187

plate group editor, 168
plate inventory. see reinventory
plate object, JavaScript, 211
plate process icon

definition, 68
setting parameters, 76

plate properties, defining, 257
PlateHub Carousel, 179

with inventory manager, 168
manually loading plates, 181
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moving plates between, 185
robotically loading plates, 179
robotically unloading plates, 182

PlateLoc
see also Seal task

PlatePierce
see also Pierce task

plates
moving between storage devices, 

185
see also simultaneous plates

plug-in, 73
FileReader format, 204
FileReader, about, 203
setting up LabwareSelector, 202

post-aspirate
delay property, 283

post-dispense
volume, 146

post-dispense delay property, 284
post-protocol

setting up, 74
post-protocol process

defined, 69
pre-aspirate volume, 161
preparing for run, workflow, 18
pre-protocol

setting rules, 32
setting up, 74

printing a protocol, 48
privileges

defined, 236
effect of, 236
types, 236

process, defined, 68
profile, defined, 9
property

acceleration, 283, 284
can be mounted, 260
can be sealed?, 259
can have lid?, 259
can mount, 260
check orientation, 267
length of filter tip/pin tool, 260
lid departure height, 260
lid gripper offset, 259
lid resting height, 259
lidded stacking thickness, 259
lidded thickness, 259
lower plate at VCode, 260
maximum robot handling speed, 

260
notch locations, 267

orientation sensor threshold, 266
post-aspirate delay, 283
post-dispense delay, 284
sealed stacking thickness, 259
sealed thickness, 259
sensor intensity, 267
stacking thickness, 259
thickness, 258
velocity, 283, 284
z-axis acceleration into wells, 

283, 284
z-axis acceleration out of wells, 

283, 284
z-axis speed into wells, 283
z-axis velocity into wells, 284
z-axis velocity out of wells, 283, 

284
protocol

compiling, 83
creating example, 126
creating pre and post processes, 

74
defined, 68
file format, 71
filename extension, 10
log file, 39
log file example, 45
optimizing, 32
options, setting rules, 32
overall process of creating, 73
printing, 48
run until done, 52
saving, 83
setting rules, 33
simulating, 84
specifying order of tasks, 122
understanding before a run, 47
what you should know, 47

Protocol Task Parameters toolbar, 
205
pump

inflow, 162
outflow, 162

Pump pipette task
defined, 155

Pump Reagent task
defined, 156
JavaScript properties, 225
setting parameters, 155, 156

Q
quadrant, 136, 139, 146, 149, 151, 
154, 158, 161
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quadrant representation in JavaS-
cript, 214

R
registry files, xiii
registry key

emailing, 242
exporting, 241
importing, 241

reinventorying storage device, 195
Relid task

defined, 97
renaming a labware entry, 275
reporting errors, xiii
reservoir filling. see VPrep
Restack task

setting parameters, 114
retract distance, 146, 151, 161
robot, preventing crashes, 22
run

aborting, 59
adding to the run-set manager, 

56
defined, 70
deleting from the run-set manag-

er, 57
monitoring, 61
performing overview, 50, 247
protocol until done, 52
scheduling, 55
starting, 51
starting from command line, 54
what happens after, 53

run set
defined, 55
file, 55
filtering, 57
opening, 58
saving, 58
stopping, 58

run set manager
adding a run to, 56
deleting a run from, 57

running a protocol, workflow, 18, 50, 
247

S
saving protocols, 83
scheduler behavior options, 26
screen message options, 63
Seal task

defined, 116
setting parameters, 116

sealed stacking thickness property, 
259
sealed thickness property, 259
sensor intensity property, 267
shelf, VPrep configuring, 133
Signal task

example, 122
setting parameters, 120

simulating a protocol, 84
simultaneous plates, 85
slot, defined, 168
software versions, ix
SQL database, 168
Stacker task

defined, 98
setting parameters, 98

stacker, defining properties for lab-
ware, 266
stacking thickness property, 259
starting

a run from a command line, 54
BenchWorks software, 19
runs, 51
runs automatically, 55

startup-protocol rules
about, 32

stopping a run, 59
storage device

manually loading plates, 181
manually unloading plates, 183
reinventorying, 195
robotically loading plates, 179
robotically unloading plates, 182

StoreX, 179
manually loading plates, 181
manually unloading plates, 183
moving plates between, 185
robotically loading plates, 179
robotically unloading plates, 182
with inventory manager, 168

synchronizing inventory database, 
170
system, defined for inventory man-
agement, 170

T
task object, JavaScript, 212

properties, 216
task parameter setting, 84
Task Parameters toolbar. see Proto-
col Task Parameters toolbar, 205
tasks

adding, 78
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defined, 68
deleting, 79
moving, 79
specifying order in a protocol, 

122
types, 80

teachpoint
file, definition, 9
filename extension, 10

technician privilege, 73, 236
thickness property, 258
tip touch, 146

horizontal distance, 146
rise height, 146

tip touch horizontal distance, 152
tip touch rise height, 151
tip touching, 151
tipbox, 143
tips. see pipette tips
toolbars

closing, 62
control, 6
Log, 7, 63

transfer log, 147

U
uninstalling BenchWorks software, 
16
Unload task, 169, 172

defined, 106, 170
setting parameters, 106

Upstack task
defined, 98
setting parameters, 98

user accounts
adding, 237
changing password, 238
creating, 236
disabling, 237
editing, 237
passwords

resetting, 237
privileges, 236

User Message task, 53
defined, 118
setting parameters, 118

V
VCode, about, 229

velocity property, 283, 284
volume

blowout, 146, 151, 161
dispense, 145
mixing, 150
post-dispense, 146
pre-aspirate, 161
wash, 160

VPrep
changing tips, 143
configuring a shelf, 127, 133
reservoir, 155
selecting, 127

VSpin
see also VSpin with Access2 task

VSpin with Access2 task
defined, 121
setting parameters, 121

W
Waitfor task

example, 122
setting parameters, 120

wash tips, 160
liquid class, 165

Wash Tips task
defined, 160, 164
JavaScript properties, 225
setting parameters, 164

wash volume, 160
Windows

registry files, xiii
registry key, copying, 241

X
XML schema, 72

Z
z-axis

acceleration into wells property, 
283, 284

acceleration out of wells proper-
ty, 283, 284

speed into wells property, 283
velocity into wells property, 284
velocity out of wells property, 

283, 284
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